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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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Dua Kartu Sekaligus.
Sudah punya kartu suara

terintegrasi belum cukup? Bisa
ditambah add-on.

Membaca Spesifikasi
Kamera Digital. Ada berbagai

istilah yang harus dipahami. Jelas bukan
cuma soal resolusi.

Pemanfaatan
Wireless
Module.

SIM Card jadi bisa
“ditanam” pada
berbagai benda.

Membuatnya
terkoneksi seperti

kita.
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

2004: Berkerikil dan Beranginkah?

Ada sebagian paranormal, pakar politik, pengamat ekonomi, yang
mengatakan demikian. Parameternya pokoknya adalah pemilu yang bakal
digelar tahun ini. Aneh sekali memang. Pemilu yang dimaksudkan untuk
mendapatkan pemerintahan yang kuat dan stabil, tapi prosesnya justru
membikin sendi-sendi kehidupan masyarakat terasa labil.

Tapi biarlah. Toh kita harus tetap melihat tahun ini sebagai sebuah
tantangan sekaligus peluang. Dibilang tantangan lantaran di tengah situasi
yang diperkirakan berkerikil dan berangin nantinya, kita justru harus bisa
memilih langkah untuk menapak di tanah yang datar, sembari berkelit dari
terpaan angin yang menerpa dari sana-sini.

PCplus tetap berasumsi bahwa 2004 adalah lebih dibanding yang
telah lewat. Mengapa? Karena sepertinya tahun ini merupakan tahun yang
justru menentukan dan penting dalam tonggak perkembangan teknologi
komputer dan IT pada umumnya.

Oleh karenanya, tak tanggung-tanggung PCplus menurunkan sebuah
artikel utama yang berbicara tentang perkembangan jalur interkoneksi
input/output yang benar-benar beralih secara dramatis dari paralel ke
serial. Secara khusus, PCplus mengangkat bahasan tentang PCI Express,
karena dengan peluncurannya yang direncanakan akan dilakukan tahun
ini, ia menutup sebuah era yang telah berumur kurang lebih satu dekade,
sekaligus membuka sebuah era baru yang jauh lebih efisien, murah, dan
praktis.

Selain itu, PCplus masih menyodorkan beberapa artikel yang tak
kalah menariknya, mulai dari rubrik belajar, kiat, sampai trik dan surfing.
Tak usah dibahas satu per satu di sini karena pasti Anda ingin segera
membukanya.

Jadi, tunggu apa lagi sih! Selamat membaca sajian kami.

Salam hangat dari Palmerah
Redaksi

TRANSFER DATA VIA
KAMDIG

Halo PCplus, aku mau tanya.
Aku punya kamera digital yang
kalo aku connect ke PC via USB,
bisa buat simpan data, data apa
saja nggak cuma image. Kadang
aku salahgunakan buat mindahin
data antar PC. Apakah hal
demikian ada efek negatifnya
buat kamera digital, khususnya
memorinya? Bagaimana juga jika
kutambah memory card agar
kapasitas lebih besar? Apa akan
baik-baik saja. Thanks.

Toni Saputra
Jogjakarta

krembizz@hotmail.com

Red: Dari sisi fungsionalitas media
simpan, tidak ada masalah menggu-
nakannya untuk transfer data. Akan
lebih bagus bila Anda menambahkan-
nya dengan memory card yang lebih
besar ukurannya sehingga transfer
datanya juga bisa lebih banyak.

SKRIP PADA BUKU PCPLUS
Dear PCplus, saya adalah

langganan PCplus dari nomor awal
dan mendapatkan tabloid
kesayangan ini dengan
berlangganan tetap sampai saat
ini, dan semua produk PCplus (CD,
buku) selalu saya beli.

Terakhir saya membeli buku
“Langkah Mudah Optimalisasi
Windows!” yang disertai CD
ketiga PCplus. Saya tertarik pada
trik pembuatan jam keren buat
desktop Windows. Setelah saya
salin skrip yang terdapat pada
buku tersebut, dan setelah

mendapatkan beberapa pesan error
(karena saya sama sekali tak ahli
Java), terakhir saya mendapat error
yang tak dapat diperbaiki dan
membuat saya bingung. Error itu
menyatakan "nsllie is undefined".
Ini membingungkan karena saya tak
salah menulis.

Tolong dong, kasih tahu saya
skrip yang benar di baris ketiga
terakhir pembuatan jam keren pada
buku Optimalisasi Windows
tersebut. Atau kalau bisa Kak Alois
Wisnuhardana, Alex Pangestu, atau
Steven Andy Pascal dapat mengirim
pada saya skripnya secara utuh
lewat e-mail. Karena terus terang
saya kelabakan dalam menulis skrip
tersebut dan selalu salah terus. Atas
bantuannya, saya ucapkan terima
kasih.

Yayan I.M.
xxxx@bdg.centrin.net.id

Red: Permintaan kiriman skrip sudah
kami kirimkan lewat e-mail Bung Yayan.

WORKSHOP PCPLUS KAPAN?
Dear Redaksi PCplus, kapan ya

PCplus mengadakan workshop
Video Editing&Desain Grafis di
Jabotabek? Kalau bisa secepatnya!
Soalnya saya kepingin banget untuk
mengikuti workshop tersebut.
Terima kasih, semoga PCplus tetap
eksis di bidangnya.

Rahmat Rahmatsyah
rrahmatsyah@yahoo.com

Red: Anda bisa melihat jadwal
workshop yang diselenggarakan PCplus
di terbitan nomor 155, 156, atau 157.
Jadwal tersebut masih ada

kemungkinan untuk bertambah
mengingat banyaknya permintaan
workshop dari kota di daerah-daerah.

MP3 DAN OVERCLOCK
Saya adalah pelanggan PC Plus

sejak 3 tahun terakhir ini dan baru
pertama kali ini saya mengirimkan
e-mail pertanyaan. Pertanyaan saya
adalah:
1. Apakah ada software atau alat

yang dapat mengubah format
audio dari kaset menjadi format
MP3?

2. Saya menggunakan prosesor
P.IV 1.8A Ghz dan ternyata
range frekuensinya (dari BIOS)
bisa diset dari 1.8GHz dan
2.4GHz. Apakah ini yang disebut
overclock? Lalu kalau prosesor
2.0A GHz, berapakah
maksimum GHz yang dapat
diset? Dan kalau 2.4GHz berapa
maksimum GHz yang dapat
diset? Dan kalau yang 2.4 C
GHz? Dan apakah perbedaan
mendasar dari pemberian A, B
dan C dibanding dengan yang
tanpa A,  B, atau C?

3. Apakah alamat e-mail ini adalah
alamat yang tepat untuk
menanyakan pertanyaan-
pertanyaan tersebut? Mohon
maaf sebelumnya apabila bukan
alamat yang tepat karena saya
pernah ikut milis PCplus dengan
tujuan untuk menyakan hal-hal
yang tidak saya ketahui seperti
yang tersebut di atas tetapi milis
tersebut lebih cenderung untuk
saling chatting dan ngobrol,
kurang serius dan bahasa yang
digunakan adalah pergaulan
sehari-hari sehingga dalam satu
hari bisa sampai 30 milis masuk
ke inbox dan yang berguna
paling banyak 30% nya saja dan
tujuan saya untuk bertukar
fikiran dan mencari solusi bu-
kannya untuk ngobrol sehingga
akhirnya langsung saya keluar
dari dari milis karena hanya
memenuhi inbox saya saja.

Terima kasih atas perhatian
dari PCplus atas pertanyaan saya
dan saya tunggu jawabannya.

Sam Basuki
Ferrari Indonesia

Red:
1. Ada. Anda bisa gunakan software
seperti SoundForge.
2. Bila Prosesor Anda yang 1,8GHz itu
dijalankan pada 2,4GHz, ya ini salah
satu contoh overclock. Overclock ini
artinya peranti Anda tersebut dijalankan
melebihi spesifikasi clock-nya. Jadi
prosesor 1,8GHz bila dijalankan pada
1,9GHz juga sudah merupakan
overclock. Masalah frekuensi maksimal
yang bisa diset dan berjalan dengan
baik/stabil, dipengaruhi oleh banyak hal.
Kemampuan dari prosesor itu sendiri,
board yang digunakan, dan juga peranti
lain utamanya memori utama.
Mainboard yang digunakan
kelihatannya mendukung FSB 133MHz
sehingga Pentium-4 yang Anda
gunakan ditawarkan untuk berjalan

pada FSB 100MHz ataupun 133MHz.
Pentium-4 1,8GHz memiliki multiplier/
pengali 18 sehingga bila berjalan pada
133MHz akan menghasilkan 2,4GHz.
Bila Anda menggunakan board yang
hanya mendukung FSB 100MHz, maka
tawaran yang tersedia hanya yang
1,8GHz, kecuali tentunya bila terdapat
fasilitas untuk menaikkan FSB hingga di
atas 100MHz. Kode A, B, dan C
digunakan untuk membedakan FSB
yang digunakan. Mulanya Pentium-4
hanya ada satu jenis yaitu Willamette
yang memiliki FSB 100MHz dan cache
L2 sebesar 256kB dan proses produksi
sebesar 0,18 micron. Belakangan
muncul Pentium-4 Northwood yang
memiliki FSB yang sama (100MHz)
namun dengan cache L2 sebesar 512kB
dan proses produksi 0,13 micron. Inilah
yang diberi kode A. Untuk Kode B, FSB
yang dimiliki adalah 133MHz dengan
spesifikasi lain sama dengan A. Kode C
juga hanya memiliki perbedaan pada
FSB-nya, yaitu sebesar 200MHz.
3. Betul. Anda bisa mengirimkan
pertanyaan ke redaksi@e-pcplus.com
untuk keperluan ini.

KOMPUTER SERING HANG
Salam kenal, langsung saja saya

mau tanya.
1. Sebenarnya saya masih bingung

dengan bahasa pemrograman.
Bagaimana sih sistem kerjanya
(secara umum) serta bagaimana
cara kerjanya (kok sering hanya
mengetik angka saja)

2. Tolong jelaskan bagaimana cara
menanggulangi komputer yang
sering hang. Spesifikasinya:
Microsoft Windows 98 Second
Edition, harddisk (r)82801 BA
Ultra ATA storage controller-
244b (dipartisi) 18,6GB, dengan
perincian C: untuk sistem
(4,76GB used 13,8GB) free  D:
untuk data (3,70GB used 14,9GB
free), prosesor Intel Pentium-III
866 MHz, memori 128MB, CD-
ROM Creative 52x, CD-RW Sony
24x/10x/40x, Vga card Nvidia
Riva TNT 2 model 64/model 64
pro, printer HP Deskjet 810 c,
modem Rockwell 336 drt
external modem, speaker Nec
Super-160 multimedia. Tolong
langkah-langkahnya secara
mendetail.

3. Ketika sudah terkoneksi kok
setelah agak lama browsing
sering muncul web page cannot
displayed padahal saya masih
terkoneksi?

4. Apa yang sebaiknya saya laku-
kan jika Norton Antivirus saya
mangidentifikasi virus tetapi vi-
rus tersebut tidak mau di-repair,
di-quarantine dan di-delete?

Terima kasih atas bantuannya

Bramastya
Surabaya

Red:
1. Seluk beluk bahasa pemrograman
bisa dinikmati di PCplus edisi 156
minggu lalu.
2. Ada banyak penyebab hang. Anda
sebaiknya memperhatikan hal apa yang

sering membuat PC hang. Apakah
menjalankan software tertentu, lama
menggunakan PC, atau malah baru
dihidupkan langsung sudah hang. Bila
PC Anda sudah lama tidak dibersihkan
ada baiknya dibersihkan secara
menyeluruh. Pastikan tidak ada
kesalahan/kekurangsempurnaan
pemasangan. Periksa juga tidak ada
komponen yang memiliki suhu yang
terlampau tinggi. Pastikan aplikasi dan
driver yang digunakan tidak ada yang
rusak. Periksa juga tidak ada konflik
antara software yang digunakan
termasuk driver yang digunakan. Ada
baiknya menggunakan driver terbaru.
Tidak ada salahnya juga untuk
menggunakan patch/update terbaru
untuk software yang Anda gunakan.
3. Pesan seperti itu bisa muncul
karena alamat situs yang dimasukkan
memang tidak ada. Selain itu, bisa
juga karena koneksi Internet yang
buruk.
4.  Yang perlu Anda lakukan adalah
selalu meng-update virus definition
antivirus Anda. Apabila masih tidak
mempan, uninstall terlebih dahulu
program antivirus yang satu dan
gunakan antivirus yang lain. Kalau
masih tetap membandel juga, tidak
ada salahnya Anda menempuh jalan
instalasi ulang daripada timbul
masalah di kemudian hari. Tentu saja
amankan dulu data-data penting
Anda.

CACHE DAN BOOT
WINDOWS

Dear PCplus. Begini, saya
punya masalah tentang PC saya
yang speknya AMD Duron 1200+,
memori 320, VGA gforce2 mx400,
HDD 20GB 5200 seagate.
1. Apa seh artinya cache dan

tolong jelasin fungsinya dari
file yang saya kirim dari atas
sampai bawah

2. Boot Windows saya lama
banget. Gimana supaya cepat
kira-kira hampir 5 menit,
padahal sudah saya speeddisk,
sudah pake reg cleaner,dan
pake clean center. Kenapa
masih lambat juga ya?
Sebaiknya HDD di speeddisk
berapa minggu sekali?

O ya, meskipun telat, selamat
ulang tahun semoga semakin jaya
daripada tabloid yang lain en
isinya juga menambah ilmu
tentang IT ya. Sekali lagi maap
agak terlambat. Terima kasih.

Hendi Sutoto
iceboy30@lycos.com

Red: 1. Cache adalah tempat
penyimpanan sementara. Biasanya
cache ini memiliki kecepatan yang
lebih tinggi dari memori utama. Ada
baiknya Anda membaca
ulasan PCplus mengenai cache untuk
lebih jelasnya. 2. Masalah boot yang
lambat bisa disebabkan karena terlalu
banyak aplikasi yang di-load pada saat
startup. Salah satu cara untuk
mengatasinya adalah mengurangi
aplikasi yang di-load melalui msconfig.



SiSM741,
Chipset Baru
dari SiS. SiSM741
merupakan chipset untuk
mobile platform berbasis
AMD mobile Athlon XP.
Selain mendukung FSB
333MHz, AGP 8X dan
memori DDR400 RAM
berkecepatan tinggi,
SiSM741 juga terintegrasi
dengan teknologi
HyperStreaming. Menurut
SiS, kombinasi antara
SiSM741 dengan chipset jaringan nirkabel SiS162 merupakan
sebuah solusi untuk mendapatkan performa jaringan nirkabel
yang handal. Dengan teknologi Ultra AGPII, chipset ini memiliki
VGA Throughput hingga 3,2GB per detik. Resolusinya yang tinggi,
1920x1600, bisa mendukung output UXGA TFT-LCD dan gambar
yang sempurna untuk game-game 3D. SiSM741 akan dipasangkan
dengan SiS963 sebagai south-bridge chipset-nya. Rencananya,
notebook yang mengadopsi chipset ini akan dilempar ke pasar
pada kuarter pertama tahun 2004. (raa)

Linux Bisa Mencuri Pasar OS
Windows dan Unix. Ini merupakan prediksi
yang diperoleh dari hasil survei yang dilakukan oleh SG Cowen
Securities. Dari lebih dari 500 responden yang merupakan
pengguna TI di daerah Amerika Utara, ada sekitar 80 persen yang
saat ini menggunakan Linux. Dalam survei ini juga ditemukan
adanya peningkatan ketertarikan masyarakat untuk
menggunakan software open-source untuk server aplikasi, e-mail
dan sistem database. Jadi, bisa diramalkan, Linux akan mencuri
ruang kerja Windows dan Unix dalam sektor korporat atau pun
individual.

Menurut survei November lalu, dari 527 perusahaan yang
bergerak di berbagai macam industri, ada 65 persen yang
berencana untuk meningkatkan penggunaan Linux-nya dalam

jangka waktu satu hingga
dua tahun ke
depan, dan 29
persen telah
siap untuk
pindah ke

Linux. Alasan
mereka
adalah karena
Linux
memiliki
realibilitas,
skalabilitas,
dan pastinya

harga yang
jauh lebih

murah. Temuan lain yang berhasil
diperoleh dari survei tersebut adalah bahwa

dari seluruh responden yang telah
menggunakan Linux, 72 persennya menjalankan Linux pada server
dan 15 persen menggunakannya pada desktop.

Sudah banyak vendor TI yang melirik Linux sebagai platform
dari produknya. Kita bisa ambil beberapa contoh – Oracle,
Hewlett Packard, dan IBM. “Persaingan antarOS akan semakin
seru di tahun 2004. OS seperti Linux, Windows dan Unix sudah
pasti akan jadi lebih maju, tetapi dari ketiganya, pertumbuhan
Linuxlah yang paling besar bila dibandingkan dengan Windows
dan Unix, apalagi karena Linux bersifat low cost”, ujar
Goenawan Loekito, Marketing Director PT Oracle Indonesia.
“Oracle sendiri akan tetap running di semua platform yang ada,
tetapi masih sama seperti tahun 2003, fokus utama campaign
tahun ini masih tentang Linux, grid computing dan UKM”, tambah
Goenawan.

Lalu, bagaimana pendapat dari Sun Microsystem? “Untuk OS
kita lihat ada 2 kelompok besar pengguna, yaitu korporasi dan
perorangan. Untuk kalangan korporat, ada beberapa hal yang
diperlukan untuk mendukung bisnis, seperti ketersediaan soft-
ware, skalabilitas, keamanan, performansi, dan juga keterbukaan
akan berbagai macam standar. Untuk perorangan, lebih banyak
bergantung pada kemudahan penggunaan dan banyaknya fungsi
OS tersebut. Idealnya, OS yang bisa menggabungkan semua hal
tersebut yang bisa menjadi pemimpin di masa mendatang,” papar
Bhra Eka Gunapriya, Presiden Direktur PT Sun Microsystems
Indonesia. ”Sun juga akan masuk ke Linux dan saat ini punya
agreement dengan pemerintah Cina untuk mendapatkan 200 juta
lisensi yang akan membuat Sun sebagai pemegang lisensi linux
terbesar di planet ini. Walau demikian SOLARIS akan tetap
menjadi fokus kita karena produknya sudah teruji dan dapat
acceptance yang baik dari para pemakainya”, tambah Bhra. (raa)

Detil Rencana AMD Mengenai Chip Masa Depan.
Para peneliti Advanced Micro Devices (AMD) punya pandangan sendiri mengenai teknologi masa
depan, sebuah prosesor yang dibuat dengan teknologi proses 45 nanometer, yang mereka harapkan
bisa terwujud di tahun 2007 mendatang. Saat ini, para produsen chip baru bisa mengeluarkan produk
yang dibuat dengan teknologi proses 90 nanometer. Bayangkan saja, satu nanometer sama dengan satu
per satu miliar meter. Jadi, sebuah chip yang dibuat dengan teknologi proses 45 nanometer akan
memiliki line sirkuit yang besarnya sama dengan 45 per satu milyar meter, dengan komponen-
komponen yang pastinya lebih kecil lagi.

Untuk bisa mewujudkan impian mereka akan chip tersebut, para peneliti dari AMD berencana
untuk menggunakan sebuah teknik yang disebut “fully depleted silicon-on-insulator” untuk
mengurangi kemungkinan terjadinya perbedaan jumlah aliran listrik di berbagai bagian transistor.
Mereka juga akan membuat sebuah pagar transistor yang terbuat dari sejenis metal, namanya nickel-
silicide, pada chip tersebut. Kontras dengan polysilicon yang banyak digunakan saat ini, nickel-silicide
mampu mengalirkan daya listrik antar atom pada chip melalui proses pemampatan lokal. Tujuannya
penggunaan material ini adalah untuk mencegah kemungkinan terjadinya kekurangan arus listrik pada
beberapa bagian chip tersebut. (raa)

Update untuk Windows XP Akan Hadir Pada
Pertengahan Tahun 2004. Windows XP Service Pack 2, atau SP2,
merupakan update untuk Windows XP. Menurut Matt Pilla, manajer produk senior Microsoft Windows,
versi beta dari Windows XP SP2 akan disediakan melalui jaringan pengembang software Microsoft
untuk diuji oleh beberapa ratus ribu tester pada akhir bulan Desember 2003. Sedangkan versi final SP2,
rencananya akan keluar pada pertengahan tahun 2004. Para tester yang menjadi target adalah para
pengembang software dan profesional TI.

“Pada dasarnya, SP2 merupakan sebuah service pack yang berbeda”, kata Pilla. “Apa yang kami
berikan di dalamnya bukan hanya sebuah set update standar yang ditingkatkan, tetapi kami juga
mencoba untuk memberikan banyak perbaikan untuk membuat sistem operasi tersebut tahan terhadap
serangan.”

Selama ini, yang menjadi masalah Microsoft adalah adanya celah keamanan pada sistem operasi
Windows-nya. Karena itu Microsoft mencoba meningkatkan sistem keamanan untuk versi update XP
ini. Dalam SP2, Microsoft memberikan versi update untuk Firewall koneksi Internet-nya, namanya
Windows Firewall, yang akan dipasang secara default pada sistem. Sebagai tambahan,
pendistribusian DCOM (Distributed Component Object Model) pada servis RPC (Remote Procedure Calls)
juga akan dibatasi karena pada beberapa bulan yang lalu, kelemahan pada RPC dan DCOM lah yang
dieksploitasi oleh worm Blaster.

SP2 juga dilengkapi dengan update untuk Internet Explorer dan Outlook Express, tujuannya sudah
jelas untuk memberikan keamanan berinternet yang lebih bagi para penggunanya. Microsoft akan
membuat blocker untuk mencegah masuknya pesan-pesan pop-up alias spam. Untuk memberikan
kemudahan bagi para penggunanya, Microsoft juga menyediakan client Software Update Services 2.0
(SUS 2.0) yang bisa membantu mengatasi masalah pada layanan Windows Update, yang selama ini
kurang bisa diandalkan. SUS juga memungkinkan user untuk menginterupsi proses download software
update dan memberikan laporannya setelah proses selesai.

Fitur terakhir yang ditambahkan pada SP2 adalah standar Bluetooth 1.1 dan sebuah client
Wireless LAN untuk mempermudah user konek di area hotspot. Menurut Pilla, versi final dari SP2
kemungkinan besar akan menawarkan lebih banyak kelebihan dibanding dengan versi betanya. Tetapi,
mungkin juga beberapa fitur yang ada pada versi beta tidak ditambahkan pada versi finalnya. (raa)

IBM Mengintegrasikan Instant Messaging Tool
untuk Versi Terbaru Lotus Notes dan Domino.
Pertengahan bulan November kemarin, IBM Indonesia mengumumkan tersedianya IBM Lotus Notes
dan Domino 6.5. Versi terbaru dari Lotus Notes dan Domino ini, selain memperluas dukungan
terhadap Linux dan dan fitur-fitur pengelolaan baru, juga mengintegrasikan fungsionalitas WebSphere
Portal dan Lotus Instant Messaging. Para penggunanya bisa menjalankan instant messaging langsung
dari inbox mereka.

Lotus Notes 6.5 merupakan rilis Lotus Notes pertama yang mengadopsi Lotus Workplace, strategi
IBM yang merupakan platform baru untuk mengintegrasikan manusia dengan bisnis. Para pengguna
bisa mengakses tool-tool seperti instant messaging, aplikasi search, serta kalender dan penjadwalan.
Lotus Notes dan Domino akan menjadi bagian yang tak terpisahkan dari Lotus Workplace. (raa)

DRM Music Player,
Download File Musik
Dari Ponsel. Alat ini pertama kali

diluncurkan oleh Siemens Information and
Communication Mobile (Siemens Mobile) di
Munich, Jerman, pada akhir November 2003.
Dengan DRM Music Player, kita bisa
memantau musik terkini atau men-down-
load file musik langsung dari ponsel.
Caranya dengan menghubungkan player
yang berdimensi 52 x 98 x 21mm dengan
bobot 80gr ini ke sebuah ponsel GPRS
melalui sebuah kabel atau infrared.
Setelah itu, kita bisa langsung
menghubungi provider ponsel yang
selanjutnya akan menampilkan judul-
judul lagu yang bisa dipilih.

DMP merupakan PDA mungil yang fungsinya bisa dialihkan dengan mudah dari komputer ke
player, caranya dengan menggunakan kabel USB. File-file musik tersebut kemudian disimpan dalam
plug-in SD memory card 64MB yang bisa menyimpan hingga 60 lagu sekaligus. Kartu itu bisa dimainkan
di DRM Music Player maupun di komputer. File-file audio tersebut dipadatkan dengan MPEG-4
aacPlus, sebuah teknologi kompresi audio paling canggih yang bisa menghasilkan tingkat kualitas
audio yang tinggi bahkan dalam komunikasi mobile dengan jaringan transmisi yang rendah sekalipun.
Dan, untuk menjamin para konsumen, operator mobile O2 telah meluncurkan jasa O2 Music-nya pada
pertengahan bulan Desember 2003. Kerjasama antara O2 dan semua perusahaan musik memungkinkan
para pelanggan ponsel memiliki akses eksklusif untuk memperoleh hit-hit musik terbaru. (raa)
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Siapa yang Mau Ikutan Main
Utak Atik Otak? Sayangnya permainan ini hanya
diperuntukkan bagi para pelanggan IM3, yang tentu saja berada
pada area yang terjangkau sinyal IM3. Utak Atik Otak adalah
sebuah ajang permainan ponsel multiplayer di Indonesia, yang
digelar atas kerjasama antara PT Ericsson Indonesia, Indosat
Multimedia Mobile (IM3), Sony Ericsson, dan Game Online Inova
(GOI). Ajang permainan ini merupakan yang ketiga kalinya, dan
diadakan mulai tanggal 17 Desember 2003 sampai 8 Februari
2004.

Untuk memulai kompetisi, pemain harus membayar sebesar
Rp 5.500,- untuk mendaftar dan men-download game yang
diinginkan. Informasi keikutsertaan bisa diperoleh pada alamat
http://www.ericsson.co.id, http://www.m3-access.com, http:/
/sonyericsson.com, dan www.hpgue.com/game/mutiplayer.
Ada tiga game yang bisa dipilih – catur jawa, catur dan conveto.
Setelah mendaftar, barulah game tersebut bisa dimainkan selama
satu minggu. Jika masa berlangganan sudah habis, pemain bisa
memperpanjang masa langgannya dengan mengirim SMS ke
nomor 3535 dan membayar sebesar Rp 5.500,- lagi, kali ini ia akan
memperoleh masa langgan selama dua minggu.

Hadiah yang ditawarkan berupa uang sejumlah Rp 5 juta dan
sebuah Sony Ericsson Z600 untuk juara pertama, uang sejumlah
Rp 2 juta dan sebuah Sony Ericsson T610 untuk juara kedua,
dan uang sejumlah Rp 1 juta dan sebuah Sony Ericsson T230
untuk juara ketiga. Jadi, siapa yang mau ikutan main Utak Atik
Otak? (raa)

LG Memimpin Pasar CDMA Dunia. Prestasi ini
diraih oleh LG Electronics (LGE), untuk pertama kalinya, di kuarter ketiga tahun
2003. Menurut survei yang dilakukan oleh lembaga market research Amerika
Serikat Strategy Analytics (SA), LGE meraih market share 23% atau 6 juta unit
ponsel CDMA ke pasar dunia, mengalahkan Samsung Electronics dan
Motorola, yang hanya meraih masing-masing 5,1 juta unit atau market
share 19,6%. Survei juga menyebutkan bahwa penjualan ponsel LG di
pasar luar negeri rata-rata menduduki posisi puncak
menyaingi kompetitor-kompetitor di belakangnya.

Sementara di pasar GSM, selama kuarter ketiga, LGE
terus melakukan kerja sama dengan operator-operator GSM
utama baik di Eropa maupun Amerika Serikat seperti
Vodafone, Orange, Cingular dan T-Mobile. Hasilnya, LGE
mampu menjual 1,6 juta ponsel GSM dan berhasil duduk di
posisi ketujuh.

Khusus bagi konsumennya di Indonesia, LG telah
menyediakan LG Royal Card yang merupakan kartu tanda
keanggotaan LG. Jenisnya ada tiga, yaitu Onyx, Sapphire
dan Ruby. Setiap kartu memiliki kategorinya sendiri,
tergantung pada produk apa yang dibeli oleh konsumen. Para
pemegang LG Royal Card bisa memperoleh perlakuan khusus
seperti perpanjangan masa garansi, diskon khusus untuk biaya reparasi dan suku cadang, prioritas
utama penanganan keluhan, dan buletin informasi program promosi LG. Kenapa kartu ini hanya untuk
konsumen di Indonesia ya? Apa mungkin karena masyarakat kita mudah tertarik dengan diskon? (raa)

VIA Umumkan Chipset IGP Pertama di Dunia. VIA
K8M800 merupakan adik dari K8T800. Chipset ini bisa dibilang sebagai pemimpin chipset untuk
platform AMD64 saat ini. K8M800 sudah pasti akan diusung oleh desktop-desktop berbasis prosesor
AMD Athlon 64 dan Opteron generasi berikutnya. Chipset ini merupakan chipset pertama yang yang
mengusung teknologi UniChrome Pro IGP (Integrated Graphics Processor), yang dikembangkan untuk
sistem komputasi 64-bit. IGP merupakan teknologi baru yang bisa menunjang kemampuan multimedia
dan hiburan seperti game. Beberapa produsen motherboard telah mengumumkan dukungannya untuk
chipset tersebut, di antaranya adalah Asus, Biostar, ECS, Gigabyte, MSI dan Shuttle. (raa)

Hukum Antispam Diberlakukan di Amerika Serikat.
Tanggal 16 Desember 2003, Presiden George W. Bush mengesahkan CAN-SPAM Act, peraturan federal
baru mengenai e-mail komersil dan hukuman untuk spam, yang akan mulai diberlakukan di sana mulai
tanggal 1 Januari 2004. CAN-SPAM Act merupakan singkatan dari Controlling the Assault of Non-
Solicited Pornography and Marketing Act of 2003. Peraturan baru tersebut melarang penggunaan
judul informasi yang salah untuk e-mail-e-mail komersil (yang biasanya adalah bulk e-mail). Para
pelanggar akan diberi hukuman serta denda hingga sebesar 250 dolar AS per e-mail, atau paling tinggi
6 juta dolar AS.

Peraturan yang dibuat oleh dua orang Senator AS ini, Conrad Burns (R-Montana) dan Ron Wyden
(D-Oregon), mendapatkan dukungan dari banyak ISP dan perusahaan e-commerce. Menurut American
Online, CAN-SPAM Act merupakan sebuah titik perubahan untuk melawan para spammer. EBay
menyebutnya sebagai berita yang bagus, sedangkan Yahoo mengatakan bahwa aturan tersebut
merupakan sebuah “kemenangan” bagi Internet dan para penggunanya, sebuah senjata ampuh untuk
melawan spam. (raa)
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dari Internet

S

Para pelaku bisnis
pasti sependapat

bahwa kadang-
kadang e-mail saja
tidak cukup dalam

berkomunikasi.
Dokumen cetak resmi

tidak akan bisa
dengan mudah

dikirimkan lewat e-
mail. Lagipula, tidak

semua orang dengan
sabarnya

“nongkrong” di
depan komputer

mereka menunggu e-
mail yang masuk.

Sedangkan fax akan
dengan otomatis

muncul dari mesinnya
tanpa perlu campur

tangan kita.

ecara garis
besar bisa
dikatakan bahwa
memiliki fax adalah

sesuatu yang wajib bagi para
pebisnis dan mereka yang
berencana untuk berbisnis.
Meskipun demikian tidak semua
orang mampu dan mau
membeli mesin fax. Dana
adalah salah satu masalahnya.
Belum lagi jika kita
mengirimkan fax ke negara lain.
Bisa dihitung berapa mahal
biayanya.

Tetapi tidak semua orang
tahu bahwa kita bisa
mengirimkan fax dengan
modem biasa. Kemana saja di
seluruh dunia. Gratis pula!
Lebih banyak lagi yang tidak
tahu bahwa fax juga bisa
dikirimkan lewat e-mail.

Masih melanjutkan
pembahasan minggu lalu
tentang pengiriman fax lewat
Internet, kali ini akan
dilanjutkan dengan yang
gratisan. Tanpa terlalu banyak
basa-basi, mari kita lihat
bagaimana caranya.

KIRIM KE MANA SAJA?
Penyedia jasa layanan ini

adalah “kakeknya” Internet fax.
Sebuah grup non-profit yang
bertujuan untuk membantu

pengguna Internet. Web site
utamanya berada di link ini:
www.tpc.int.

Pertanyaan yang mungkin
muncul pertama kali sebelum kita
menggunakan layanan ini adalah
biaya, yang kedua biasanya
seputar cakupan layanannya.
Apakah Indonesia termasuk di
dalamnya? Hebatnya, tidak
seperti kebanyakan layanan
gratisan di Internet, Indonesia
tidak menjadi anak tiri. Jika Anda
lihat di www.tcp.int/
fax_cover_auto.html, Anda
akan menemukan Surabaya,
Sidoarjo, dan Gresik di sana.

Lalu bolehkah kita berasumsi
bahwa seluruh Indonesia ter-
cover oleh layanan ini? Jangan
terburu-buru. Silakan cek dulu
dengan menggunakan online
tool-nya di www.tcp.int/
verify.html. Sayangnya Bogor
bukanlah salah satu yang
beruntung. Untuk kota-kota lain,
silakan dicek sendiri.

Tetapi secara umum, tidak
ada ruginya menggunakan
layanan ini karena selain gratis,
bisa dikatakan bahwa (hampir)
semua belahan dunia bisa
dijangkau.

LEWAT WEB SITE
Ada dua cara pengiriman fax

yang disediakan: lewat Web site
dan lewat e-mail. Mari kita bahas
yang pertama dahulu.

Yang perlu dilakukan
sangatlah mudah. Kita log-in ke
Web site-nya, mengisi form yang
ada di situ, menekan tombol
Send, dan ... selesai! Tidak bisa
lebih mudah daripada itu.

Alamat situs untuk
pengiriman fax tersebut adalah:
www.tcp.int/sendfax.html.
Adapun field dari form yang ha-
rus diisi adalah sebagai berikut:
• To: diisi dengan nama

penerima
• Room/Office: diisi dengan

nomor atau data ruangan/
kantor penerima

• Fax Number: nomor fax-nya
(sesuai dengan format yang
ditetapkan)

• Subject: sudah cukup jelas
• Your e-mail address: alamat

e-mail Anda untuk konfirmasi
pengiriman

• Body of the fax: isi fax-nya

Dan di bagian bawah ada
dua tombol [Fax It!] untuk
mengirimkan fax, dan [Clear It!]
untuk mengosongkan field yang
barusan kita isi. Tujuannya adalah
untuk memudahkan pengiriman
fax berikutnya.

Format penulisan nomor fax
yang disepakati adalah +[kode
negara]-[kode kota]-[nomer
fax]. Jadi sebuah fax yang akan
dikirimkan untuk seseorang di
Surabaya dengan nomor fax
1234567 akan berbentuk +62-
31-1234567.

MENGIRIM LEWAT E-MAIL
Cara kedua pengiriman fax

adalah lewat e-mail. Hal ini
dimungkinkan dari
pengembangan dari sebuah
eksperimen yang dimulai pada
bulan Juni 1993 (sepuluh tahun
yang lalu!).

Sistem kerjanya adalah kita
mengirimkan pesan ke alamat
server tcp.int dengan
awalan nomor fax yang
kita tuju. Server tersebut
kemudian akan
meneruskan pesan
tersebut ke nomor fax.
Dengan demikian, yang
diperlukan hanyalah
program e-mail client
biasa.

Nah sekarang untuk
sesuatu yang
menyenangkan: “Kita
‘kan bisa mengirimkan e-
mail lewat SMS
(detailnya tidak akan dibahas di
sini karena topiknya berbeda),
maka teorinya kita juga
sebetulnya bisa mengirimkan fax
lewat SMS!” Walaupun terus

terang saya belum pernah
mencobanya, tetapi itu bukanlah
hal yang mustahil untuk
dilakukan. Silakan dicoba dan
update saya mengenai hasilnya.

Lalu mengenai caranya:
• Tulislah sebuah pesan baru.

Biasanya urutan prosesnya
adalah lewat menu
[Message]>[New], tetapi
biasanya ada sedikit
perbedaan tergantung e-mail
client apa yang digunakan.

• Semua field bisa diisi dengan
bebas sesuai dengan data
Anda, termasuk Subject dan
Message body.

• Yang perlu diperhatikan
adalah format penulisan
alamat pada field To. Yaitu:
remote-
printer.recipient_name@
fax_number.iddd.tpc.int. Di
mana recepient_name
diganti dengan nama
penerima fax. Lambang
underscore ( _ ) akan dibaca
sebagai spasi dan lambang
slash ( / ) akan dibaca sebagai
baris baru. Sementara
fax_number dimulai dengan
kode negara dan maksimum
nomor yang diijinkan adalah
15 karakter.

Contoh penulisan alamat:
remote-printer.

Arlington_Hewes/
Room_403@14959682590.
iddd.tpc.int

Akan menghasilkan fax
yang akan dikirim ke nomor
495-968-2590 karena angka 1 di
depan adalah kode negara
untuk USA. Bentuk fax yang
akan diterima adalah sebagai
berikut:

Please deliver to:
Arlington Hewes
Room 403

Isi pesan dalam e-mail akan
terkirim sebagai halaman
terpisah dari fax tersebut. Dan
sebuah e-mail akan dikirimkan
ke alamat pengirim fax sebagai
konfirmasi. Pesan konfirmasi
tersebut bisa menyatakan
bahwa fax sudah terkirim atau
bisa juga memberitahukan
mengenai masalah yang muncul
seperti jika fax tidak terkirim.

Contoh lain:
remote-

printer.Darren_Nickerson/
Room_403@441813434622.
iddd.tpc.int

Pada contoh ini, angka 44
pada awal nomor menyatakan
kode negara untuk UK (United
Kingdom).

Jika Anda membutuhkan
bantuan mengenai kode
negara, lihat daftar lengkapnya
di: http://www.tpc.int/
servers/iddd.html.

Catatan:
• Tipe e-mail seperti ini akan

menghasilkan fax dengan
kurang lebih selebar 80
karakter menggunakan
huruf Courier dengan
ukuran 11. Karena karakter
khusus ataupun lambang
grafis ASCII belum tentu
terlihat “benar” pada hasil
fax yang dikirim, maka
disarankan untuk menjaga
isi pesan sesederhana
mungkin.

• Jika Anda menginginkan isi
fax yang terkirim lebih dari
sekedar teks, dan
memasukkan grafis, jenis-
jenis font khusus, dan lain
sebagainya, Anda bisa
menggunakan software
khusus. Daftarnya bisa
dilihat pada alamat ini:
http://www.tpc.int/clients/
index.html. PC+
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Alex Pangestu
alex@e-pcplus.com

S

Type
Effective Pixel
Focal Length
Digital Zoom

Focusing Range

Autofocus
Optical Viewfinder
LCD Monitor
LCD Pixels
LCD Coverage
Aperture Range
Shutter Speed
Sensitivity
Light Metering Method
Exposure Control Method
AE Lock
White Balance Control

Built-in Flash
Flash Range

Recycling Time
Shooting Mode
Self Timer
Wireless Control
Photo Effect
Continuous Shooting
Storage Media
Print Order Format
Image Recording Format
JPEG Conversion Mode
Number of Recording Pixels

Playback Mode Files

Erase Modes

Computer Interface
Video Out
Other Interface

Power Source

Shooting Capacity

Playback Time
Operating Temperature
Operating Humidity
Dimensions (W x H x D)
Weight

1/2.7 inch Charge-Coupled Device (CCD)
Approx. 3.2 million
5.4 – 10.8mm, f/2.8 – 3.9 zoom lens (35mm film equivalent: 35 – 70mm)
3.2x Digital Zoom (Maximum 6.4x digital zoom is available when combined
with optical zoom)
Normal: AF: 18 in. – Infinity/ 47cm – Infinity, Macro AF: 4 in. – 18 in./ 10cm –
47cm (WIDE); 9 in. – 18 in./ 23cm – 47cm (TELE)
9-point AiAF/ 1-point AF (Fixed to center)
Real image zoom viewfinder
1.5 inch low temperature polycrystalline silicon TFT color LCD
Approx. 118.000
100%
f/2.8/7.1 (W), f/3.9/10 (T)
15 – 1/1,500 sec
Auto/ ISO 50/ 100/ 200/ 400 (equivalent ISO)
Evaluative, Center-weighted Average or Spot Metering
Program AE
Available
Auto, Pre-set (Daylight, Cloudy, Tungsten, Fluorescent, Fluorescent H), or
Custom
Auto, Red-Eye Reduction On/Off, Slow-Sync
1.6 ft. – 9.8 ft./ 47cm–3.0m (WIDE); 1.6 ft. – 6.6 ft./ 47cm – 2.0m (TELE); 11
in. – 18 in./ 27cm – 47cm (Macro) (When ISO is speed is set to AUTO)
Approx. 10 sec. or less
Auto, Program, Manual, Stitch Assist, Movie
Operates with approx. 2 sec. or approx 10 sec. count-down
Not Available
Vivid Color, Neutral Color, Low Sharpening, Sepia, Black & White
Approx. 2.2 shots/sec. (Large/ Fine Mode and LCD monitor is Off)
SD Memory Card
Digital Print Order Format (DPOF) Version 1.1
Still Image: JPEG (Exif 2.2 compliant)
SuperFine, Fine or Normal
Large: 2,048 x 1,536, Medium1: 1,600 x 1,200, Medium2: 1,024 x 768
Small: 640 x 480 pixels
Movie: 640 x 480, 320 x 240 or 160 x 120
Single, Index (9 thumbnail images), Magnification (2x to 10x), or Slide Show
or Movie
Still images: Single Image, All Images
Movie: Part of movie, All movie
USB (mini-B jack)
NTSC or PAL
SD memory card slot. Direct connection to Canon Card Photo Printers and
select Bubble Jet Direct Photo Printers (no computer required), using camera's
USB cable
Rechargeable Lithium-ion battery (NB-3L)
Compact Power Adapter (CA-PS500 & DC Coupler DR-900)
Approx. 180 shots (LCD monitor ON)
Approx. 480 shots (LCD monitor OFF)
Approx. 150 min.
32 – 104°F (0 – 40°C)
10—90%
3.35 x 2.20 x 0.94 in./ 85 x 56 x 23.9mm (Excluding protrusions)
Approx. 5.82 oz./ 165g (Camera body only)

Spesifikasi IXUS II

Autofocus biasanya
menggambarkan metode kamera
dalam menentukan fokus. IXUS II
menggunakan 9 point AiAF.
Maksudnya adalah gambar yang
tertangkap dibagi menjadi grid
3x3. Kemudian pada saat
penguncian fokus, kamera akan
mengambil satu atau beberapa
petak untuk menentukan fokus.
Kamera lain mungkin memiliki
metode yang berbeda.

VIEWFINDER
Selanjutnya adalah optical

viewfinder, LCD monitor, LCD
pixel, dan LCD coverage.
Semuanya ini berhubungan
dengan cara  melihat objek yang
akan kita ambil. Viewfinder
adalah tempat untuk membidik.
Biasanya viewfinder ini
merupakan jendela optis. Namun
ada pula kamera digital yang
membuat viewfinder yang
digital. Viewfinder yang
demikian sering disebut dengan
electronic viewfinder (EVF).

Pada kamera digital yang
bukan SLR, umumnya viewfinder
jarang digunakan. LCD-lah yang
lebih sering digunakan untuk
melihat objek yang hendak
dipotret. LCD monitor maksudnya
adalah LCD yang digunakan di
kamera. Angka 1.5 inch pada
spesifikasi IXUS II menunjukkan
ukuran LCD. LCD pixel
menunjukkan resolusi LCD.
Sedangkan angka 100% pada
LCD coverage menunjukkan
bahwa apa yang terlihat di LCD
adalah hasil yang akan
didapatkan

APERTURE DAN SHUTTER
Berikutnya adalah aperture

range dan shutter speed. Aper-
ture adalah bukaan diafragma.
Semakin besar bukaannya,
semakin banyak cahaya yang
masuk ke lensa. Selain itu,
aperture juga menentukan ruang
tajam. Semakin kecil nilai
aperture semakin kecil ruang
tajam pada gambar. Shutter
speed adalah kecepatan bukaan
rana. Bukaan rana ini
menentukan banyaknya cahaya
yang masuk ke dalam lensa.
Selain itu, shutter speed dapat
digunakan untuk membekukan
gerak (apabila kecepatannya
tinggi) atau malah memberikan
efek gerak (apabila kecepatannya
rendah).

Beberapa kamera memiliki
A/S/M untuk modus pengambilan
gambar. A berarti aperture
priority. Jika modus ini yang
dipilih, maka pengguna kamera
memilih nilai aperture sedangkan
kamera memilih shutter speed. S
berarti shutter, artinya kebalikan
dari A. M adalah manual, di
mana pengguna kamera yang
menentukan nilai aperture dan
shutter.

EXPOSURE
Sensitivity, light metering

method, exposure control
method, dan AE lock dapat
dikelompokkan sendiri. Sensiti-
vity adalah kepekaan CCD (kalau
di analog, kepekaan film) dalam
menangkap cahaya. IXUS II
memiliki sensitivity yang dinilai
dengan ISO. ISO ini sama artinya
dengan ASA. ISO dengan nilai
yang kecil (25-200) digunakan
untuk pemotretan di lokasi
dengan cahaya yang terang,
seperti di bawah cuaca cerah.
Sedangkan ISO dengan nilai
besar (400-3200) digunakan
untuk pemotretan di cahaya yang

kurang. IXUS II memiliki
pengaturan auto untuk ISO.
Artinya, kamera lah yang memilih
nilai ISO yang terbaik untuk
pencahayaan pada saat
pemotretan.

Light metering method
adalah metode pengukuran
cahaya. IXUS II memiliki 3 metode
pengukuran cahaya, yaitu
evaluative, center-weighted
average dan spot metering.
Kamera digital lain pun rata-rata
memiliki metode yang sama.
Evaluative adalah pengukuran
cahaya dengan mengambil
pencahayaan rata-rata dari
seluruh gambar yang terjangkau

Membaca Spesifik
Kamera Digital

IS
TI

M
EW

A

Kamera digital
memiliki berbagai

istilah fotografi pada
spesifikasinya. Bagi

mata yang masih buta
fotografi, istilah-

istilah itu bisa
membingungkan.

Akhirnya yang
mereka pentingkan
hanya resolusi yang

tinggi tanpa
mempedulikan data
spesifikasi yang lain.

Padahal data-data
yang lain itu bisa saja

menunjukkan suatu
fitur tertentu yang

berguna pula.

ebagai studi
kasus, spesifikasi
yang digunakan
adalah spesifikasi

kamera digital Canon IXUS II.

IMAGE CAPTURE DEVICE
Type dan effective pixel

menggambarkan image capture
device, alat yang digunakan
untuk menangkap gambar.
Image capture device sering
pula disebut sebagai sensor
(censor). Pada spesifikasi Canon
IXUS II type yang tertera adalah
1/2.7 inch Charge-Coupled
Device (CCD). Artinya IXUS II
menggunakan sensor CCD
berukuran 1/2.7 untuk
menangkap gambar. Sensor lain
yang sering pula digunakan
adalah CMOS. Effective pixel
adalah resolusi yang paling
efektif untuk CCD.

LENS
Focal length, digital zoom,

focusing range, dan autofocus
dapat dikelompokkan dalam
kategori lensa. Focal length
adalah panjang titik api lensa.
Digital zoom adalah perbesaran
digital yang berbeda dengan
perbesaran dari lensa
(perbesaran optis). Biasanya
akibat perbesaran ini, kualitas
foto menurun karena pixel
dipaksakan untuk membesar.
Angka 3.2x berarti IXUS II
memiliki perbesaran digital
sebesar 3.2x. Dan jika
dikombinasikan dengan
perbesaran optisnya yang 2x,
maka total perbesaran menjadi
6.4x.

Focusing range adalah
jarak di mana kamera bisa
mengambil gambar yang fokus
(tajam). Ada beberapa
perbedaan focusing range pada
modus yang berbeda. Misalnya
IXUS II, pada modus pemotretan
biasa jarak fokus yang bisa
digunakan adalah 18 inci
sampai tak terhingga. Jika
digunakan pada modus wide
macro (untuk memotret benda
kecil dengan menggunakan
focal length terkecil) IXUS II
memiliki jarak fokus 4-18 inci.
Sedangkan untuk modus
telemacro (jarak dekat
dengan focal length terbesar),
IXUS II memiliki jarak fokus 9-18
inci.
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oleh lensa. Center-weighted
average mengukur cahaya di
tengah gambar dan
mengaplikasikannya ke seluruh
gambar. Sedangkan spot meter-
ing mengambil titik tertentu
pada gambar, dan pengukuran
cahaya dilakukan pada titik itu.

Exposure control method
merupakan metode yang
digunakan untuk penguncian
exposure. IXUS II menggunakan
program AE (Auto Exposure)
yang artinya, kamera mengunci
exposure secara otomatis pada
saat fokus terkunci.

AE lock digunakan untuk
mengunci nilai exposure.
Biasanya AE lock ini digunakan
dengan spot metering. Selain AE
lock, kamera digital sering pula
dilengkapi dengan AF lock, yaitu
penguncian fokus.

WHITE BALANCE
White balance digunakan

agar pengguna kamera tetap
dapat mengambil gambar dengan
warna aslinya walaupun
pencahaayaan yang ada
memungkinkan adanya
perubahan warna. Misalnya
adalah pengambilan foto di
bawah lampu tungsten (lampu
yang berwarna kuning). Untuk
mengatasi itu, kamera digital
memiliki pengaturan white
balance. Kamera-kamera digital
rata-rata memiliki pengaturan
white balance yang sama dengan
IXUS II.

FLASH
Hampir semua kamera digital

dilengkapi dengan built-in flash
(lampu kilat) yang dilengkapi
dengan beberapa setting untuk
penggunaan lampu kilat itu.
Setting yang ada pada IXUS II
adalah auto, red-eye reduction,
dan slow-sync. Jika lampu kilat
diatur pada auto, maka kamera

menentukan apakah pada suatu
kondisi pemotretan, lampu kilat
dibutuhkan. Jika dibutuhkan,
maka kamera akan menembakkan
cahaya. Red-eye reduction
digunakan untuk mengurangi
efek mata merah karena mata
yang kaget akan cahaya terang
yang menyala tiba-tiba.

Lampu kilat memiliki jarak
maksimal. Jarak ini tergantung
ISO yang digunakan dan focal
length. Contoh perubahan jarak
lampu kilat, bisa dilihat pada
spesifikasi IXUS II pada bagian
flash range.

Recycling time masih
berhubungan dengan lampu kilat.
Recycling time adalah waktu yang
diperlukan oleh lampu kilat untuk
mengumpulkan tenaga agar
dapat kembali ditembakkan. Pada
IXUS II, angka 10 detik itu berarti
setelah lampu kilat ditembakkan,
IXUS II membutuhkan waktu
sekitar 10 detik untuk dapat
kembali ditembakkan.

SHOOTING
Shooting mode tidak selalu

sama pada tiap kamera digital.
IXUS II memiliki shooting mode
dengan pilihan program, manual,
stitch assist, dan movie. Program
digunakan untuk pemotretan
yang full otomatis. Pengguna
kamera tinggal jeprat-jepret.
Manual adalah kebalikan auto,
yaitu pengguna kamera dapat
mengatur sebagian besar setting-
nya secara manual.

Stitch digunakan untuk
pemotretan panorama yang lebar.
Biasanya untuk memotret sebuah
pemandangan yang luas, foto
diambil beberapa kali dengan
sudut yang berbeda. Dengan
adanya fasilitas stitch ini, bagian
penyambungan foto sudah
disediakan.

Kamera digital banyak yang
dilengkapi dengan fasilitas
perekaman movie. Untuk itulah
shooting mode movie digunakan.
Kamera digital lain mungkin
memiliki lebih banyak shooting
mode seperti sunset, macro, dan
close-up.

Self-timer digunakan untuk
menunda pemotretan beberapa
saat setelah tombol shutter
ditekan. Jadi misalnya, orang yang
memotret juga ingin turut

dipotret, maka ia mengatur self-
timer 10 detik. Maka setelah ia
menekan tombol shutter, ia
bergabung bersama kawan-
kawannya, dan 10 detik
kemudian, kamera baru
memotret.

Kamera yang memiliki
wireless control dapat digunakan
untuk memotret tanpa dipegang
oleh pengguna kamera.
Pemotretan dilakukan dengan
menggunakan remote control
tanpa kabel.

Untuk memberikan efek-efek
tertentu, kamera analog biasanya
ditambah filter pada lensanya.
Dengan kamera digital, filter ini
tidak lagi diperlukan, karena
biasanya sudah tersedia fitur
untuk memberikan efek.
Contohnya IXUS II yang memiliki
efek foto sepia, netral, hitam-
putih, low sharpening, dan vivid.

Continuous shooting adalah
pemotretan secara terus-menerus
selama tombol shutter ditekan.
Angka 2,2 shots/sec pada IXUS II
memberi arti bahwa kamera ini
dapat merekam 2,2 gambar per
detik jika digunakan pada
continuous shooting. Contohnya
tombol shutter ditekan selama 10
detik, maka IXUS II akan menyim-
pan gambar sebanyak 4 foto.

IMAGE STORAGE
Storage media adalah media

penyimpanan yang digunakan.
Ada banyak media penyimpanan
pada kamera digital. Di
antaranya adalah Compact Flash
(CF), Secure Digital (SD), dan
Multimedia Card (MMC). IXUS II
menggunakan kartu SD.

Image recording format
menginformasikan mengenai
jenis file gambar yang digunakan
untuk menyimpan foto di
kamera. Ada beberapa jenis file
gambar, yaitu JPEG, TIFF, dan
RAW. JPEG memiliki kompresi
yang paling tinggi, yang berarti
kualitas gambarnya lebih rendah
dibandingkan dengan TIFF dan
RAW. Namun demikian, JPEG
memiliki ukuran file yang kecil,
sehingga memori dapat lebih
banyak memuat gambar. JPEG
adalah format gambar yang
paling sering digunakan oleh
kamera digital point-and-shoot
seperti IXUS II ini.

Kompresi JPEG bisa diatur
pada kamera digital. IXUS II
menyebut setting untuk kompresi
dengan JPEG Conversion Mode.
Istilah untuk kompresi ini
mungkin berbeda pada tiap
kamera. IXUS II menggunakan
istilah SuperFine, Fine, dan
Normal. Kamera digital lain
mungkin menggunakan Best,
Standar, dan Economy.

Resolusi gambar di kamera
digital bisa diatur. Misalnya IXUS
II yang memiliki resolusi 3MP,
maka ukuran terbesarnya adalah
2.048x1.536 pixel. Tapi resolusi itu
bisa diturunkan, misalnya
menjadi 1.600x1.200 pixel. Inilah
yang dimaksud dengan number
of recording pixels. Pengaturan
resolusi ini berhubungan dengan
ukuran cetak foto.

Kelebihan kamera digital
dibandingkan dengan kamera
analog adalah kamera digital
dapat me-review foto sesaat
setelah foto diambil. Cara
menampilkan gambar ini
dinamakan playback mode files.
IXUS II memiliki mode
pengambilan gambar single,
index, dan zoom. Single
menampilkan satu gambar di
LCD, index menampilkan
beberapa gambar dalam ukuran
thumbnail, sedangkan zoom
menampilkan gambar dengan
perbesaran tertentu, misalnya 2
kali atau 4 kali.

Foto atau video yang tidak
diinginkan bisa langsung dihapus
agar ruang dalam kartu memori
kembali lega. Kamera digital
memiliki beberapa erase mode.
Pada IXUS II, erase mode yang
ada adadalah single image dan
all image untuk foto, serta part
of movie dan all movie untuk
video.

CONECTIVITY
Kamera digital dapat

dihubungkan ke komputer atau
ke televisi. Computer interface
adalah cara menghubungkan
kamera digital ke komputer.
Umumnya, kamera digital
menggunakan Universal Serial
Bus (USB).

Video out adalah jenis video
yang dihasilkan oleh kamera
digital. Pilihan pada IXUS II, dan
juga pada kamera lain, adalah

NTSC dan PAL.
Selain ke televisi dan

komputer, beberapa kamera
dapat dihubungkan langsung ke
printer. Biasanya fasilitas ini
ditandai dengan adanya logo
direct print atau PictBridge.
Dengan adanya fasilitas ini,
kamera tidak perlu
dihubungkan ke komputer lebih
dulu untuk mencetak foto-foto
yang ada di dalam memori.

BATTERY
Catu daya yang digunakan

sebuah kamera digital belum
tentu sama dengan kamera lain.
Ada kamera digital, seperti IXUS
II, yang menggunakan
rechargable lithium-ion batery,
ada pula yang menggunakan
baterai AA. Rechargable
lithium-ion biasanya bisa
bertahan lebih lama daripada
AA. Namun demikian,
rechargable lithium-ion untuk
sebuah kamera biasanya hanya
cocok untuk kamera itu,
sedangkan AA lebih universal
dan lebih mudah diperoleh.

Biasanya spesifikasi kamera
digital juga menyertakan
berapa banyak foto dapat
diambil sebelum baterainya
habis. IXUS II, pada
spesifikasinya, mampu
mengambil 180 foto jika LCD
dinyalakan. Dan, pada saat LCD
dimatikan, IXUS II mampu
mengambil 480 foto. Sedangkan
pada saat digunakan untuk
playback, IXUS II mampu
bertahan selama 150 menit.

LAIN-LAIN
Kamera digital dianjurkan

agar digunakan pada
temperatur tertentu. Operating
temperature memberikan
informasi ini. Sedangkan
operating humidity
menunjukkan pada tingkat
kelembaban berapa kamera
dapat dioperasikan.

Dimensions menunjukkan
ukuran kamera, sedangkan
weight menunjukkan berat
kamera. Berat kamera biasanya
memiliki keterangan lebih
lanjut. Misalnya, tulisan camera
body only seperti pada IXUS II,
berarti angka 165kg adalah
berat IXUS II tanpa baterai. PC+

kasi
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Sejuta Kemungkinan
Pemanfaatan

“Wireless Module”

Selama ini kita
membayangkan bahwa
yang bisa dikoneksikan

melalui teknologi
seluler hanyalah

manusia (yang
memiliki ponsel).

Namun pada tahun
2010 nanti manusia

hanyalah merupakan
sebagian kecil dari

komunitas pelanggan
seluler. Mimpi kali ye?

ercaya nggak
percaya,
setidaknya itulah yang
dikatakan oleh opera-

tor terdepan di Jepang, NTT
DoCoMo. Mereka
memperkirakan bahwa pada
tahun 2010 tersebut, hanya
sepertiga dari 360 juta
pelanggannya yang
“merupakan” manusia (human
being). Sisanya berupa mobil
(sebutlah sebagai car being), PC
jinjing (portable PC being), kapal
(ship being), vending machine
(vending machine being).

Benda-benda mati ini
menjadi anggota masyarakat
seluler berkat sebuah wireless
module yang “dicangkokkan” di
dalam “tubuhnya”. Secara garis
besar wireless module (modul
nirkabel) adalah sebuah paket
elektronik berisi IC yang menya-
tukan berbagai fungsi hubungan
seluler dengan jantung SIM Card
di dalamnya. Kehadiran SIM Card
ini membuat peranti yang dita-
nami modul ini menjadi transmit-
ter, receiver, atau transceiver.

Untuk memudahkan,
bayangkan sebuah mesin ponsel
yang tanpa layar tampilan,
keypad, dan casing. Sebuah
ponsel “barebone”! Berbobot
antara 10 sampai 20 gram, ia bisa
digunakan untuk beragam
keperluan.

KALAU MESIN BISA
NGOMONG

Sebagaimana operator
seluler mempunyai berbagai
layanan bernilai tambah yang
makin bervariasi, maka
kemungkinan untuk
memanfaatkan modul ini dalam
berbagai bidang hanya dibatasi
oleh imajinasi kita saja.

Pernahkah Anda mendapat
kiriman paket dari luar negeri?
Kurir perusahaan jasa pengiriman
internasional seperti DHL, Fedex,
atau TNT sudah dilengkapi
dengan peranti sejenis ini. Begitu
barang diterima oleh yang
berhak, maka ia akan
menggunakan sebuah alat untuk
membaca informasi dari bar code
pada paket. Informasi ini segera
dikirim melalui jaringan seluler
dan segera sampai ke server
utama milik perusahaan tersebut
untuk dapat di-trace statusnya.

Perhatikan bahwa orang
menjadi tidak banyak “cakap”
lagi. Semua dikuasai oleh mesin
yang bisa berkomunikasi antar-
mereka sendiri. Modul nirkabel
seperti ini memungkinkan mesin
pun bicara.

Berbagai skenario yang telah
atau bisa segera diwujudkan
dalam berbagai bidang adalah
seperti berikut ini:

• Rumah Cerdas. Bayangkan
bagaimana kemanan rumah
bisa dimonitor melalui ponsel.
Sebuah kamera yang
dilengkapi dengan SIM Card
dipasang di rumah yang
sedang kosong. Pada kamera
tersebut terdapat sensor baik
gerakan atau suara, sehingga
jika sensor tersebut terpicu
maka kamera akan menjepret
dan mengirimkan gambar
situasi ke sebuah nomor lain.

• Memantau Kesehatan.
Laporan kesehatan seorang
penderita penyakit kronis
tertentu seperti jantung dan
diabetes bisa dipantau tanpa
harus melakukan temu muka
dengan dokter pada frekuensi
tinggi. Sebuah alat portabel
bisa diciptakan untuk
memantau status kesehatan
sang pasien dan
mentransmisikannya ke pusat
pengelolaan penyakit untuk
diambil tindakan seperlunya.

• Meteran. Meteran air atau
listrik di rumah-rumah,
misalnya, bisa dipasangi
dengan modul nirkabel ini
agar bisa langsung
mengirimkan posisi angka
pada suatu saat tertentu
melalui jaringan seluler ke
penyedia layanan air atau
listrik tersebut. Cara ini akan
mengurangi tenaga, waktu,
dan kerepotan yang
dibutuhkan untuk memeriksa
dan mencatat meteran satu
per satu setiap bulannya.

• Transportasi dan Logistik.
Sektor ini kiranya merupakan
sektor yang paling subur bagi
perkembangan modul
nirkabel ini. Pemantaun
terhadap posisi kendaraan
atau barang yang diangkut di
dalamnya bisa dilakukan
dengan memasang modul di
dalamnya. Informasi tracking
ini dapat digunakan baik
untuk mengoptimalkan sistem
pengantaran, memantau
posisi, bahkan dalam kasus
tertentu untuk memantau
kehilangan. Di Jerman,
misalnya, sejak September
2003 lalu setiap truk
dikenakan biaya tol. Namun,
cara menagihnya tidak seperti
yang lazim kita temui di sini
di mana ada petugas di dalam
box yang mengurus struk dan
menarik ongkos. Dalam truk-

truk tersebut dipasangi
wireless module yang setiap
kali lewat akan mencatatnya
untuk kepentingan
penagihan.

• Vending Machine. Beberapa
waktu lalu, operator seluler
IM3 sempat mendemokan
penggunaan vending machine
untuk belanja minuman
softdrink. Kita bisa membeli
minuman kaleng tersebut
cukup dengan mengirimkan
SMS ke nomor tertentu. SMS
tersebut akan memicu mesin
untuk mengeluarkan kaleng
minuman sesuai dengan
pesanan. Ongkos akan ditagih
dengan pengurangan pulsa
senilai harga minuman yang
telah ditetapkan.
Ini adalah salah satu aplikasi
wireless module. Di masa
depan vending machine
seperti ini bisa diterapkan
untuk berjualan berbagai
produk.

• Komputasi Mobile.
Beberapa waktu lalu juga,
PCplus sempat mengulas
sebuah notebook yang sudah
dilengkapi dengan modul

modem GPRS. Dengan modul
tersebut, notebook menjelma
menjadi sebuah peranti untuk
berkomunikasi telepon, serta
dapat digunakanlangsung

untuk mengakses Internet
melalui jaringan GPRS.
Dalam jagad PDA (Personal
Digital Assistance) modul ini
sudah banyak digunakan
dalam bentuk expansion slot,
baik berujud Compact Flash,
Secure Digital, Memory Stick,
atau “jacket”  yang
mempunyai kapabilitas GSM/
GPRS. Modem GSM/GPRS
terpisah juga sudah mulai
banyak ditemukan. Demikian
juga dengan modul yang
langsung ditanamkan pada
PDA tersebut.

• Pemantauan Benda
Berharga. Secara umum,
bisnis yang paling afdol bagi
modul nirkabel ini memang
terdapat pada bisnis
pemantauan. Jika sebuah
benda cukup berharga, maka
pantas “di tubuhnya” kita
tempeli dengan modul ini
agar dapat diketahui
kondisinya sewaktu-waktu.

Mobil, perhiasan, lukisan, dan
lain-lain, bisa jadi kembali ke
pangkuan kita dari status
tercuri berkat tambahan alat
ini.
Pernah mengalami saat-saat
ketika ponsel tercecer di suatu
tempat? Apa yang kita
lakukan? Kita akan berdoa
supaya kita tidak menyetel
mode Silent dan kemudian
melakukan call ke nomor
ponsel tersebut sambil
mendengarkan dengan
seksama. Jika ponsel berbunyi
maka ke arah sanalah kita
menuju dan “Eureka!”. Itu
contoh sederhana betapa SIM
Card memberi jantung
kehidupan kepada benda
mati seperti ponsel.
Bahkan, hewan-hewan langka
yang dilindungi dapat
dipantau dan dicek
keberadaannya. Jika alatnya
cukup canggih, maka
dimungkinkan juga untuk
memantau kondisi fisik dan
lingkungan sang binatang
dan datanya akan menjadi
informasi yang berguna bagi
dia sendiri dan ilmu
pengetahuan.

PENTINGNYA APLIKASI
Apalah artinya kecanggihan

perangkat keras jika tidak bisa
dibuat lebih bernilai tambah?
Aplikasi adalah jiwa perangkat
keras. Dalam konteks tak
terhingganya kemungkinan yang
ditawarkan oleh wireless module,
maka penciuman para
pengembang diuji untuk dapat
mengendus peluang pada
industri ini (yang juga menjadi
tak terhingga).

Setidaknya dua pengembang
lokal telah mencoba
memanfaatkan peluang yang
dibuka oleh modul nirkabel ini.
Mereka adalah Jaksoft dan
Prasimax yang sama-sama
membuat aplikasi yang
dijalankan pada wireless module
keluaran Siemens.

Jaksoft mengembangkan
aplikasi Optimum. Aplikasi ini
dimaksudkan untuk membantu
sebuah usaha menekan biaya
produksi dan distribusinya.
Dengan memanfaatkan teknologi
GPRS, GPS, dan wireless module,
sistem transportasi untuk
distribusi dan logistik bisa dilacak
dan –yang terpenting—
dikalkulasi untuk dapat
dioptimalisasikan. Dalam
hubungan dengan penggunanya,
Jaksoft berperan sebagai Applica-
tion Service Provider (ASP) yang

Jasa kurir yang memberikan layanan pelacakan paket di-
support oleh penggunaan wireless module.
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PBCCH (Packet Broadcast Control
Channel) dan GPRS kelas 10.
Teknologi PBCCH meningkatkan
kapasitas transmisi pada jaringan
GPRS sehingga sangat cocok bagi
transfer data berukuran besar. Modul
ini telah digunakan pada Alva Mobile
Phone Organizer.

TC45
Ini adalah wireless module

pertama di dunia yang mendukung
Java 2 Micro Edition. Dengan
kemampuan Java ini maka
kemampuannya tidak hanya terbatas
pada komunikasi antarmesin semata,
namun juga dapat mengendalikan
fungsi-fungsi pada sebuah aplikasi.

Modul ini diarahkan juga untuk
segmen M2M khususnya pada: fleet
management, vending machine,

aplikasi point-of-sales (POS), dan
gateway GSM.

AC45
Modul yang juga mendukung

jaringan GPRS ini mempunyai ke-
unikan tersendiri, yaitu ketahanan-
nya dalam suhu tinggi. Sampai pada
suhu 75 derajat Celsius, modul ini
masih oke-oke saja, bekerja tanpa
error. Kemampuan ini membuatnya
cocok untuk dimanfaatkan antara
lain pada sektor otomotif.

MC55 DAN MC56
Merupakan modul yang

berukuran sangat kompak dan
masing-masing bekerja pada tiga
band frekuensi. MC55 beroperasi pada
frekuensi yang umum digunakan di
negara-negara Asia dan Eropa, yaitu

bertindak sebagaimana pihak
yang menyewakan layanan
aplikasi.

Sedang Prasimax menyasar
segmen yang lebih kecil, yaitu
Usaha Kelas Menengah (UKM),
dengan membuat sebuah
aplikasi yang akan membuat
sebuah SMS tercetak langsung
ke printer tanpa harus melalui
komputer.

Paket ini dapat
dimanfaatkan untuk usaha
yang membutuhkan hardcopy
dari pemesanan melalui SMS
sebagai bukti tertulis.

Jelas kita berharap bahwa
kita mampu menggali aplikasi-
aplikasi “killer” lain dari
berbagai segi kehidupan di
negeri ini. Selain menabur
manfaat, pengembangnya
tentu juga akan menuai hasil
finansial. PC+

Riset pasar Dataquest
memperkirakan bahwa pasar
dunia untuk wireless module dan
terminal akan mencapai 3,5 miliar
Euro pada tahun 2006. Pasar
tersebut akan berada pada tiga
segmen utama, yaitu: otomotif,
industri, dan konsumen umum.

Menelisik industri ini tak bisa
lepas dari membicarakan produk-
produk wireless module yang
dikeluarkan oleh pemimpin
pasarnya, yaitu Siemens. Produk
ini masuk dalam jajaran Siemens
Information and Communication
Mobile. Divisi Wireless Module-nya
telah mengeluarkan produk-
produk yang menjadikan sampai
akhir tahun ini Siemens menempati
urutan pertama di pasar Eropa dan
di dunia dalam industri tersebut.

Jika dalam dunia PC dikenal
jargon “Intel Inside”, maka di
jagad wireless module ini terdapat
jargon “Siemens Embedded”.

Beberapa produknya adalah:

MC35I (TERMINAL
DAN MODUL)

MC35i yang berujud terminal
berupa alat yang berujud kotak
berwarna hitam dipersenjatai
dengan teknologi GSM dan GPRS.
GPRS yang diusungnya
merupakan GPRS multislot kelas 8
dengan kapasitas transfer data
sampai 85,6kbps (untuk down-
link). Perangkat keras ini
dilengkapi dengan antena, SIM
Card, unit pencatu daya, kabel
koneksi RS232, dan handset.

Alat ini dikembangkan ter-
utama untuk segmen M2M (ma-
chine to machine) alias industri,
seperti untuk keperluan: fleet ma-
nagement, kendali lampu lalu-lin-
tas, sistem keamanan, pemantauan
jarak jauh, pengukuran meteran
jarak jauh, vending machine, atau
mobile office. MC35i ini juga bisa
diperoleh dalam bentuk modulnya
saja, belum dikemas pada boks.

TC35I (TERMINAL
DAN MODUL)

Terminal ini nyaris sama
dengan MC35i, hanya saja ia tidak
mempunyai kapabilitas GPRS
karena memang diperuntukkan
untuk segmen konsumer. Tersedia
juga dalam bentuk modul. Modul
ini telah digunakan pada Falken
Person Alarm dan alat untuk
memantau keberadaan dan
perilaku singa laut.

MC45 (MODUL)
Keunggulan MC45 adalah

bahwa ia mempunyai teknologi
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Salah satu unit terminal modul nirkabel dari Siemens yang
dapat dimanfaatkan untuk berkreasi dengan berbagai
implementasi

“SIEMENS EMBEDDED” (900, 1800, dan 1900 MHz). Sedang
MC56 bekerja pada frekuensi 850,
1800, dan 1900 MHz, yang jamak di-
gunakan negara-negara Amerika

Utara. Karena ukurannya yang mu-
ngil, maka modul ini pas digunakan
untuk peranti mobile seperti
PDA. PC+



plusTrik V • 06 - 12 Januari 2004
PCplus 157

10 |

Kiat Hemat
Ber-GPRS

Mematikan Fasilitas
Auto Expand

Menghilangkan Signature
pada SMS ICQ

Beberapa tahun lalu
ketika koneksi Internet melalui
dial-up masih menjadi andalan
untuk ber-internet di rumah,
pengguna selalu dikejar-kejar
waktu dalam mengakses
Internet. Ya, waktu itu (atau
juga saat ini --- jika Anda masih
ber-dial-up ria) koneksi Internet
dibayar berdasarkan waktu.
Anda melakukan apapun di
Internet atau bahkan Anda
tidak melakukan apa-apa
sekalipun tapi terkoneksi ke
Internet Anda akan
mengeluarkan biaya yang sama
besarnya.

Sekarang kondisinya sudah
berbeda, banyak alternatif
koneksi yang lebih murah dan
lebih cepat yang dapat
digunakan. Anda bisa
menggunakan cable, Wi-Fi, atau
GPRS yang saat ini marak

digunakan pengguna ponsel.
GPRS merupakan solusi ber-
Internet secara mobile atau bagi
pengguna rumahan yang
rumahnya agak “terpencil” yang
tidak terjangkau kabel telepon
namun mendapat sinyal ponsel.
Tak jarang juga pengguna ponsel
menggunakan GPRS karena
beberapa operator yang masih
menerapkan flat rate untuk akses
GPRSnya, sehingga Internet bisa
diakses dengan jauh lebih murah.

Bagaimana dengan
pengguna yang operatornya
men-charge penggunaan GPRS
per-kilo byte? Terpaksa kita harus
mampu menahan diri untuk tidak
terlalu sering membuka situs
yang tidak perlu agar tagihan
tidak membengkak.

Meskipun kita sudah selektif
dalam membuka sebuah situs,
yang biasanya “menguras”

bandwidth justru gambar-
gambar yang ada di dalamnya.
Kadangkala besarnya gambar
yang di-download malah lebih
besar dibandingkan isi teks
situsnya sendiri, padahal tidak
selamanya kita membutuhkan
gambar-gambar tersebut.
Solusinya: nonaktifkan seluruh
gambar pada situs yang Anda
buka! Dengan  begini, tagihan
Internet Anda tantu akan
berkurang, karena data yang
disalurkan menjadi lebih sedikit.

Pada ponsel Nokia Anda
dapat menonaktifkan gambar
di situs WAP dengan cara:
1. Masuk ke menu

[Services]>[Settings]>[Appearance
settings].

2. Pilih [Show Images],
kemudian tekan [No].
Sedangkan jika Anda

menyambungkan ponsel
dengan PC (Internet over GPRS)
untuk mengakses Internet ikuti
langkah-langkah berikut:
1. Klik [Start]>[Control

Panel]>[Network and
Internet
Connections]>[Internet
Options].

2. Ketika jendela Internet

Properties telah terbuka, klik
tab [Advanced].

3. Carilah menu Multimedia di
kotak Settings.

4. Hilangkan tanda centang
pada checkbox [Show
Pictues].

5. Klik [OK] untuk menyimpan
perubahan yang telah Anda
lakukan.
Dengan cara ini, konsekuen-

sinya gambar tidak lagi muncul di

Jika kita belum
memiliki ponsel
atau ingin mengirit pulsa,
biasanya kita akan
menggunakan jasa SMS gratis
yang dulu banyak tersedia di
Internet. Sayangnya semakin
lama penyedia fasilitas tersebut
semakin banyak yang bergugu-
ran. Kalaupun ada, operator
yang didukung hanya satu atau
dua operator saja. Salah satu
penyedia SMS gratis paling
populer yang mendukung ba-
nyak operator dan masih ber-

tahan adalah ICQ. SMS melalui
ICQ ini mendukung pengiriman
SMS ke nomor operator
Telkomsel, Excelcom, dan Indosat.

Ketika kita menggunakan
fasilitas ICQ ini untuk mengirim
SMS, umumnya si penerima akan
mendapatkan pesan yang berisi
nick dan nomer ICQ Anda.
Catatan berupa nama dan nomor
ICQ ini jelas akan memboroskan
jumlah karakter yang seharusnya
bisa kita gunakan untuk diisi
pesan. Karakter yang tersisa
untuk pesan tidak lagi 160

karakter, namun menjadi sekitar
130-an karakter saja. Selain itu,
membiarkan signature tetap aktif
akan mengakibatkan penerima
SMS di ponsel mengetahui nomor
ICQ kita. Ingin privasi lebih ter-
jaga dan karakter SMS yang lebih
panjang? Yuk, ikuti langkah be-
rikut untuk menonaktifkan signa-
ture pada SMS yang kita kirim.
1. Aktifkan program ICQ di PC

dengan mengklik [Start]>[All
Programs]>[ICQ]>[ICQ].

2. Pada jendela utama ICQ klik
tombol [Main], setelah itu klik

[Preferences...].
3. Akan muncul window baru

dengan judul Owner Prefer-
ences For: ....

4. Pilih menu SMS Messages
yang berada di bagian kiri.

5. Di sebelah kanan window
akan muncul tab [Settings].
Hilangkan tanda checkbox

yang bertuliskan [Add
signature to outgoing SMS
messages].

6. Untuk menutup window
Preferences klik tombol
[OK].

Steven Andy Pascal
steven@e-pcplus.com

ponsel dan browser Anda,
namun tagihan GPRS Anda jelas
lebih akan terkendali. Pilih
mana, tanpa gambar tapi
murah atau dengan gambar
tapi tagihan membengkak?
Semuanya tergantung
keinginan dan kantong Anda
tentunya.

Steven Andy Pascal
steven@e-pcplus.com

Di dalam Windows Explorer milik XP maupun milik
Windows Server 2003 terdapat suatu fasilitas yang menurut saya
kurang bagus. Yaitu jika Anda mengklik sebuah folder yang berada
di window sebelah kiri, maka folder tersebut langsung secara
otomatis meng-expand dirinya dengan menampilkan semua folder
dan file ZIP, walaupun kita tidak meng-klik tanda (+) yang berada di
samping folder atau men-doubleclick-nya. Fasilitas tersebut kurang
menyenangkan karena seandainya di dalam folder tersebut terdapat
puluhan bahkan ratusan folder atau file ZIP, maka scroll bar akan
menjadi lebih kecil dan panjang.

Untuk mematikan fasilitas tersebut, jalankan regedit lalu masuk
ke key HKEY_CURRENT_USER\Software\Microsoft\Windows\
CurrentVersion\Explorer\Advanced. Dari sana carilah entri yang
bernama FriendlyTree dan ubahlah value-nya yang tadinya 1
menjadi 0. Setelah itu restart PC Anda. Sebagai catatan, fasilitas Auto
Expand ini hanya terdapat pada versi Windows XP ke atas.

Rully Novrianto
roolee@telkom.net
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Membuat Screen Saver
dari File Gambar

Merepresentasikan Data
dalam Bentuk Grafik pada Star Write

Penggunaan chart
pada beberapa jenis dokumen
diperlukan. Keperluan itu di-
dasari atas fungsi chart untuk
pengambilan keputusan. Chart
akan mempermudah pengguna
dokumen mendapatkan gamba-
ran keadaan suatu hal. Star
Write mempunyai fasilitas chart
yang dapat dengan mudah
merubah bentuk data ke dalam
sebuah representasi grafik.
Terdapat beberapa bentuk yang
dapat dipergunakan. Pengguna
tinggal memilih sesuai dengan
kebutuhan dokumennya.

MEMBUAT TABEL
Star Write tidak mengijin-

kan pengguna memasukkan
data secara langsung untuk
chart pada ruang kerja. Data
yang sudah dipersiapkan harus
dimasukan terlebih dahulu ke-
dalam sebuah tabel. Oleh ka-
rena itu hal pertama yang dila-
kukan adalah membuat tabel.

Pertama klik tombol
[Insert] pada toolbar utama.
Secara default tombol tersebut
akan mengacu pada pembuatan
tabel. Selain melalui toolbar
utama, tabel dapat dibuat
melalui menu Insert, yaitu
melalui submenu [Table]. Klik
submenu tersebut atau
pergunakan tombol shortcut
[Control]+[F12] (Gambar 1).

Akan tampil sebuah kotak
dialog Insert table yang
meminta pengguna
memasukkan beberapa atribut,
di antaranya: nama tabel,
ukuran tabel, dan beberapa
pilihan. Ukuran tabel adalah

berupa kombinasi antara
banyaknya kolom dan baris yang
akan dimasukkan. Di sebelahnya
terdapat beberapa pilihan yang
berfungsi untuk memberi
karakteristik bentuk tabel. Untuk
memberikan kesan berbeda,
pilihlah bentuk tabel melalui
tombol [Autoformat] (Gambar 2)
. Klik [OK] untuk memulai proses.

Untuk membuat tabel tampil
beda tambahkan pula efek
border. Klik kanan pada lembar
kerja yang akan menampilkan
menu [Context. Pilih submenu
[Paragraph], namun sebelumnya
sorot dahulu tabel yang akan
dimanipulasi. Setelah kotak
dialog Paragraph muncul, pilih
tab [Borders]. Sesuaikan jenis
border yang dipilih melalui kotak
Presents, atau efek bayangan
pada opsi Shadow Styles. Selain
itu terdapat pula beberapa efek
tambahan kotak dialog Pre-
sents, yaitu Background,
Numbering, Tabs, Alignment,
Indent&spacing, Text flow, dan
Drop caps.

MEMBUAT CHART
Terdapat beberapa macam

chart yang disediakan Star Write.
Pengguna dapat memilih di an-
tara bentuk lines, pies, columns,
xychart, bars dan lainnya.
Tentunya pemilihan bentuk
tersebut disesuaikan berdasarkan
karakteristik penggunanya.

Sorot keseluruhan isi tabel,
kemudian klik tombol [Insert
Object] pada toolbar utama.
Akan tampil kotak dialog
Autoformat Chart seperti
Gambar 3. Header yang tampak

pada setiap kolom dan baris pada
tabel berfungsi sebagai garis
absis dan ordinat pada grafis. Klik
tombol [Next]. Langkah ke dua
ini membawa pengguna pada
pilihan chart. Chart hasil akhir
dapat dilihat pada opsi [Preview].
Pengguna dianjurkan
menentukan penempatan data,
apakah diletakkan pada baris
atau kolom. Berikutnya, tentukan
grid lines untuk membantu
proses pembacaan data pada
chart. Selanjutnya masukkan
judul chart. Pilihan [Legend]
memungkinkan chart berisi

informasi data series dalam
warna. Tambahkan pula judul
untuk deretan data vertikal dan
horizontal melalui opsi aksis x
dan aksis y. Klik [Create] untuk
memulai pembuatan chart.

MEMODIFIKASI CHART
Jika kemudian chart yang

dihasilkan kurang memenuhi
selera, diperlukan modifikasi.
Modifikasi dapat berupa peruba-
han posisi chart dari tabel, atau-
pun merombak chart secara fisik.

Posisi chart dapat dirubah
dengan mempergunakan cut/paste

untuk memindahkannya di atas
atau dibawah tabel. Klik pada area
chart, kemudian cut dan paste
pada area yang dikehendaki.

Untuk pengeditan secara
fisik, klik gandalah pada chart.
Pada toolbar utama akan tampil
fasilitas pengedit chart. Beberapa
keterangan dalam dapat diubah
dengan cara melakukan klik gan-
da. Setelah itu pengeditan dapat
dilaksanakan. Untuk menyelesai-
kannya, klik sembarang area.

Type chart dapat pula diru-
bah dengan mengakses tombol
[Edit Chart Type] pada toolbar
utama. Akan muncul kotak
dialog Chart Type (Gambar 4).
Di dalamnya terdapat pilihan
untuk bentuk 2D (dua dimensi)
atau 3D (tiga dimensi). Klik [OK]
untuk menyelesaikan pilihan.

Budhi Dharmawan
onenko@hotmail.com

Anda mungkin
sudah tahu ada banyak
program untuk membuat screen
saver. Namun trik kali ini lain
karena tidak diperlukan
program tambahan dan tidak
ada file yang harus diinstal atau
dieksekusi.
Anda hanya menentukan folder
yang isi file di dalamnya akan
ditampilkan ke screen saver dan
otomatis gambar-gambar yang
ada akan ditampilkan dalam
screen saver. Berikut langkah-
langkah yang harus Anda
lakukan:
1. Buka jendela Display

Poperties ([Start]>[Control
Panel]>[Display]).

2. Klik tab [Screen Saver] lalu
pada pilihan screen saver (di
bawah tulisan Screen

Saver) pilih [My Pictures
Slideshow] untuk Windows
XP dan pilih [My Picture
Screen Saver] untuk Win-
dows Millenium.

3. Klik tombol [Setting] untuk
melakukan konfigurasi. Pada
jendela [My Pictures Screen
Saver Options], klik tombol
[Browse] untuk menentukan
folder yang file di dalamnya
akan ditampilkan pada
screen saver. Perhatikan
bahwa jika ada subfolder di
bawah folder yang Anda
pilih, file gambar di
dalamnya juga akan
ditampilkan dalam screen
saver nanti.

4. Sebagai konfigurasi
tambahan Anda bisa
menentukan lamanya tiap

gambar yang akan
ditampilkan dalam slide,
besar gambar yang akan

ditampilkan, efek transisi,
atau menampilkan atau
menyembunyikan nama file

dalam screen saver.
5. Sebelum keluar, Anda bisa

melihat hasilnya dengan
melakukan klik pada tombol
[Preview]. Jika sudah beres,
tekan tombol [OK].
File yang ditampilkan

dalam screen saver dapat
diubah kapan saja dengan cara
yang sama seperti di atas.

Rachmad Hakim Sutarto
rachmad_hakim@yahoo.com

Gambar 1 Gambar 2

Gambar 1 Gambar 2

Gambar 3 Gambar 4
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Hanung Jati Purbakusuma
langit_byru@yahoo.com Menggunakan HTML

Executable untuk
Dokumentasi (Bagian-1)

F

Sejak booming World
Wide Web, orang

mulai
menggandrungi file

berformat HTML
dalam menyusun

suatu dokumen. Ini
disebabkan

kelebihannya dalam
me-link

(menghubungkan)
berbagai file dan
halaman dengan

sekali klik pada kata,
kalimat, atau simbol

lain yang telah
ditandai dengan

hyperlink

ormat html
tersebut terus
dikembangkan hingga
saat ini karena html

cukup bertenaga untuk memuat
berbagai file multimedia mulai
dari sekadar gambar, suara,
hingga animasi. Selain itu dengan
ditambahkannya beberapa script-
script tertentu, html bisa menjadi
lebih interaktif dan menarik.

Karena itulah format ini
kemudian tidak hanya digunakan
untuk keperluan internet saja
melainkan juga dipergunakan
dalam presentasi, pembuatan file
dokumentasi, help files, manua, e-
book serta keperluan-keperluan
lain.

Namun untuk keperluan
tersebut, file-file html tadi
seringkali menghabiskan banyak
tempat di harddisk. Memang kita
dengan mudah bisa
mengompresnya dengan WinZip
atau WinRar. Tetapi tidaklah
praktis kalau jika ingin
menggunakannya kita harus
mengestraknya secara manual
terlebih dahulu. Lagipula
pengguna yang ingin melihat
dokumen tersebut terpaksa harus
mencari file halaman awal yang
biasanya diberi nama Index.html.
Itupun kalau diberi nama Index,
kalau namanya lain tentu kita
harus mencari dengan membaca
tiap halaman satu-persatu.

HTML EXECUTABLE
Untuk keperluan tersebut,

G.D.G. Software menciptakan
HTML Executable. Menurut
pembuatnya, HTML Executable
adalah tool untuk mengompilasi,
mem-package dan
mendistribusikan website, file
html dan file  lain yang
berhubungan. Dengan HTML
Executable kita dapat memilih
untuk membuat sebuah file
tunggal yang bisa dijalankan
(executable file) yang Self-
Extracting dengan dijalankan
dalam browser kita maupun yang
membawa viewer-nya sendiri dari
file html yang telah kita buat
sebelumnya.

Untuk memulai
menggunakannya, pertama-tama
tentu kita harus meng-install-nya.
HTML Executable ini bisa kita
peroleh di website G.D.G.
Software http://
www.gdgsoft.com/. Setelah di-
download, klik file executable

yang kemudian akan membawa
kita ke dalam proses instalasi. Ikuti
setiap langkahnya, jika sudah selesai
aktifkan HTML Executable.
Software ini memberikan kita dua
pilihan hasil akhir kompilasi yaitu
Self-Extracting Package dan
Stand-Alone Viewer Package.

SELF-EXTRACTING PACKAGE
Untuk bagian yang pertama,

pada edisi kali ini  kita akan berlatih
membuat file kompilasi dengan
hasil akhir menggunakan pilihan
yang pertama, Self-Extracting
Package. Hasil akhir dari Self-
Extracting Package ini adalah file
berformat *.exe yang memerlukan
browser Internet untuk melihatnya.
Namun kelebihannya, kita dapat
mengeksploitasi semua kelebihan
html, script-script
serta komponen-
komponen lain
yang didukung
selama browser
yang digunakan
untuk melihat juga
mendukungnya.

Cara kerjanya,
ketika kita
mengaktifkan file
hasil kompilasi
(*.exe), sebuah
browser default di
komputer kita
akan terbuka dan
secara bersamaan
file tersebut akan mengekstrak isi
dirinya ke folder sementara. Setelah
kita selesai browsing dan
mematikan browser, file-file di
folder temporary tersebut pun
dihapus. Dengan mode ini, tentu
saja pengguna harus memiliki
paling tidak sebuah browser
Internet untuk mejalankan file
tersebut.

Kelebihan mode ini adalah,
seluruh kode, gambar dan
komponen lain dari file yang kita
ekstrak tersebut dengan mudah
dapat dilihat dan dikopi dengan
membuka
temporaryfolder.
Kelebihan
lainnya adalah
ukuran file-nya
yang relatif lebih
kecil dari  pilihan
kedua. Berikut ini
adalah cara
penggunaannya:

1.  Pastikan
dahulu bahwa
HTML Executable
sudah ter-install.
Jika belum, klik ke
http://www.
gdgsoft.com/ dan
download file instalasinya yang
merupakan versi percobaan, install
dan kemudian aktifkan. Versi ini
sudah memiliki semua kemampuan
dasar dari HTML Executable.

Setelah mencoba dan Anda ingin
lebih, Anda dapat membeli versi Lite
maupun Professional dari website
tadi.

2. Siapkan file-file html dan
semua komponennya yang akan
Anda kompilasi dalam satu folder
khusus. Pastikan tidak ada file lain
yang tidak berhubungan dalam
folder itu. Cek juga dalam folder-
folder dibawahnya. Jika file-file
Anda itu ternyata belum dibuat,
buat dulu, karena tentunya Anda
tidak bisa mengompilasi jika tidak
ada yang bisa dikompilasi.

3.  Klik New pada toolmenu atau
pada menu [File] > [New Project].
Maka akan terbukalah jendela New
Project.

4.  Pada jendela New Project
pilihlah tab Self-Extracting
Package, lalu klik [OK]. Terbukalah
jendela Self-Extracting Publica-
tion Properties.

5. Pada jendela Self-Extracting
Publication Properties ini kita
harus mengisikan file yang akan
menjadi default homepage. Default
homepage ini adalah file html yang
pertama kali dibuka pada browser
sebagai halaman awal. Ketikkan
letaknya atau klik [Browse] untuk
mencarinya. Setelah itu klik [OK].

6.  Setelah itu kita harus
mengonfigurasi dokumen kita
dalam panel Publication Settings.
Pilihannya disediakan dalam

beberapa tab. Pada tab
General ketikkan judul
dari dokumen Anda,
judul ini akan
ditampilkan pada Title
bar dan message box.
Lalu isi juga contact
information untuk
pemberitahuan kepada
pengguna tentang kita
sebagai pembuat dan
pembuatan informasi
hak cipta. Isikan pula
status text (wajib jika
tidak dibuat silent)
untuk ditampilkan pada
saat unpacking file Anda pada tab
Files Option. Di sini Anda juga
dapat menampilkan animasi

pembukaan dalam
format AVI sebagai
pengganti animasi
standar milik HTML
Executable, atau jika
tidak suka kita dapat
memilih silent extrac-
tion. Anda juga bisa
menambahkan About
message serta readme
text untuk
menampilkan informasi
tentang Anda pada tab
Main Dialog. Pada tab
Web Browser kita
dapat mengonfigurasi ukuran
jendela browser (normal, minimize,
maximize, hide).  Tambahkan pula
password jika Anda tidak ingin
orang lain membuka file Anda ini
dengan mengaturnya pada tab
Security. Password ini berlaku
global.

7.  Klik panel [Files Manager]
dan lihat apakah semua file yang

terkait ada di situ. Jika ada yang
kurang klik [Add] dan tambahkan,
jika ada yang tidak Anda butuh-
kan Anda dapat membuangnya
dengan mengklik [Remove].

8.  Klik panel [Output] dan
isikan nama file hasil kompilasi,
pada Advanced Options Anda
dapat menentukan Compression
Level yang akan mengatur level
kompresi file-file Anda.

9.  Setelah selesai simpan
dengan mengklik [Save], beri

nama file (*.hep,
sebaiknya sama dengan
nama file hasil kompilasi
agar tidak bingung) lalu
klik [OK].

10.  Terakhir klik
[Build] untuk
mengompilasi, setelah
selesai akan ada log yang
ditampilkan. Untuk
mengetesnya klik pada
file yang tadi Anda
kompilasi (*.exe).

Setelah Anda mengklik
[Build] tadi maka hasil
kompilasinya akan tersimpan
dan selesailah semua proses
pembuatan file Self-Extracting
Package ini. Hasilnya bisa Anda
nikmati pada browser Internet
kesayangan Anda. Untuk versi
trial ini Anda juga dapat
menyebarkan hasil kompilasinya
kepada orang lain selama tidak

untuk kepentingan
komersial (hanya
untuk personal dan
pendidikan).
Selanjutnya, pada
edisi depan kita akan
membuat file dengan
mode Stand-Alone
Viewer Package
yang tidak
membutuhkan
browser Internet lagi
karena sudah
membawa viewer
sendiri. PC+
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Cakrawala Gintings
cakra@e-pcplus.com Menggunakan

Dua Kartu Suara
Sekaligus pada PC

M

Kartu suara, sesuai
namanya,

bertanggung jawab
mengenai perkara

bunyi-bunyian pada
komputer. Pada PC

yang banyak
digunakan sekarang
ini, praktis tidak ada

lagi PC tanpa kartu
suara.

ainboard
masa kini
pun sudah
dilengkapi dengan

kartu suara yang terintegrasi.
Jenis yang banyak digunakan
adalah AC ’97, yang
implementasinya tidak
terlampau memberatkan
pembuat mainboard.
Umumnya, bila seseorang
memutuskan untuk meng-
upgrade kartu suara yang
digunakannya dari yang
terintegrasi menjadi add-on,
kartu suara yang terintegrasi
akan dinonaktifkan.

Sebenarnya selama tidak
terjadi konflik terhadap
resource yang digunakan, kartu
suara yang terintegrasi bisa saja
tetap digunakan bersama-sama
yang add-on. Satu hal yang
perlu diingat adalah jangan
sampai kartu suara yang
terintegrasi tersebut

mengganggu kartu suara yang
add-on.

AKTIFKAN KARTU SUARA
TERINTEGRASI

Umumnya, seseorang yang
memiliki kartu suara add-on
terpasang pada PC-nya hanya
menggunakan kartu suara
tersebut. Agar kartu suara yang
terintegrasi juga berfungsi, opsi
untuk menggunakan kartu suara
terintegrasi ini harus diaktifkan
pada BIOS.

CARANYA?
Masuklah ke dalam Setup

BIOS dan pilihlah menu Inte-
grated Peripherals lalu
aktifkanlah AC ’97 Audio
ataupun Onboard/Integrated
Audio. Bisa saja item mengenai
kartu suara yang terintegrasi ini
terletak pada menu dengan
nama yang berbeda, namun
umumnya terletak pada menu

Integrated Peripherals
tersebut. Setelah
itu simpanlah setting
BIOS tersebut pada
CMOS dan
keluarlah dari
Setup BIOS.

Setelah
masuk pada
sistem
operasi
yang
diguna-
kan,
seharus-
nya sistem
operasi
tersebut
akan men-
deteksi
adanya
hardware baru.
Install-lah
driver yang
sesuai dan restart-
lah sistem bila
memang diperlukan. Setelah
melakukan restart seharusnya
kartu suara terintegrasi Anda
tersebut sudah berjalan dengan
benar. Bila Anda menggunakan
Windows, periksalah melalui
Device Manager, properti dari
kartu suara terintegrasi
tersebut. Bila ada masalah,
seharusnya sistem operasi yang
digunakan akan
memberitahukan. Jangan lupa
juga untuk memeriksa properti
dari kartu suara add-on yang
digunakan untuk memastikan
tidak ada masalah.

PILIH KARTU SUARA YANG
INGIN DIGUNAKAN

Setelah kedua kartu suara
tersebut berfungsi dengan baik
tanpa masalah, bilaPeriksa jangan sampai terjadi konflik antara kedua kartu suara.

menggunakan Windows XP,
masuklah pada Sound and
Audio Devices yang tersedia
pada Control Panel untuk
memilih kartu suara mana
yang akan digunakan pada
kondisi default. Pengaturan
ini tersedia pada menu Audio.
Anda bisa mengatur kartu
suara mana yang secara
default akan digunakan
untuk playback dan kartu
suara mana yang akan
digunakan secara default untuk
recording.

Bila Anda menggunakan
software yang memiliki opsi
untuk memilih piranti audio yang
digunakan, Anda bisa
menentukan software tersebut
untuk menggunakan kartu suara
yang diinginkan, tidak harus

sama dengan yang pada
Control Panel. Bila Anda
menggunakan beberapa
software seperti ini, Anda bisa
menjalankan dua buah software
sekaligus dan menentukan
kartu suara yang add-on
digunakan oleh software yang
satu dan yang terintegrasi
digunakan oleh software yang
satunya lagi. Hal ini misalnya
akan membolehkan Anda
mendengarkan sebuah lagu
menggunakan headphones dan
kartu suara add-on sementara
teman Anda mendengarkan
lagu yang berbeda
menggunakan headphones
yang lain dan kartu suara
terintegrasi. PC+
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Pengatur Letak
Wallpaper

Wallpaper Aligner

Membangun Screen Saver
dengan Mudah

Screen Saver Builder

WALLPAPER ALIGNER. Tercermin dari namanya,
software ini sangat bermanfaat pada saat kita ingin mengatur letak
wallpaper di desktop. Berbagai posisi wallpaper adalah menjorok ke
kiri, kanan, atas, atau bawah.

Software ini penggunaannya sederhana sekali. Setelah kita
menginstalnya, kita dapat menjalankan Wallpaper Aligner dari start
menu. Setelah Wallpaper Aligner dijalankan, Wallpaper Aligner,
secara otomatis, me-load wallpaper anda.

Untuk mengatur letak wallpaper secara horizontal, klik tombol
[Left], [Center], dan [Right]. Sedangkan untuk mengatur letak
wallpaper secara vertikal, dapat dilakukan dengan mengklik tombol
[Top], [Center], dan [Bottom]. Dan jika anda sudah yakin dengan
tata letak wallpaper tersebut, anda dapat mengklik OK untuk
melihat hasilnya.

Software yang berukuran 332KB ini dapat Anda download
secara gratis di www.12noon.com.

Fadlan Setiaji
aji-edl@plasa.com

Generasi Baru
untuk Emulasi CD

DAEMON Tools v3.41

MELIHAT KOLEKSI
GAMBAR kegemaran
tentunya merupakan suatu
kegiatan yang sering dilakukan
dalam berkomputer. Anda,
pemilik komputer, dapat
menikmati koleksi gambar
dengan menyulapnya menjadi
screen saver, karena koleksi
gambar tersebut dapat kita
jadikan screen saver.

Bagaimana kalau kita ingin
membuat koleksi gambar
tersebut menjadi screen saver
yang menarik  dan sesuai
dengan keinginan kita? Untuk
itu kita dapat menggunakan
shareware berjudul Screen Saver
Builder yang dapat di-download
dari www.mgshareware.com.

Apa saja yang dapat
dilakukan oleh Screen Saver
Builder? Dengan software ini,
kita dapat membangun screen
saver sendiri dengan
menambahkan efek dan
mengatur waktu (redraw speed)
penampilan gambar. Gambar-
gambar yang akan ditampilkan
juga dapat diatur agar
ditampilkan secara acak
(shuffle) dan ditampilkan satu
layar penuh (fit to screen).
Format gambar yang dapat
digunakan adalah JPEG, GIF,
BMP, dan PPM.

Dengan Screen Saver
Builder, kita dapat
menambahkan alunan musik

berformat WAV, MID, dan MP3.
Suara atau musik yang kita dipilih
juga dapat diatur supaya
dimainkan secara acak dan kita
dapat tentukan berapa lama
jarak (delay) antar musik
tersebut.

Untuk memudahkan kita
dalam membuat screen saver, kita
dapat menyimpan pekerjaan ke
dalam project yang dapat kita
modikasi sewaktu-waktu. Kita
juga dapat menentukan format
yang dihasilkan, yaitu SCR atau
EXE. Aplikasi ini juga
memperbolehkan kita
menambahkan informasi singkat,

nama pembuat, dan membuat
teks read me pada screen saver
yang kita buat.

Screen Saver Builder dapat
digunakan pada sistem operasi
Windows 9.X, Windows NT, dan
Windows XP.

Dengan berbagai macam
fasilitas dan tampilan aplikasi
yang mudah dimengerti, maka
Screen Saver Builder merupakan
tools yang tepat jika anda ingin
membangun screen saver yang
menarik. Silakan mencoba.

Adhitya Christiawan
Nurprasetyo

keftones14@yahoo.com

KITA SUDAH
MENGENAL teknik
emulasi CD dengan cara
membuat image dari CD
tersebut dengan software-

DAEMON Tools di Windows,
Windows sudah harus memiliki
Windows Installer yang terbaru.
Seandainya belum diinstal,
Windows Installer dapat di-
download dari situs milik
Microsoft
(www.microsoft.com).

Ada cara lain untuk
memperoleh Windows Installer,
yaitu dengan cara menginstal
software apa saja yang terhitung
baru. Contohnya, ACDSee versi 5
atau Office XP. Karena dengan
menginstal software-software
tersebut, Windows installer yang
terbaru akan otomatis terinstal
juga.

Setelah diinstal, Anda tidak
usah me-restart PC Anda karena
pada Windows Explorer sudah
terlihat drive virtualnya. Jumlah
drive virtual bisa ditambah

menjadi empat drive. Selain itu,
Anda juga bisa memilih DVD
Region bagi yang membuat
image dari DVD.

DAEMON Tools bisa di-
download di www.daemon-
tools.cc dengan ukuran file
505KB.

Rully Novrianto
roolee@telkom.net

software seperti Virtual Disk,
Clone CD, dan Nero. Namun
sayangnya, file image yang
diciptakan oleh software-
software yang sudah disebutkan,

hanya bisa bisa dibaca oleh
software itu sendiri. Jadi, image
yang diciptakan oleh Nero hanya
bisa dibaca dengan Nero. Virtual
Disk maupun Clone CD tidak bisa

membaca image hasil Nero.
DAEMON Tools adalah

sebuah software yang bisa
membaca hampir semua file
image dalam format CUE/BIN,
ISO, CCD (CloneCD), BWT
(Blindwrite) , MDS (Media
Descriptor File), CDI
(Discjuggler), NRG (Nero), dan
PDI (Instant CD/DVD).
Walaupun aplikasi ini bisa
membaca banyak format tapi
tidak bisa membuat image.
Untuk membuat image,
software yang dianjurkan
oleh pembuat DAEMON Tools
adalah Disc Juggler, CDRWin,
Alcohol 120%, Disc Dump,
CloneCD, atau Blindread.

Untuk menginstal
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Mengamankan Aplikasi
dari Tangan-tangan Jahil

Password Protection System Lite

Backup untuk Outlook
OutSource-XP

Windows dengan
Taskbar MacOS X

MobyDock

ANDA, yang memiliki komputer yang sering dipakai oleh orang
lain, mungkin memiliki beberapa software yang tidak boleh
digunakan oleh orang lain. Sebagai contoh, Anda tidak ingin agar
orang lain menggunakan komputer Anda untuk main game, Anda
tidak ingin agar ada orang yang mengutak-utik registry dengan
Regedit, dan Anda
tidak ingin agar ada
orang yang
mengubah setting di
MSconfig. Untuk itu,
Anda membutuhkan
software yang dapat
melindungi software-
software tersebut.

Jika Anda meng-
alami kasus seperti
tadi, maka Password
Protection System Lite
adalah software yang
Anda butuhkan.

Software ini dapat memproteksi file apa saja yang berekstensi EXE.
Password Protection System dapat diperoleh di

www.ppsplus.net. Setelah freeware ini diinstal, Password Protec-
tion System dapat diakses dari start menu.

Sebagai contoh kita akan memproteksi Regedit. Di Password
Protection System, klik tombol [File]. Kemudian, cari
file Regedit.exe yang berada di folder Windows dan
klik [Open]. Setelah itu isikan password pada kotak
yang tersedia. Isikan juga konfirmasi password, lalu
klik [Add Pass].

Setelah dilindungi, jika ada orang ingin
membuka Regedit untuk mengubah registry, maka
akan muncul jendela yang akan meminta password.
Dengan demikian, Regedit hanya dapat dibuka oleh
yang mengetahui password. Hal yang sama dapat
Anda terapkan pada file yang berekstensi EXE
lainnya.

Fadlan Setiaji
aji-edl@plasa.com

BERBEDA DENGAN MICROSOFT OUTLOOK
versi sebelumnya, Microsoft Outlook 2002 alias Outlook XP, dan
Office 2003, menggunakan software untuk mengatur kontak dan e-
mail. Sayangnya, Outlook 2002 ini
tidak menyediakan opsi untuk
menyimpan semua data-data personal,
setting, template, dan account e-mail.

Nah, bila Anda mengalami
masalah dengan semua itu, maka
sebaiknya Anda mencoba
menggunakan OutSource-XP yang
dapat didapat di www.totalidea.com
dengan lisensi demo.

Kenapa Anda membutuhkan
software ini? Bayangkan, apabila
Windows atau hardware Anda
bermasalah sehingga menyebabkan
data-data e-mail hilang. OutSource-XP
menyediakan pembuatan backup,
sehingga data-data e-mail yang hilang
itu, bisa diperoleh kembali.

Penggunaan software ini relatif mudah, Anda hanya masuk ke
tab [Backup] kemudian menentukan apa-apa saja yang ingin di-
backup, kemudian klik [Create Backup Now!].

Sayangnya, pada versi demo ini,
tidak tersedia fitur backup compres-
sion, office 2002 activation, dan quick
backup.

Selain berfungsi sebagai tool
untuk backup-restore, software ini
juga dapat membatasi tipe-tipe file
tertentu yang mungkin akan
berbahaya jika ditampilkan, apalagi
dijalankan. File-file berbahaya yang
biasa disertakan sebagai attachment
ini, dapat berekstensi BAT, CHM,
COM, dan masih banyak lagi. Soft-
ware ini, setelah dipasang hanya
berukuran 1MB.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

BOSAN DENGAN TASKBAR Windows XP yang
standarnya? Kalau saya, iya. Makanya, saya cari software yang bisa
memodifikasi tampilan Windows XP termasuk tampilan taskbar-nya.
Jika Anda juga bosan, maka MobyDock adalah pilihan yang sempuna.
Instal MobyDock untuk mendapatkan taskbar Windows 2000 atau
Windows XP sehingga mirip dengan taskbar MacOS X, termasuk
animasinya.

Mobydock dapat di download di http://pwp.netcabo.pt/
mobydock/filesB/Mobydock%20DX%200.87b%20Setup.exe.
Ukuran file instalasinya 3MB. Untuk menggunakan Mobydock,
DirectX 9 adalah syarat wajib.

Mobydock dapat diatur agar menjadi transparan agar tidak
mengganggu wallpaper di desktop. Letak Mobydock dapat diatur
agar berada di salah satu posisi dari empat posisi, yaitu atas, bawah,
kiri, dan kanan.

Tampilan MobyDock dapat diganti warnanya. Warna-warna
yang disedikan adalah XP silver, XP Silver Shadow, XP blue, XP
Blue shadow, XP Olive, Xp Olive Shadow. Untuk informasi lebih
lengkap, kunjungi www.mobydock.com.

Satu lagi yang penting mobydock adalah freeware.

Anton Hermawan
gigabit_x@yahoo.com.sg
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Lompatan Teknologi
di Dunia Komponen

Alois Wisnuhardana
wisnu@e-pcplus.com

Teknologi komputer
tiada habis untuk
diuber-uber. Baru

sebentar muncul yang
satu, telah muncul

lagi yang lain. Praktis,
tanpa kecintaan dan
dorongan keinginta-

huan yang lebih,
mengikutinya per-

kembangannya justru
bisa bikin kita

kelenger!!!

alam hal
teknologi kartu
suara onboard
misalnya. Rasanya

baru saja muncul solusi kartu
suara onboard AC’97, dan
konco-konconya, sebentar lagi
akan muncul teknologi yang
menggantikannya. Namanya
Azalia. Kalau solusi AC’97 cuma
mampu menawarkan sistem
tatasuara 2.1 (dua buah speaker
satelit dan satu subwoofer),
Azalia menawarkan
kemampuan tatasuara 5.1.
Lebih fantastis. Lebih realistis.

Dari solusi kartu suara
onboard pada motherboard
saja, kita bisa melihat betapa
perubahan itu sendiri telah
menghasilkan matinya puluhan
perusahaan pembuat kartu
suara di satu sisi, sementara di
sisi seberangnya kita bisa
menjumpai makin mudah dan
murahnya tawaran komputer
multimedia.

Begitu pula halnya dengan
teknologi memori utama atau
RAM. Setelah era SDRAM, DDR-
SDRAM, dan kemudian muncul

Rambus RAM, kita sudah
disuguhi dengan pendekatan
baru yang disebut DDR-SDRAM
dual kanal.

Dan ketika belum semua
orang menikmati rasanya
teknologi memori DDR dual
kanal, sebentar lagi orang sudah
berbicara mengenai DDR 2. Rasa-
rasanya, teknologi melesat
seperti angin, sedangkan
kemampuan kita (baik pikiran,
waktu, biaya) untuk mengikuti
perkembangannya bergerak
laksana siput yang merangkak.

Belum lagi ten-tang prosesor
dan perdebatan ten-tang 64-bit.
Setelah AMD memunculkan

prosesor berbasis 64-bit, orang
lantas menunggu apa yang akan
dilakukan oleh Intel, sang jawara
di bisnis mikroprosesor. Ternyata,

hingga tahun
depan mereka
masih berfokus
pada sistem
prosesor 32-bit
dengan terus
mendo-rong
pergerakan
teknologi proses
dan kerapatan
transistor. Intel

belum tergoda untuk memasuki
arena 64-bit dan justru mengge-
ber lebih lanjut prosesor Hyper
Threading mereka dengan apa
yang disebut Extreme Edition.

Apa yang menonjol dari
prosesor Extreme Edition ini?
Seberapa besar peningkatannya
dan seberapa jauh lompatan
teknologinya? Kita masih belum
bisa mengujinya, karena dalam
roadmap Intel, prosesor tersebut
baru akan diluncurkan tahun
depan.

Intel buru-buru
mengumumkan Extreme Edition
ini, tampaknya untuk menggeser
fokus perhatian para pelaku TI

terhadap sistem prosesor 64-bit
yang ditawarkan AMD. Lagipula,
Intel beralasan bahwa belum
banyak aplikasi yang mendukung
sistem komputasi 64-bit, sehingga
beralih ke 64-bit bisa jadi justru
menjadi semacam langkah bunuh
diri karena riset yang mahal dan
lama tidak didukung dengan
kesiapan dari sisi pengguna.

Itu baru
tiga hal: kartu
suara, memori
utama, serta
prosesor. Belum
lagi ketika kita
berbicara
tentang
interkoneksi
input/output
pada komponen
PC.

SISTEM
INTERKONEKSI
INPUT/OUT-
PUT

Selama kurang lebih satu
dekade belakangan ini, teknologi
I/O pada komputer telah
menggunakan platform yang
bertipe paralel, seperti terlihat
pada interkoneksi I/O berbasis PCI

D

(Peripheral Component Inter-
connect) ataupun AGP (Acceler-
ated Graphics Port) untuk kartu
grafis.

Boleh dibilang, dari sekian
banyak teknologi pada
komputer, sistem interkoneksi I/
O ini terbilang yang paling awet
dibandingkan dengan
perkembangan teknologi

prosesor, memori, kartu grafis,
storage, dan sebagainya. Ba-
yangkan, teknologi PCI berumur
lebih dari sepuluh tahun sejak
menggantikan slot ISA dan atau
slot I/O propietary. PC+

Modul memori DDR 2. Menawarkan kecepatan dan
reliabilitas.

Evolusi perkembangan graphics bus dalam sistem
PC.

Ada suatu gelombang
baru dalam perkara

arsitektur pemindahan
data. Gelombang baru

tersebut akan terjadi di
dalam berbagai

peranti komputer
modern, mulai skala

individu hingga enter-
prise, misalnya saja

pada peranti komputer
server, media simpan/

storage, kartu-kartu
jaringan, dan kom-
ponen-komponen

periferal yang lain.
Sebut saja gelombang

itu sebagai “Era Se-
rial”.

eknologi
pemindahan
data input/output
(sering disingkat I/O)

dari sistem host dan PCI bus ke
kontroler storage, prosesor, dan
kartu jaringan, yang selama ini
berbasis paralel, sudah mulai
digantikan oleh interkoneksi yang
bersifat serial. Salah satu nama
yang bisa dipastikan bakal ramai
dipergunjingkan adalah apa yang
disebut PCI Express.

Standar I/O PCI Express yang
berbasis serial boleh dikatakan
merupakan salah satu langkah
lanjutan dalam rangkaian proses
transisi dari paralel ke serial,

PCI Express:
Tonggak Pergeseran

Interkoneksi
dari Paralel ke Serial
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setelah sebelumnya interkoneksi
lainnya seperti Serial ATA sudah
lebih dahulu diperkenalkan.

Dengan dukungan lebih dari
1000 anggota PCI
Special Interest
Group ( PCI-SIG),
PCI Express
dipastikan akan
menggantikan
teknologi arsitektur
bus PCI yang
sekarang ini.
Beragam platform
PCI Express, slot,
dan peranti-peranti
yang menggunakan
arsitektur baru ini
sudah akan muncul
pada awal tahun
2004 mendatang. Dari seluruh
indi-kasi yang berhasil dideteksi,
standar baru ini tam-paknya akan

meraih sukses dalam
menggantikan arsitektur paralel
yang telah bertahun-tahun mela-
yani sistem interkoneksi antar-

peranti dalam komputer modern.
Seiring dengan

ketersediaan produk-produk

PCI Express di pasaran, PCI
Express juga akan mulai
berkonjungsi dengan teknologi
prosesor, kontroler-kontroler,

dan komponen-
komponen yang
lain. Produk-
produk tersebut
akan membawa
perubahan perfor-
ma sistem kompu-
ter yang sangat
signifikan serta
menawarkan fitur-
fitur baru yang
lebih menarik pada
berbagai peranti
pendukung seperti
RAID, Direct
Attached Storage

(DAS), Storage Area Networks
(SAN), dan juga Network Attached
Storage (NAS).

Meski sudah pernah kita
dengar dan dengungnya mulai
menggema akhir tahun ini,
pertanyaan sesungguhnya bagi
kita sebagai konsumen teknologi
adalah, ka-pan kita bisa
menikmati produk-produk
semacam itu dan mengimple-
mentasikannya dalam sistem
komputasi yang kitapunyai?

Tak lama lagi. Tunggu
kuartal kedua tahun 2004!

PERGESERAN
REVOLUSIONER

Mikroprosesor, storage,
peranti komunikasi, I/O signal
processing, dan berbagai peranti
pemrosesan data yang lain
bertambah cepat secara kontinyu
dari waktu ke waktu, dan hanya
dalam hitungan tahun,
ukurannya sudah dinyatakan
dalam satuan giga.

Jalur data (bus) PCI (Periph-
eral Component Interconnect)
yang diperkenalkan pertama kali
pada tahun 1990-an belakangan
telah menjadi salah satu sumber
masalah dalam lalu lintas data
yang berukuran gigabyte
ataupun gigabit.

Terjadinya penyumbatan
pada jalur interkoneksi PCI tidak
dapat dihindari karena standar
ini memang memiliki
keterbatasan dalam hal band-
width dan skalabilitas,
dibandingkan pertumbuhan
peranti lain seperti
mikroprosesor, storage, alat-alat
komunikasi, dan sebagainya yang

T

Tabel perkembangan interkoneksi kartu grafis pada PC
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telah disebutkan di muka.
Untuk menambahkan

kapasitas bandwidth yang masih
mungkin, sebuah standar PCI
yang sekarang kita kenal ini
harus mengatasi rintangan dalam
hal bus latency dan dengan
demikian juga jumlah pin yang
lebih banyak. Penambahan
jumlah pin (hanya untuk
mengejar bandwidth yang
memang sudah terbatas) akan
mengakibatkan perubahan yang
signifikan pada ukuran, kemasan,
konektor, dan biaya-biaya
lainnya. Ini berarti, baik secara
langsung maupun tak langsung,
mengubah desain PCI akan
menyebabkan biaya yang makin
membesar, baik dari sisi
pengembangan maupun dari sisi
bahan yang digunakan. Padahal,
hukum ini bertentangan dengan
prinsip dalam dunia komputer
dan teknologi informasi secara
umum, yang menabukan
peningkatan cost untuk setiap
peningkatan teknis dalam hal
apapun.

SOLUSI DAN TRANSISI
Yang menjadi perkara,

penggantian atau perubahan
platform dari PCI ke PCI Express
tidak dengan serta merta bisa
dilakukan semalam layaknya
kisah Pangeran Bandung
Bondowoso membangun Candi
Rara Jonggrang di Prambanan
sana. Bagaimanapun, tingkat
penyebaran dan penerimaan

konsumen terhadap standar PCI
di berbagai peralatan komputasi
tidak akan bisa digusur dalam
sekali sapuan.

Penetrasi pasar dari
produk-produk berbasis PCI
yang telah berpuluh-puluh
tahun diterima
secara luas oleh
para pelaku di
industri ini
merupakan faktor
yang tidak bisa
dielakkan.

Faktor ini
pulalah yang
menjadi
pertimbangan,
bahwa apabila
terdapat
teknologi baru
yang akan
menggantikan
teknologi PCI, ia
harus memiliki
dukungan
terhadap
teknologi PCI
yang lama, dalam
artian supaya
perubahan
tersebut tidak
membuat guncangan baik dari
sisi teknis maupun ekonomi.

Secara historis, perubahan
atau transisi semacam ini pernah
terjadi pada awal tahun 1990-an
di mana standar ISA yang lama
tetap ada untuk beberapa saat
sebelum semuanya tergantikan
sama sekali oleh PCI. Oleh

karenanya, berdasarkan
pengalaman tersebut, perubahan
ini diperhitungkan tidak akan
terlalu menimbulkan masalah.

PCI Express sendiri, meski
disebut-sebut banyak kalangan
dan praktisi IT merupakan

revolusi teknologi yang baru,
sebenarnya sedikit banyak
masih bisa dikelompokkan
dalam teknologi keluarga PCI
itu sendiri. PCI Express tetap
menjaga kompatibilitas soft-
ware-software sebelumnya
dengan sistem operasi, driver,
dan juga tetap memakai utiliti-

utiliti lain yang ditulis
berdasarkan standar teknologi/
platform PCI.

Lebih jauh lagi, platform
sistem baru nantinya akan
menyediakan slot ekspansi dan
dukungan peranti dalam dua

jenis yakni PCI
dan PCI Express,
hingga akhirnya
PCI benar-benar
telah lenyap dan
“dilupakan”
orang. Pada
akhirnya,
jembatan yang
memindahkan
semua jalur
koneksi PCI
paralel ke PCI
serial akan
terbentuk, di
mana standar
baru akan
mengadaptasi PCI
lama dan juga
akan tersedia
host bus adapter
ataupun add-in
cards yang bisa
mengonversi
peranti PCI ke

dalam slot PCI Express.

PCI EXPRESS PADA DESK-
TOP DAN SERVER

Sepuluh tahun lalu.
Arsitektur bus PCI Paralel untuk
komponen periferal I/O dan
storage merupakan teknologi
yang sangat bertenaga. Secara

esensial, PCI Paralel
menggantikan bus-bus propri-
etary yang dikembangkan oleh
para vendor komputer dunia
pada waktu itu dalam suatu
standar industri. Salah satu dari
standar bawaan tersebut memi-
liki kelemahan pada kecepatan
transfer yang lebih lambat dan
universalitas dukungan.

Dengan adanya PCI, standar
propietary luluh digantikan
oleh model plug and play, yang
kini telah berkembang dengan
sangat dramatis, tidak hanya
pada PC tradisional dan plat-
form aplikasi komputer pada
umumnya. Sistem I/O paralel
dan bus-bus lokal (local buses)
seperti PCI sesunggunya sangat
efisien dan tepat untuk
berbagai peranti dengan
throughput lebih rendah pada
setiap pin yang dibutuhkan.

Yang menjadi masalah,
dalam perkembangannya
ternyata PCI tidak mampu
untuk mengejar atau mengikuti
setiap pertumbuhan bandwidth,
harga, dan reliabilitas data yang
dibutuhkan dalam spektrum
aplikasi hardware yang sangat
luas saat ini.

Kalau kita mengingat
komputer di tahun 1980-an,
sistem interface-nya
menggunakan beberapa tipe
seperti ISA, lalu berkembang
menjadi MSA, EISA, dan VESA.
Lalu, pada dekade 1990-an, PCI
32-bit sebesar 33/66MHz

Skenario perpindahan data pada PC masa kini dan beberapa tahun
ke depan.
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menggantikan standar platform
lama. Setelah berumur lebih dari
sepuluh tahun, tampaknya PCI
Express yang memiliki througput
sebesar 133MHz pun akan meng-
gantikan kedudukan PCI lama.

Telah lama disadari bahwa
penggunaan bus-bus lokal dalam
I/O paralel dengan model sharing
seperti halnya dalam PCI telah
mengakibatkan penyumbatan
yang paling serius dibandingkan
komponen lainnya. Perpindahan
data antara periferal lain
berkecepatan tinggi seperti
storage, network communication,
dan peranti grafis tampaknya
akan bergeser pada jenis serial
sebagai pengganti dari arsitektur
PCI dan di masa mendatang akan

menjadi arsitektur standar yang
diterima secara luas di kalangan
industri komputer/teknologi
informasi.

Pergeseran dari interface
paralel menjadi serial ini tidak
hanya unik tetapi juga sejalan
dengan perubahan di peranti-

peranti yang lain. Paralel
SCSI dan ATA atau IDE
untuk protokol media
simpan kini juga sudah
mengalami keterbatasan
dalam hal performansi
dan skalabilitas. Dapat
diperkirakan, arsitektur
serial yang lebih baru
dalam bentuk seperti
Serial Attached SCSI
(SAS), dan Serial ATA (SATA) yang
diintrodusir untuk menggantikan
SCSI dan ATA akan segera
menjadi hal jamak di lingkungan
industri komputer.

Mengapa interface paralel
merupakan teknologi yang sudah
mentok dan perlu digantikan
oleh teknologi serial? Pertama

karena bus paralel ini
memerlukan lebih banyak pin.
Bus-bus ini memerlukan
komponen, board, dan daya lebih

Evolusi tentang
interkoneksi di dunia

kartu grafis/VGA Card
pada sistem PC telah

menjadi suatu
fenomena yang luar

biasa menarik, seiring
dengan

meningkatnya
kebutuhan bandwidth

dalam interkoneksi
tersebut dari waktu

ke waktu.

ada tahun
1990-an,
perkembangan di
dalam teknologi kartu

grafis boleh dikatakan hanya
meningkat dua kali lipat dalam
kurun waktu sekitar dua tahun.
Waktu tersebut terasa sangat
longgar bagi para developer
untuk membuat setiap produk
yang mereka rancang benar-
benar mampu menembus pasar
secara mendalam dan mencapai
titik impas secara ekonomis
dalam waktu yang tersedia.

Lalu, diperkenalkanlah
sebuah sistem interkoneksi baru
yang dinamakan Accelerated
Graphics Port atau AGP, yang
salah satu tujuannya adalah
mendorong pertumbuhan
aplikasi grafik tiga dimensi atau
3D. Tujuan yang lainnya adalah
mengatasi kebutuhan akan
bandwidth yang semakin
meningkat dan pemrosesan
grafik yang makin cepat. AGP
pun berevolusi mulai dari AGP
1x, 2x, 4x, hingga yang terakhir
adalah 8x.

Yang menjadi masalah
sekarang ini, aplikasi-aplikasi
baru menjadi sangat rakus

PCI Express dan
Tampilan Grafis

Alois Wisnuhardana
wisnu@e-pcplus.com

P

terhadap bandwidth,
karena berbagai
kebutuhan seperti
audio-video processing,
digital home entertain-
ment, dan semacamnya,
menekankan pada
kecepatan pemrosesan
data yang melibatkan
kartu grafis secara
intensif dan masif.

Oleh karenanya,
melanjutkan teknologi
interkoneksi berbasis
AGP (misalnya saja
mengembangkan AGP
16x atau 32x) justru
akan menimbulkan
masalah di masa depan.
Interkoneksi paralel
point to point akan
menimbulkan dampak
yang serius pada
beberapa hal. Pertama, Konektor
yang sudah ada harus didesain
ulang untuk memberikan
induktansi dan
kapasitansi yang
lebih rendah
pada signaling
rates yang lebih
tinggi.
Seandainya
dipaksa untuk
menempuh cara
itu, tetap saja ia tidak akan
memberikan dampak atau
perubahan yang signifikan
terhadap bandwidth.

PCI Express sebagai sebuah
interkoneksi point to point yang

bersifat serial merupakan solusi
yang dipandang jitu, karena
memberikan fleksibilitas dan

skalabilitas dibandingkan dengan
AGP. Interkoneksi ini
menawarkan bandwidth sebesar
4GB/detik untuk setiap jalurnya
dan 8GB/detik pada bandwidth
totalnya.

Sebagai gambaran, PCI
Express sendiri memiliki beberapa
model atau tipe sebagaimana

yang dikenal pada AGP, yakni PCI
Express 1x, 2x, 4x, 8x, dan 16x.
Berikut ini lebar lintasan dari PCI
Express untuk setiap tipe jalur:

Dengan skenario bandwidth
seperti itu, game-game di masa

         ----------‡>>>>>---------------‡>>>>>>Arah perubahan----‡>>>>>>>----------------

Desktop Interfacing Port printer paralel USB 2.0 USB
(LPT)

Grafik PCI AGP 2x, 4x, 8x PCI Express
Network 10/100 Ethernet 1 Gig Ethernet 10 Gig Ethernet
Clustering/Data Centers Proprietary IBA 4x 10 Gig
Local I/O PCI PCI-X PCI-Express

I/O Interconnect Mode Operasi dan Jumlah Pin Megabyte per pin

PCI 32-bit 33 MHz dengan jumlah pin 49 2.7
PCI-X 133 MHz dengan jumlah pin 89 11.9
AGP 4x 66 MHz x4 dengan jumlah pin 108 9.8
Hyper Transport 8b encoding, 800 MHz @ 3.2 GB/sec 80

dgn jumlah pin 40
PCI Express 8b encoding, x8 full duplex @ 4 GB/sec 100

dgn jumlah pin 40

mendatang akan hadir dalam
tampilan yang benar-benar
fotorealistik.

Tekstur, karakter, suasana,
dan semua citra dalam game
akan tampil dalam bentuk
photorealism tadi. Dengan
lingkungan semacam itu, para
developer aplikasi dan games
dapat berkreasi secara lebih
maksimal guna membawa para
pengguna dan penikmat
komputer ke dalam level yang
sama sekali baru.

Para developer tidak lagi
menjumpai rintangan band-
width yang berakibat pada hasil
resolusi yang rendah dan teks-
tur yang minim. Jelas ini adalah
suatu gairah baru melampaui
permainan-permainan multipla-
yer yang sekarang ini kita kenal.

Sementara itu, konsep
tentang Digital Home yang
mendorong penggunaan PC
secara lebih luas dan lebih
bervariasi juga diuntungkan
dengan kehadiran PCI Express
ini. Kehadirannya akan
meningkatkan ketersebaran
beragam format audio, foto,
serta video yang serba digital.

Pemrosesan video capturing
dan video editing melalui PCI
Express juga akan menghasilkan
media yang praktis sempurna,
lantaran tidak ada lagi kegaga-
lan proses perpindahan akibat
adanya frame yang drop. PCI Ex-
press akan membuat proses per-
pindahan data dilakukan secara
simultan menggunakan dua
jalur bolak-balik yang tersedia.

Interface grafis atau
Graphical User Interfaces (GUI)
di masa mendatang juga akan
mendorong permintaan
bandwidth yang lebih lebar
untuk menghasilkan tampilan
desktop yang lebih kaya dengan
kemampuan real time. PC+

Dengan penggunaan PCI Express pada kartu grafis, permainan game di masa
mendatang akan mendekati photorealism, menawan dari sisi tampilan

A
RE

/P
C
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us

Tipe PCI-Exp. Bandwidth Uni-directional Bandwidth full duplex (bolak-balik)

PCI Express 1x 250MB/detik 500MB/detik
PCI Express 2x 500 MB/detik 1GB/detik
PCI Express 4x 1GB/detik 2GB/detik
PCI Express 8x 2GB/detik 4GB/detik
PCI Express 16x 4GB/detik 8GB/detik

besar. Dengan mengubahnya
menjadi serial, voltase yang
digunakan serta jumlah pin yang
diperlukan juga menjadi lebih
rendah, sementara pada saat
yang sama bandwidth yang di-
hasilkan bisa didongkrak. Berikut
ini kecenderungan pergerakan/
perubahan ke arah I/O Serial

yang lebih cepat.
Sebagai

catatan, PCI-X
diperkenalkan
pertama kali pada
akhir tahun 1990-
an. PCI-X versi 1.0
bekerja pada clock
speed 133 MHz
dengan beberapa
penyempurnaan,
sehingga secara

teoretis mampu mentransfer data
sebesar 1066 MB/s atau 1GB/s,
dua kali lebih besar
dibandingkan dengan standar PCI

64-bit yang bekerja pada clock
speed 66MHz.

Dengan demikian, PCI
Express dapat dikatakan
merupakan sebuah teknologi
interkoneksi baru di dalam PC,
yang menjawab keterbatasan
dalam hal performansi, cost,
feature, dan rancang bangun
pada standar PCI. Dari sisi desain,
ia merupakan interkoneksi I/O
serial berkecepatan tinggi yang
terintegrasi dalam sebuah paket.
PCI Express juga merupakan
standar industri yang diterima
secara luas, di mana PCI Express
versi 1.0a telah dipublikasikan
secara luas oleh PCI SIG sebagai-
mana telah disebut dimuka.

Untuk mengukur tingkat
efisiensi PCI Express dibandingkan
dengan standar interkoneksi yang
lain pada setiap pin yang disedia-
kan, berikut ini tabel efisiensi
sistem interkoneksi I/O. PC+
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Setting Modem dan
Dial Up di Linux ( Bagian - 1)
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Bisakah Linux
digunakan untuk

main Internet?
Begitulah kira-kira

pertanyaan para
pemula yang

sebenarnya sangat
ingin belajar

menggunakan Linux
tapi ragu-ragu apakah

hobinya untuk
“berselancar”, kirim

e-mail, chatting, dan
lain-lain akan

terakomodasi bila
menggunakan Linux.

awabannya
adalah sudah jelas
pasti bisa! Bahkan
sebenarnya Linux

memang diciptakan untuk
mendukung penggunaan TCP/IP
yang merupakan protokol
utama dalam berinternet-ria.

Lalu jika komputer saya
yang di rumah nanti akan
diinstal Linux, bagaimana
caranya untuk melakukan
koneksi ke Internet? Secara
prinsip jawabannya adalah
sama saja dengan
menggunakan sistem operasi
Windows. Yang paling mudah
dan murah koneksi Internet
dilakukan dengan
menggunakan dial up.

Untuk dapat melakukan
setting dial up, yang pertama
sudah tentu Anda harus
memiliki line telepon di rumah
Anda. Kalau kebetulan di lokasi
rumah Anda belum ada
jaringan telepon atau sudah
ada tapi penuh, ya terimalah
nasib Anda karena Anda tidak
dapat mengakses Internet.
Sebagai alternatif mungkin
dapat menggunakan teknologi
wireless, tapi jelas jauh lebih
mahal.

Yang kedua, Anda harus
memiliki modem. Namun sudah
jamak diketahui bahwa masalah
kompatibilitas hardware
merupakan kelemahan Linux.
Hal ini juga bisa menjadi salah
satu faktor yang membuat para
pemula ragu-ragu untuk
melakukan migrasi ke Linux.
Namun jangan pesimis dulu.
Jika Anda menggunakan
modem eksternal, maka setting
penggunaannya di Linux justru
lebih mudah daripada di
Windows.

Apa sebab? Linux mampu
untuk mengenal hampir semua
modem eksternal tanpa perlu
menginstal driver-nya! Anda
hanya perlu tahu di port serial
mana modem tersebut
tertancap di komputer Anda.

Jika Anda menggunakan
modem internal, Anda memang
memerlukan driver seperti
halnya jika menggunakan
sistem operasi Windows. Jika
mengacu pada disket atau CD
bawaan dari modem internal
tersebut, Anda pasti akan
kecewa karena hampir tidak
mungkin menemukan driver for
Linux di sana.

Namun, sekali lagi jangan

pesimis dulu. Ada suatu
organisasi yang membuat,
mengumpulkan, dan menyajikan
informasi mengenai berbagai
driver untuk modem internal di
Linux. Anda dapat
menemukannya di
www.linmodems.org.

Terakhir adalah perangkat-
perangkat lunak untuk
mengakses Internet. Perangkat
lunak minimal yang diperlukan
untuk mengakses Internet adalah
browser. Hampir semua distro
Linux menyertakan browser di
dalam paket instalasinya. Hanya
saja jangan berharap
menemukan Internet Explorer di
sana. Browser yang umumnya
tersedia dalam distro Linux
adalah Netscape atau Mozilla.
Sayangnya “persaingan tidak
sehat” antara Internet Explorer
dengan Netscape/Mozilla
membuat keduanya saling tidak
kompatibel dalam urusan
tertentu, misalnya skrip yang
didukung dan ekstensi HTML
yang dikenal.

Dan apesnya, jauh lebih
banyak situs yang
perancangannya ditujukan untuk
dapat diakses dengan baik jika
menggunakan Internet Explorer.
(PCplus yakin Anda pasti sering
menjumpai situs yang bertuliskan
“This site is best viewed with
Internet Explorer ... bla ... bla ...
bla ...”). Akibatnya situs-situs
tersebut tidak dapat diakses
dengan baik jika menggunakan
Netscape/Mozilla.

Tapi apa yang bisa kita
lakukan? Kita tidak bisa memaksa
para Web designer agar
menyesuaikan karyanya dengan
Netscape/Mozilla, bukan?
Mungkin salah satu jalan yang
dapat ditempuh adalah membuat
sendiri browser yang kompatibel
dengan Internet Explorer yang
jalan di Linux.

But the show must go on.
Kalau memang harus
menggunakan Linux dalam
mengakses Internet, just do it.
Berikut ini adalah daftar
perangkat lunak under-Linux
yang dapat digunakan dalam
berinternet ria beserta
padanannya pada sistem operasi
Windows. Bagian yang diberi
tanda [prop] bersifat proprietary,
bukan freeware.

KELOMPOK WINDOWS LINUX

Web browser 1. Internet Explorer 1. Netscape / Mozilla
2. Netscape / Mozilla 2. Galeon
3. Opera [Prop] 3. Konqueror
4. Firebird 4. Opera [Prop]
5. Firebird
6. Nautilus
7. Epiphany
8. Links (dengan parameter -g)
9. Dillo

                                                           10. Encompass
Console Web browser 1. Links 1. Links

2. Lynx 2. Elinks
3. Xemacs + w3. 3. Lynx

4. w3m
5. Xemacs + w3

E-mail client 1. Outlook Express 1. Evolution
2. Microsoft Outlook [prop] 2. Netscape/Mozilla messenger
3. Netscape / Mozilla 3. Sylpheed / Sylpheed-claws
4. The Bat 4. Kmail
5. Eudora 5. Gnus
6. Becky 6. Balsa
7. Datula 7. Bynari Insight GroupWare Suite [Prop]
8. Sylpheed / Sylpheed-claws 8. Arrow
9. Opera 9. Gnumail

                                                           10. Althea
                                                           11. Liamail
                                                           12. Aethera
                                                           13. MailWarrior
                                                           14. Opera
E-mail client bergaya Outlook Outlook 1. Evolution

2. Bynari Insight GroupWare Suite [Prop]
3. Aethera
4. Sylpheed
5. Sylpheed-claws

E-mail client bergaya The Bat! The Bat! 1. Sylpheed
2. Sylpheed-claws
3. Kmail
4. Gnus
5. Balsa

Console e-mail client 1. Mutt 1. Pine
2. Pine 2. Mutt
3. Pegasus 3. Gnus
4. Emacs 4. Elm
5. Emacs

News Reader 1. Agent [Prop] 1. Knode
2. Free Agent 2. Pan
3. Xnews 3. NewsReader
4. Outlook 4. Netscape / Mozilla
5. Netscape / Mozilla 5. Opera [Prop]
6. Opera [Prop] 6. Sylpheed / Sylpheed-claws
7. Sylpheed / Sylpheed-claws Console:
8. Dialog 7. Pine
9. Gravity 8. Mutt

9. Gnus
                                                         10. tin
                                                         11. slrn
                                                         12. Xemacs

Address book Outlook Rubrica
Download Manager 1. Flashget 1. Downloader for X

2. Go!zilla 2. Caitoo (former Kget)
3. Reget 3. Prozilla
4. Getright 4. Wget (console, standard)
5. DAP 5. GUI for Wget: Kmago,
6. Wget Gnome Transfer Manager, QTget, Xget
7. WackGet 6. Aria
8. Mass Downloader 7. Axel

8. Download Accelerator Plus
9. GetLeft

                                                         10. Lftp
FTP Client 1. Bullet Proof FTP 1) Gftp

2. CuteFTP 2) Konqueror
3. WSFTP 3) Kbear
4. SmartFTP 4) IglooFTP [Prop]

5) Nftp
6) Wxftp
7) AxyFTP
8) mc (cd ftp://...)
9) tkFTP

                                                         10) Yafc
Console FTP-clients 1. FTP in Far 1. Ncftp

2. ftp.exe 2. Lftp
3. Ncftp 3. Avfs

IRC Client 1. Mirc 1. Xchat
2. Klient 2. Kvirc
3. VIRC 3. Irssi
4. Xircon 4. BitchX
5. Pirch 5. Ksirc
6. XChat 6. Epic
7. Sirc
8. PJIRC

Nah, setelah tahu begitu banyak pilihan perangkat-perangkat under-Linux yang dapat digunakan
untuk "bermain" Internet, tentu Anda akan "ngiler" untuk mencobanya. Minggu depan PCplus akan
memberikan penuntun bagaimana cara setting dial up di Linux. Distro yang PCplus gunakan adalah
RedHat 9.0. Linux. PC+

ISTIMEWA
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Vincent Bayu Tapa Brata
vincent@e-pcplus.com “Welcome To The Babel”:

Menerapkan Efek
Malam dan KabutN

Nuansa suram dan
dingin sering dihindari

dalam karya visual.

amun demi-
kian, sebenarnya
nuansa ini memiliki daya
tarik tersendiri karena

belum banyak dibahas dan
mengundang pemecahan. Kali ini
kita mencoba melakukannya!

1. Buka foto bahan dasar Pencakar Langit. Pastikan mode warnanya CMYK atau RGB,
serta 8-bit. Check dengan klik menu [Image]>[Mode]. Jika belum sesuai, ubah dahulu.

2. Buka palet Layer. Jika belum tampak, klik menu [Windows]>[Show Layers]. Klik
ganda pada bar layer Background untuk menjadikannya layer normal (supaya bisa
dimodifikasi). Ubah namanya pada kotak dialog Layer Properties dengan Dasar.
Pengubahan Layer Properties juga dapat dilakukan dengan klik ikon [Arrow] pada
palet layer sebelah kanan atas dan memilih Layer Properties.

3. Klik lagi ikon [Arrow], pilih New Layer. Tempatkan di urutan sebelah atas layer Dasar.
Klik [Paint Bucket Tool] di [Toolbox]. Pilih warna biru tua/gelap pada palet Fore-
ground Color di Toolbox. Klik di kanvas kerja. Beri nama layer ini dengan Nuansa
Malam.

4. Ubah Transfer Mode layer Nuansa Malam dari normal menjadi Multiply. Transfer
Mode ini mengatur metode bagaimana sebuah layer melebur dengan layer di
bawahnya.

5. Buka foto bahan dasar Wulan. Atur komposisi warnanya sehingga menjadi bernuansa
kekuningan. Klik menu [Image]>[Adjust]>[Color Balance]. Geser slider unsur-unsur
warna. Lakukan hal ini baik di bagian Highlight, Midtone, maupun Shadow.

6. Klik menu [Select]>[All]. Klik menu [Edit]>[Copy].

7. Aktifkan kanvas kerja. Klik menu [Edit]>[Paste]. Ubah nama layer di palet Layer
dengan nama Rembulan. Tempatkan di urutan bawah layer Dasar.

8. Jika kita ingin mengatur letak Rembulan dengan mudah tanpa terhalang layer
Dasar, turunkan dahulu opacity dari layer Dasar. Klik [Move Tool] di Toolbox,
aktifkan layer Rembulan, lalu drag ke posisi yang diinginkan. Jika ingin mengubah
ukuran gambar Rembulan, klik menu [Edit]>[Transform]>[Scale]. Tekan terus tombol
[Shift] di keyboard sambil men-drag handle point di sudut gambar agar proporsi

9. Sembunyikan layer Nuansa Malam agar tidak mengganggu. Lakukan dengan
mematikan ikon mata (layer visibility). Aktifkan layer Dasar, klik ikon [Add Mask] di
bawah palet layer. Klik  [Paint Brush Tool] di Toolbox, pilih nada gelap pada palet
Foreground Color, atur Tool opacity dengan nilai rendah untuk mengatur
kekuatan sapuan kuas (brush). Diameter brush diatur dengan menekan tombol [ atau
] di keyboard. Sapukan ke kanvas kerja untuk menampilkan rembulan. Jika ingin
menyembunyikan bagian rembulan, balik nada di palet Foreground Color menjadi
nada terang.

10. Aktifkan layer Nuansa Malam. Lakukan hal yang sama pada langkah 9.

11. Klik [Arrow] palet layer dan pilih New Layer. Beri warna abu-abu. Tempatkan di
urutan layer paling atas.

12.Klik menu [Filters]>[Texturize]>[Grain]. Atur nilai resolusi tekstur. Klik [OK]. Beri
nama layer Nuansa Kabut.

panjang dan lebarnya tetap. Jika ingin memutar subjek, klik menu
[Edit]>[Transform]>[Rotate].

Klik
ganda
jadikan
layer
normal

Transfer
mode

Paint
bucket
Tool

Highlight,
Midtone
dan
Shadow

Opacity
Layer

Opacity layer
handle point

Tool brush
opacity

Paint
brush
Tool

Nada
gelapLayer

hidden

Mask
aktif

Ikon add
layer mask

Layer
aktif

Layer
visible



plusTutorial V • 06 - 12 Januari 2004
PCplus 157

| 21

14. Beri Mask pada layer Nuansa kabut. Sapu dan sembunyikan bagian-bagian
tertentu, misalnya: rembulan, puncak gedung (seperti langkah 9).

15.Tambahkan unsur gambar penguat tema, misalnya burung purba. Terapkan filter
Gaussian blur dengan nilai rendah agar tepian bayangan burung tidak terlalu
tajam. Tempatkan di bawah layer Nuansa Kabut.

16. Save pekerjaan kita dengan format .PSD.
Selamat mencoba. Pertanyaan dan permintaan file source dapat dikirim ke e-mail

penulis. PC+

13.Turunkan Layer Opacity.

Slider
opacity
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Koneksi
PHP - PostgreSQL

Yahya Kurniawan
yahya@e-pcplus.com

Di dua edisi PCplus
terakhir, telah

diberikan tutorial
tentang penggunaan

PostgreSQL. Memang
baru sebagian kecil

dari fitur-fitur
PostgreSQL yang
dibahas, namun

sebagai dasar
penggunaan

PostgreSQL dirasa
sudah cukup. Anda

bisa mempelajari
sendiri dari PostgreSQL
manual jika ingin lebih

jauh mempelajarinya.

ah, sekarang
tahap berikut dari
pembelajaran
PostgreSQL adalah

koneksi yang dapat dilakukan
dengan PHP. Sebagaimana
dukungan yang diberikan kepada
MySQL, PHP juga memiliki
fungsi-fungsi built-in yang siap
digunakan untuk koneksi ke
server database PostgreSQL.
Untuk mempelajari hal ini kita
akan menggunakan contoh
database “Perpustakaan” yang
kita buat minggu yang lalu.

OK, kita mulai saja dengan
langkah-langkah yang harus
dilakukan untuk melakukan
koneksi PHP – PostgreSQL.
Sebelum kita mulai dengan
membuat skrip PHP, ada
beberapa setting yang terlebih
dahulu harus diatur. Dalam
pengaturan ini tentu saja Anda
harus login sebagai root.

Yang pertama adalah
mengedit file /var/lib/pgsql/
data/postgresql.conf (letak file
ini mungkin berbeda jika tidak
menggunakan RedHat 9.0).
Carilah bagian bertuliskan
#tcpip_socket = false,
uncoment bagian tersebut dan
gantilah nilainya menjadi true
hingga menjadi tcpip_socket =
true.

Setelah itu edit file /var/lib/
pgsql/data/pg_hba.conf.
Tambahkan teks berikut pada
baris terakhir file tersebut: host
[tab] all [tab] all [tab] 127.0.0.1
[tab] 255.255.255.255 [tab]
trust. Tanda [tab] maksudnya
adalah menekan tombol [tab] pada
keyboard Anda. Jika Anda ingin
tahu arti dari setting ini, Anda da-
pat membaca PostgreSQL Manual.

Langkah berikutnya adalah
menambahkan sebuah user yang
nantinya akan mengakses
PostgreSQL dari PHP. Misalnya
saja nama user tersebut adalah
pcplus, maka yang harus Anda
lakukan adalah sebagai berikut:

# su postgres
bash-2.05b$ createuser pcplus
Shall the new user be allowed
to create databases? (y/n) n
Shall the new user be allowed
to create more new users? (y/
n) n
CREATE USER
bash-2.05b$

Yang terakhir, user pcplus ini
harus diberi wewenang (privi-

lege) untuk dapat melakukan
query pada database
perpustakaan. Jenis privilege
yang tersedia adalah: SELECT,
INSERT, UPDATE, DELETE, RULE,
REFERENCES, TRIGGER, CRE-
ATE, TEMPORARY, EXECUTE,
USAGE, dan ALL PRIVILEGES.
Misalnya Anda hanya akan
memberi wewenang SELECT
pada user pcplus untuk
mengakses database bernama
buku, maka yang Anda harus
lakukan adalah sebagai berikut:

bash-2.05b$ psql
perpustakaan
perpustakaan=# grant select
on buku to pcplus;
GRANT
perpustakaan=#

Nah, sekarang kita siap
untuk melakukan koneksi PHP –
PostgreSQL (untuk database
perpustakaan yang telah kita
buat minggu lalu).

Membuka koneksi
Untuk membuka koneksi dari

PHP ke PostgreSQL digunakan
fungsi pg_connect() yang
sintaksnya adalah sebagai berikut:

pg_connect(string_koneksi);

Parameter string_koneksi
dapat berisi hal-hal sebagai
berikut:

• host
• port
• tty
• options
• dbname
• user
• password

Berikut ini adalah beberapa
contoh penggunaan fungsi
pg_connect() tersebut.

$conn = pg_connect
("dbname=pcplus");
// melakukan koneksi ke
database bernama “pcplus”.

$conn2 = pg_connect
("host=localhost port=5432
dbname=pcplus");
// melakukan koneksi ke
database bernama "pcplus" di
"localhost" pada port "5432"

$conn3 = pg_connect
("host=serverplus port=5432
dbname=pcplus user=aku
password=rahasia");
// melakukan koneksi ke
database bernama "pcplus"
pada host "serverplus" di
port “5432” dengan username
“aku” dan password
“rahasia”.

$conn_string =
"host=serverplus port=5432

dbname=pcplus user=aku
password=rahasia";
$conn4 = pg_connect
($conn_string);

Perhatikan bahwa contoh ke
tiga dan keempat akan memberi-
kan hasil yang sama, hanya saja
penulisan string_koneksi
dipisah pada variabel tersendiri.

Eksekusi query
Setelah koneksi berhasil

dibuka, langkah berikutnya
adalah mengeksekusi query yang
ingin dilakukan terhadap data-

base tersebut. Fungsi yang digu-
nakan adalah fungsi pg_query()
dengan sintaks sebagai berikut:

pg_query(koneksi, query)

Parameter koneksi adalah
variabel berisi koneksi yang
dibuka dengan fungsi
pg_connect(). Parameter ini
boleh tidak dituliskan, tetapi
alangkah baiknya tetap ditulis-
kan karena akan mempermudah
proses debug seandainya ada
error yang terjadi.

Parameter query berupa teks
yang berisi perintah SQL.

Contoh penggunaannya
adalah sebagai berikut:

$conn = pg_connect
("dbname=perpustakaan");
$strsql = "select * from
buku";
$query = pg_query
($conn,$strsql);

Mengambil
hasil query

Query yang dieksekusi di atas
akan memberikan hasil berupa
array. Untuk “menjemput” array
tersebut ada beberapa fungsi
yang dapat digunakan yaitu:

pg_fetch_all() – Mengambil
seluruh baris hasil query
sebagai array.

pg_fetch_array() – Mengambil
suatu baris hasil query sebagai
array.

pg_fetch_assoc() – Mengambil
suatu baris hasil query sebagai
array asosiatif.

pg_fetch_object() – Mengambil

suatu baris hasil query sebagai
objek.

pg_fetch_row() – Mengambil
suatu baris hasil query sebagai
array.

Pada dasarnya sintaks dari
fungsi-fungsi tersebut hampir
sama yaitu sebagai berikut:

namafungsi(query, baris)

Parameter query adalah
query yang dihasilkan dari fungsi
pg_query.

Parameter baris adalah

nomor baris dari hasil query.
Sejak PHP versi 4.1.0, parameter
baris ini boleh diabaikan karena
setiap digunakan akan naik
secara bertahap (inkremen). Nilai
kenaikannya adalah 1.

Khusus untuk fungsi
pg_fetch_array() dan
pg_fetch_object() ada satu
parameter lagi yang digunakan
dan terletak paling akhir yaitu
parameter tipe_hasil. Parameter
ini menentukan tipe array yang
dihasilkan, apakah array vektor,
array asosiatif, atau keduanya.
Nilai yang mungkin dari param-
eter tipe_hasil adalah
PGSQL_ASSOC, PGSQL_NUM,
dan PGSQL_BOTH. Untuk fungsi
pg_fetch_object nilai
PGSQL_NUM tidak berlaku.

Pada kasus di mana nomor
baris dari hasil query perlu
dituliskan, mungkin kita perlu
tahu dengan pasti jumlah baris
yang ada. Untuk mengetahui
jumlah baris dari hasil query
dapat digunakan fungsi
pg_num_rows(). Fungsi ini akan
menghitung jumlah baris yang
dihasilkan oleh query.=.

OK, teori dirasa sudah cukup.
Sekarang kita menginjak pada
contoh skrip PHP untuk melaku-
kan koneksi ini. Berikut adalah
contoh untuk melakukan koneksi
ke database perpustakaan dengan
user pcplus, mengambil query, dan
menampilkan hasil query tersebut
ke dalam bentuk tabel.

<HTML>
<HEAD>
<TITLE>Test PostgrSQL </TITLE>
</HEAD>

<BODY>
<?
$conn = pg_connect
("host=localhost
dbname=perpustakaan
user=pcplus");
if (!$conn) {

echo "Ada error pada
koneksi ke PostgreSQL";

exit;
}

$strsql = "select * from
buku";
$query =
pg_query($conn,$strsql);
if (!$query) {

echo "Ada kesalahan
pada query Anda";

exit;
}
?>

<TABLE BORDER=1>

<TR>
<TD>ISBN </TD>
<TD>Judul </TD>
<TD>Penulis </TD>
<TD>Penerbit </TD>
<TD>Tanggal Terbit </TD>
</TR>

<?
// dengan pg_fetch_row
while($hasil =
pg_fetch_row($query)) {

echo "<TR>";
echo "<TD> $hasil[0] </TD>";
echo "<TD> $hasil[1] </TD>";
echo "<TD> $hasil[2] </TD>";
echo "<TD> $hasil[3] </TD>";
echo "<TD> $hasil[4] </TD>";
echo "</TR>";

}
?>
</TABLE>
</BODY>
</HTML>

Jika Anda ingin mengguna-
kan array asosiatif, bagian yang
diberi keterangan “// dengan
pg_fetch_row” dapat Anda
ganti dengan skrip berikut:

$brs = pg_num_rows($query);
for ($i=0;$i<$brs;$i++) {

$hasil =pg_fetch_array
($query,$i,PGSQL_ASSOC);

echo "<TR>";
echo "<TD>

$hasil[isbn] </TD>";
echo "<TD>

$hasil[judul] </TD>";
echo "<TD>

$hasil[penulis] </TD>";
echo "<TD>

$hasil[penerbit] </TD>";
echo "<TD>

$hasil[thterbit] </TD>";
echo "</TR>";

}

Hasil eksekusi skrip ini akan
nampak seperti Gambar 1.

Selamat belajar.  PC+

N



plusInteraksi

| 23

V • 06 - 12 Januari 2004
PCplus 157

Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan
mendaftar dengan mengirimkan e-mail  kosong ke mailplus-

subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang

dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda
dapat mengirimkan e-mail pertanyaan ataupun tukar menukar

pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika

Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join
ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu

e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-
digest@yahoogroups.com. Sebagai informasi, setiap hari Jum’at hingga

Minggu adalah hari bebas di milis ini.
Setiap anggota dapat mem-posting e-mail diluar seputar masalah

komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak
software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-

mail OOT (Out Of Topic), kirim e-mail ke mailplus-
nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode
normal dengan mengirim e-mail ke mailplus-normal@yahoogroups.com.

•Redaksi

Kecepatan Koneksi LAN Tanya Dual Boot Windows XP

Rekan-rekan milis, gimana ya caranya melihat kecepatan koneksi jaringan di LAN
baik di sistem operasi Windows 2000/XP atau di 98? Terima kasih sebelumnya.

ISD

Jawab:
Kalau di Windows 2000 atau XP, coba kamu lihat di icon kecil yang bergambar

dua buah komputer kelap-kelip. Klik saja di sana. Dari situ kamu bisa lihat status,
durasi, dan kecepatannya.

Kalau kamu memakai Windows 98, gunakan saja software LAN Light. Software
ini absolutely free dan dijamin tokcer. Di situ bisa ketauan berapa transmission (Tx)-
nya dan berapa data-received speed (Rx)-nya. Mirip kayak di Windows 2000/XP. Kalau
kamu mau men-download software ini, ambil aja di http://www.dalesplace.net/
download/LanLightF.zip. Semoga membantu, salam.

John DOE, The Gunners

Windows XP Error

Rekan milis, selagi aku
berinternet ria, rasanya ada
program yang nyusup dan meng-
install secara otomatis di
komputerku. Aku taunya karena
di desktop-ku tiba-tiba muncul
shortcut "Second Thought". Wak-
tu aku cari program tersebut di
folder manapun di komputerku,
gak ketemu-ketemu, termasuk di
Add/Remove Program juga gak
ada. Nah sekarang setiap kali aku
start komputer, selalu ada pesan
error “2ndsrch.dll missing”.

Gimana cara ngebetulinnya
ya? Aku udah coba restore, tapi
gak bisa. Apa ada yang bisa
bantu? Trimakasih sebelumnya.

Yungkie Angkasa

Jawab:
Coba Anda install dan

jalankan AdAware. Kalau perlu,
download aja di
www.lavasoftusa.com. Software
lainnya adalah SpyBot Search &
Destroy. Software ini ada di
http://www.safer-networking.org/
index.php?lang=en&page=download.
Biasanya dengan software-soft-
ware semacam ini program ban-
del semacam tadi bisa terdeteksi.

Adhitya F. Anggoro

Monitor Gue
Kenapa Ya?

Halo rekan-rekan milis,
Tolong kasih pencerahan

dong, spesifikasi komputer saya
begini:
• AMD Athlon XP 2200+
• ECS VIA KT400
• Inno3D Geforce-4 MX440 8x

64MB DDR

Saya mempartisi harddisk 40GB sama besar, C:\ 20GB dan D:\ 20GB. Di partisi C:\,
saya mengisikannya dengan Windows XP Home Edition dan di D:\ Windows XP
Professional. Sekarang Windows XP Home Edition-nya sudah saya hapus. Masalahnya,
bagaimana cara menghilangkan pilihan dual boot pada waktu start? Terima kasih.

Herry
Jawab:
Coba Anda klik di Windows XP Professionalnya tombol [Start] > [Setting] >

[Control Panel] > [System]. Pada menu tersebut, pilih tab [Advanced]. Setelah itu, klik
[Setting] pada bagian Startup and Recovery. Pada menu berikutnya, klik [Edit]
Hapus pilihan Windows XP Home Edition-nya.

Cara lainnya, coba Anda lakukan booting pakai CD instalasi Windows XP. Pilih
Recover Console (r). Kalau sudah, ketik fixboot lalu tekan [Enter]. Lalu fixmbr, dan
tekan [Enter]. Kalau ada warning, klik [OK]saja. Semoga membantu.

Eddy Setiawan Wibowo, Adhitya F. Anggoro

• DDR 256 PC-3200
• Mugen 14" Digital
• DVD ROM Lite On
• CD-RW Lite On 52x24x52x
• Sistem Operasi Windows 98SE

Yang ingin saya tanyakan
adalah:

Awalnya saya menggunakan
resolusi monitor 1024x768 dengan
refresh rate default. Masalahnya,
kenapa kok pada keesokan hari-
nya atau pada saat komputer ti-
dak dinyalakan dalam waktu lama,
resolusinya turun menjadi
800x600? Bagaimana ini? Apakah
saya perlu mengganti monitor
saya?

vw_ibe

Jawab:
Saya sarankan Anda update

driver VGA dan monitor. Coba
Anda cari saja di website ECS.
Untuk monitornya, set aja ke
Plug n Play monitor.

Adhitya F. Anggoro

Cara Setting LAN
User ke Server

Mas-mas dan rekan-rekan
sekalian, ada yang tahu gak
bagaimana cara dan men-settting
supaya kita bisa sharing antar
komputer? Contohnya: pada
jaringan sudah ada dua user lama
dan satu server. Tetapi sekarang
ada satu komputer user baru
yang mau bergabung ke
jaringan. Saya sudah coba utak-
atik setting-nya tetapi masih gak
ada sharing-nya. Bagaimana ya?

Sebagai tambahan, user
tersebut menggunakan sistem
operasi Windows XP sedangkan
server-nya menggunakan
Windows 98. Langkah-

langkahnya kayak gimana sih?
Ada perbedaan gak, antara men-
setting Windows ME, XP, dengan
98?

Satu lagi, saya juga mau
tanya apakah kita bisa
mengkoneksikan dua komputer
tanpa menggunakan hub?
Contoh, saya punya komputer
menggunakan motherboard Asus
A7N8X dengan LAN onboard dan
saya ingin menghubungkannya
dengan komputer IBM yang
menggunakan LAN onboard
juga. Apa file sharing bisa
dilakukan pada dua komputer
dengan kabel LAN saja tanpa
hub? Terima kasih banyak bila di
antara rekan-rekan Ada yang
dapat membantu saya. Salam.

poncho

Jawab:
Biasanya di komputer client,

pada Properties Network-nya,
aktifkan File and Printer Sharing.
Pada NetBEUI, isi IP dan mask-
nya. Komputer user baru tersebut
kasih IP baru.

Setau gue, pada tipe koneksi
client-server, biasanya menggu-
nakan domain. Komputer yang
baru mau gabung biasanya harus
join domain dulu ke dalam
lingkungan domain. Lain halnya
dengan P2P (Peer to Peer) atau
workgroup yang langsung bisa
join ke dalam network tanpa
perlu authentication dari domain
server.

Kalau user-nya Windows XP,
ikuti aja semacam Connection/
Network Wizard di XP-nya.

Gampang aja kok, bahasanya
juga mudah. Nanti tinggal res-
tart, dan setelah restart, tunggu
saja beberapa saat sampai Win-
dows XP-nya mendetek semua PC

yang ada di jaringan. Kalau user
tersebut mau ikut internet
sharing ke server, masukkan IP
server sebagai gateway di user.

Untuk tipe client-server,
Windows 98 dan ME sama
caranya, sedangkan untuk
Windows 2000/XP beda lagi
caranya.

Pada Windows 98 dan ME:
Klik kanan [Network

Neighbourhood] > [Properties].
Pada tab [Configuration] klik
[Add client for MS Network].
Pada bagian Client for Ms
Network beri centang pada Log
on to Windows NT Domain. Lalu
isi nama domain-nya. Lalu pada
Network Logon Option, pilih dan
OK di Logon and Restore......

Pada Primary Network
Logon, pilih Client for Microsoft
Network, pada File & Print
Sharing, centang kedua opsi yang
ada. Jangan lupa untuk isi TCP/IP
atau biarkan saja kalau sudah
terinstal DHCP pada server.

Pada Windows XP dan
Windows 2000:

Isi dulu TCP/IP atau biarkan
kosong kalau sudah
menggunakan DHCP. Klik kanan
[My computer] > [Properties] >
[Network Identification] >
[Properties] > [Member of
Domain]. Setelah Anda isikan
nama domain, klik [OK].

Nanti Anda akan ditanya
user name dan password. Isikan
dengan account admin atau
yang punya otorisasi selevel
admin. Setelah itu restart
komputer.

Kalau untuk mengkoneksi-
kan dua komputer tanpa hub,
Anda bisa pakai kabel UTP cross,
bisa pesan di toko komputer atau
bikin sendiri kalo ada alatnya.
Kalau sudah ada, tinggal pasang
di LAN-card masing-masing.
Setelah itu set jaringan dan IP
seperti biasa.

DinDin

✔

+

✔

+

✔

+

✔

+

✔

+



Elsa Falcox 980FX:

Kartu Grafis Radeon
9800 Versi Standar

Atikom
www.elsa.com.tw
☎ (021) 6123612

332 dolar AS

Bagi perusahaan yang ingin produknya diulas pada rubrik ini, silakan kirim produk tersebut ke alamat Redaksi. Produk yang dikirimkan sebaiknya merupakan paket penjualan,
sesuai dengan yang akan dipasarkan. Sertakan pula informasi detail mengenai produk, nama distributor, telepon yang dapat dihubungi, dan kisaran harga produk tersebut untuk

end-user. Kami tidak memungut biaya apapun untuk produk yang dimuat, sedangkan pengujian dilakukan berdasarkan produk yang kami terima terlebih dahulu.

Soltek SL-KT600-RL:

Mobo Berbasis KT-600
dengan 6 Slot PCI

Berca Cakra Teknologi
www.soltek.com.tw

☎ (021) 2316352
73 dolar AS
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3D Mark 2001
1024 x 768  32bit :15898
1600 x 1200  32bit :11220

3D Mark 2003
1024 x 768 :5001
1600 x 1200 :2836

Quake III Arena
1024x768 high quality:320,8fps
1600x1200 high quality:191,2fps

Serious Sam Second Encounter
1024 x 768 :78,0fps
1600 x 1200 :42,5fps

Commanche 4
1024 x 768 :56,37fps
1600 x 1200 :54,37fps

Halo
1024 x 768 :46,43fps
1600 x 1200 :21,68fps

SysMark 2002
Rating :263
Internet Content :338
Office Productivity:205

3D Mark 2001
640 x 480  16bit :15859
1024 x 768  32bit :12836

3D Mark 2003
640 x 480 :5811
1024 x 768 :3822

Quake III Arena
640 x 480  normal :302,5fps
1024x768 high quality:300,4fps

TMPGenc
38 menit 32 detik

Serious Sam
640 x 480 :114,3
1024 x 768 :88,2

ATi memper-
kenalkan chip

R350 mereka pada kuartal
pertama tahun lalu. Chip grafis
R350 ini tujuannya adalah
untuk menggantikan chip grafis
R300 alias Radeon 9700 yang
merupakan produk tercepat
pada masanya. Chip R350 yang
diproduksi dengan teknologi
0,15 micron ini mempersenjatai
kartu grafis high end terbaru
saat itu yakni seri Radeon
9800Pro dan memang
mendapat dukungan yang luas
dari banyak vendor pembuat
kartu grafis.

Yang jarang terdengar
gaungnya adalah kartu grafis
Radeon 9800 yang
menggunakan konfigurasi
standar alias non-pro. Saat R350
diluncurkan, untuk kartu grafis
seri 9800 non-pro ini core clock
dan memory clock-nya belum
diketahui. Alasan penundaan
diluncurkannya kartu grafis seri

Soltek yang
merupakan salah satu
produsen motherboard memang
cukup banyak memiliki seri
motherboard yang diperuntuk-
kan untuk sistem berbasis
prosesor AMD. Salah satu tipe-
nya adalah SL-KT-600 RL yang
mengusung chipset bikinan VIA.

Seperti terlihat dari serinya,
produk ini menggunakan
chipset VIA KT600 sebagai polisi
data utama alias
chipset Northbridge-
nya. Dengan
penggunaan chipset
ini, Soltek ini sudah
mampu mendukung
penggunaan
prosesor AMD
Athlon XP dengan
Front Side Bus
sebesar 400MHz
atau varian di
bawahnya.
Sementara itu,
untuk urusan
memori, 3 buah
soket DIMM yang

disertakannya mampu
menampung DDR dari jenis PC-
3200 atau varian di bawahnya
dengan kapasitas maksimal
hingga sebesar 3GB. Selain itu,
chipset utamanya juga sudah
mendukung teknologi AGP
bermode 8X atau di bawahnya.
Untuk dukungan ini, SL-KT600-RL
juga menyertakan sebuah port
AGP yang dilengkapi pula dengan
pengunci.

Untuk tambahan beragam
fitur modern, motherboard ini
menggunakan chipset
Southbridge VT8237 yang
mendukung pula penggunaan
ATA133 untuk harddisk jenis
parallel ATA dan drive optik. Yang
menonjol dari produk ini adalah 6
buah slot PCI untuk menampung
beragam kartu tambahan. Jumlah
sebanyak ini tentu sudah sangat
cukup untuk beragam kartu

tambahan yang mungkin
dipasang. Kelengkapan
lain yang didukung
motherboard ber-form
factor ATX ini adalah
adanya LAN onboard dari
kelas PHY6103 dengan
kemampuan 10/100 fast
Ethernet base T LAN. Tak
ketinggalan pula
disertakan pula sebuah
controller onboard dari
kelas AC’97 yang sudah
mendukung audio 6
channel analog.

Fitur lain yang
tergolong lumayan

baru juga dimiliki oleh produk
berbasis AMIBIOS ini adalah serial
ATA dengan dua port dan
Universal Serial Bus versi 2.0 yang
dapat diekspansi hingga 8 buah
port. Fitur lain yang disertakan
adalah 2 port PS/2, 2 port serial, 1
port parallel, dan sebuah port
audio dengan 3 buah port plus
sebuah port game/midi.

Menarik diperhatikan dari
produk dengan heatsink
pendingin pada Northbridge-nya
ini adalah masih digunakannya
jumper sebagai pengatur FSB
prosesornya selain pengaturan
secara otomatis lewat BIOS. Tak
kalah menarik untuk disimak juga
adalah letak dua port power yang
disertakan di bagian tengah.
Dengan port power seperti ini,
kabel-kabel dari power supply
berpotensi akan menggangu
aliran udara di sekitar prosesor.

PCplus menguji produk ini
dengan menggunakan test bed
baru yaitu prosesor AMD Athlon
3200+ FSB400MHz, memori
Kingston 1GB dua keping,
harddisk Barracuda ATA 7200.7
40GB, kartu grafis Albatron
GeForce FX5700 128MB DDRII,
power supply Enlight 420W, dan
monitor ViewSonic PF950F+.
Driver yang digunakan adalah
versi terbaru yaitu VIA 4in1 versi
4.51v dengan detonator 52.16.
Pengujian dilakukan dengan
menggunakan software SysMark
2002, 3DMark2001, 3DMark 2003,

Radeon 9800 versi standar adalah
karena menurut prediksi ATi,
produk ini memiliki kemungkinan
untuk lebih banyak menarik
pembeli dibandingkan
saudaranya versi high end
Radeon 9800Pro yang dijual
dengan harga sekitar 100 dolar
lebih tinggi.

Setelah beberapa waktu
kemudian, barulah kartu grafis
seri 9800 versi standar ini
diluncurkan ke pasaran. Salah
satu vendor yang ikut
memproduksi kartu grafis
Radeon 9800 jenis ini adalah Elsa
dengan produknya Falcox 980FX.
Produk yang kami terima kali ini
adalah bikinan Elsa yang
menggunakan konfigurasi
memori DDR sebesar 128MB.

Perbedaan utama kartu
grafis seri Radeon 9800 dengan
seri Radeon 9800Pro adalah
clock-nya, baik core dan memory-
nya. Pada kartu grafis Elsa ini,
saat kami cek dengan software

PowerStrip 3.47, kami mendeteksi
bahwa core clock default-nya
adalah 324MHz sedangkan
memory clock-nya adalah
580,50MHz. Bandingkan dengan
standar Radeon 9800Pro yang
clock core dan memory-nya pada
380MHz dan 680MHz. Namun,
sama seperti versi Radeon
9800Pro, kartu grafis yang juga
memiliki sejumlah 107 juta buah
transistor ini memiliki
kebutuhkan daya yang sama
hingga membutuhkan konektor
daya tambahan.

Pada Elsa Falcox 980FX,
fasilitas pendingin chip VPU-nya
merupakan heat sink fan standar
ATi. Meskipun tidak ada fitur
pendinginan untuk chip memori
jenis DDR 256-bit keluaran
Samsung yang digunakan, namun
kartu grafis ini dapat bekerja
dengan baik pada kondisi
normal.

Pada paket penjualan kartu
grafis yang kami terima, tersedia
bundel CD Delta Force Black
Hawk Down dari Novalogic serta
sebuah CD driver. Untuk

perlengkapan tambahannya,
kartu grafis ini disertai sebuah
kabel S-Video, kabel RCA,
konverter S-Video ke RCA, dan
konverter DVI ke VGA D-Sub.
Cukup standar, tidak ada
perlengkapan atau bundel CD
lainnya seperti pada umumnya.

Namun demikian, dari sisi
buku manual yang diterbitkan
dalam dua bahasa, informasi
yang dimuat cukup jelas. Fitur-
fitur yang dimiliki oleh kartu
grafis dipaparkan dengan
lengkap pada buku manual ini.

Kami menguji kartu grafis ini
pada motherboard Abit AN7
dengan chipset nVidia nForce-2
Ultra 400 serta prosesor AMD
Athlon XP 3200+ yang
menggunakan FSB 400MHz.
Modul memori yang kami pasang
adalah dua keping memori
Kingston DDR400 masing-masing
berkapasitas 512MB dengan
mode dual channel diaktifkan.
Untuk media penyimpanan kami
memakai Seagate Barracuda
7200.7 kapasitas 40GB. Sistem
operasi Windows XP Professional

Service Pack 1 kami gunakan
dengan driver nVidia ForceWare
52.16. (fmn)

ARE/PCplus

Quake3 Arena Demo, TMPGenc,
dan Sisoft Sandra 2003Pro.

Dari hasil uji yang dilakukan,
terlihat kemampuannya memang
cukup baik. Hanya saja, skor yang
dihasilkan memang sedikit lebih
rendah jika dibanding produk yang
menggunakan chipset nForce2.
Selain karena faktor chipset-nya,
faktor system clock prosesor  yang
standar yaitu 200,01MHz alias tidak
dinaikkan oleh pembuatnya juga
jadi penyebab mengapa skor yang
dihasilkan masih sedikit lebih
rendah. (sil)

ARE/PCplus
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Acer Power ST:

Sistem PC
Pendukung
Bisnis

Acer Indonesia
www.acer.com

☎ (021) 5745888

Acer yang
merupakan perusahaan
TI terkemuka juga
mengeluarkan produk-produk
PC branded dengan beragam
spesifikasi. Khusus untuk sistem
PC, Acer membagi klasifikasi
produknya berdasarkan target
pasarnya yaitu untuk kelas
Home PC dan Business PC.
Salah satu produk kelas
bisnisnya yang diterima PCplus
adalah versi Acer Power ST.

Datang dengan beragam
fitur all in one, produk yang
berbasis chipset SiS651 ini
menawarkan spesifikasi yang
cukup menarik untuk
pengguna kantoran. Selain
mengusung prosesor sekelas
Pentium-4 2,5GHz FSB400MHz,
memori DDR PC-2700 yang
disertakannya memiliki
kapasitas sebesar 128MB.

Sementara, untuk
harddisk, Acer menggunakan
paralel IDE Maxtor
berkapasitas 40GB yang
dikombinasikan dengan
sebuah CD-ROM 52X. Sebagai
produk yang menggunakan
chipset yang mendukung
motherboard all in one, cukup
banyak fitur yang diusung
oleh motherboard yang
digunakannya. Fitur utama
yang dimilikinya adalah
sebuah VGA onboard dari SiS
dengan share memory hingga
64MB. VGA onboard semacam ini
memang menguntungkan untuk
pengguna kantoran yang
memang tidak terlalu
membutuhkan spesifikasi grafis
terlampau tinggi. Meski begitu,
produk yang menggunakan
power supply sebesar 200watt
murni ini juga menyertakan

sebuah port AGP 4X.
Selain itu, disertakan pula

sebuah controller LAN onboard
dari kelas Realtek RTL8100B
dengan port RJ-45 yang memberi
dukungan terhadap transfer data
hingga 10/100Mbps. Dukungan
LAN onboard ini memang sudah
tepat karena PC ini memang
ditujukan untuk pengguna

kantoran
yang
masing-
masing PC
terhubung
dalam satu
jaringan.

Untuk
kemungkinan
ekspansinya,
selain
menyertakan
pula 3 buah
slot PCI untuk
kartu add on
yang mungkin
dipasang, Acer
juga
menyertakan 4
back panel di
bagian

belakang casing.
Sementara, untuk

di bagian depan,
disertakan sebuah

bay tambahan jika
pengguna ingin

menambah sebuah drive
optik.

Untuk perangkat input-
output, produk yang masih
menyertakan sebuah drive floppy
di bagian depan ini tergolong
standar. Selain menyertakan port
input-output standar semisal PS/2
untuk mouse dan keyboard,
sebuah port paralel, dan sebuah
port serial. Untuk mendukung
controller suara onboard RealTek
601A, disediakan pula port audio

pada jajaran input-outputnya.
Menariknya, selain menyertakan
port audio di bagian belakang,
Acer juga menyertakan dua port
audio tambahan di casing
bagian depan untuk headset
dan microphone. Untuk transfer
data yang lebih cepat, Acer juga
menyertakan dua buah port
USB di bagian belakang plus
tambahan dua port di bagian
depan.

Pada paket jual
lengkapnya, produk yang
menggunakan sistem operasi
Linux ini menyertakan pula
sebuah monitor yang bisa
dipilih apakah tipe CRT atau
LCD. Sementara, untuk ukuran,
Acer Power ST ini menyediakan
pilihan 15” dan 17”. Tak lupa
disertakan pula sebuah key-
board dan mouse khas Acer

Untuk pengguna kantoran
dengan aplikasi ringan hingga
sedang, beragam fitur yang ada
pada PC ini memang sudah
mampu memberikan kinerja
yang cukup baik. Hanya saja,
kapasitas memorinya yang
hanya 128MB membuat aplikasi
yang mampu dijalankan  lebih
terbatas. (sil)

ARE/PCplus
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OCZ PC-4000 EL Gold Dual Channel:
Memori Kecepatan Tinggi
untuk Sistem Dual Channel

Sony DRX-510UL:

DVD Writer Eksternal
dengan Format Fleksibel

Soca Marketing
www.sony.com
☎ (021) 6347638

Rp.3.200.000,-

Asus WL-100g:

Mudahnya Masuk ke
Jaringan Berbasis WiFi

Astrindo Senayasa
www.asus.com

☎ (021) 6121330
65 dolar AS

Astrindo Senayasa
www.ocztechnology.com

☎ (021) 6121330
236 dolar AS

Sony merupakan salah
satu pemain utama dalam dunia
elektronika. Banyak produk Sony
yang terkenal di dalam dunia
elektronika hiburan. Di samping
menghasilkan produk-produk
seperti TV, CD player, speaker,
Sony juga menghasilkan DVD
writer yang diperuntukkan bagi
PC. Ini sebenarnya bukanlah
sesuatu yang baru berhubung
sebelumnya juga Sony sudah
mengeluarkan produk optical
drive-nya untuk PC, seperti halnya
CD-ROM drive. Salah satu produk
DVD-Writer Sony yang belum
lama dikeluarkan adalah DRX-

510UL.
Pada saat sekarang ini ada dua

format yang sedang bersaing ketat
dalam dunia DVD writer. Kedua
format tersebut adalah format +
(plus) dan format – (minus). Format
ini sudah bersaing sejak beberapa
lama dan hingga saat ini belum ada
yang bisa dikatakan sebagai format
yang dominan, apalagi format yang
menang. Melihat kondisi di mana
belum ada format yang menang
ataupun dominan, Sony berinisiatif
mengeluarkan DVD-writer yang
mendukung kedua format tersebut.
Sony memang merupakan produsen
pertama yang mengeluarkan DVD

writer
yang
mendukung
kedua format tersebut. Sony
DRX-510UL ini juga merupakan
DVD writer yang telah mendukung
kedua format + dan – tersebut. Sony
DRX-510UL ini merupakan DVD
writer eksternal yang dilengkapi
dengan interface USB 2.0 dan
FireWire. Dengan interface ini, DRX-
510UL ini bisa mencapai kecepatan
maksimalnya tanpa ada hambatan.

Sony DRX-510UL ini memiliki
kecepatan menulis sebesar 4x untuk
DVD-R, 2x untuk DVD-RW, 4x untuk
DVD+R, 4x untuk DVD+RW, 24x

untuk CD-R, dan 16x untuk CD-RW.
Adapun kecepatan yang dimiliki
untuk pembacaan adalah 12x
sebagai DVD-ROM drive dan 32x
sebagai CD-ROM drive. Kecepatan-
kecepatan di atas tentunya adalah
kecepatan maksimal yang bisa
dihasilkan.

Untuk mengetahui apakah
kecepatan menulis maksimal di atas
bisa tercapai, PCplus melakukan
pengujian dengan Nero Burning
Rom 6.0.0.28 menggunakan data

berukuran 4480MB (total data
yang ditulis adalah 4483MB) untuk
DVD dan 675MB (total data yang
ditulis adalah 676MB) untuk CD.
Berhubung tidak tersedia media
DVD maupun CD yang bisa ditulis
ataupun ditulis ulang pada paket
yang PCplus terima, PCplus
menggunakan DVD+R 4x, DVD-R
4x, DVD+RW 2,4x, DVD-RW 2x,
CD-R 52x, dan CD-RW 10x yang
PCplus miliki. Adapun hasil yang
diperoleh menunjukkan bahwa
untuk DVD+R 4x kecepatan (rata-
rata) yang diperoleh adalah
sebesar 3,61x, untuk DVD-R 4x
sebesar 3,46x, untuk DVD+RW 2,4x
sebesar 2,43x, untuk DVD-RW 2x
sebesar 1,83x, untuk CD-R 24x
sebesar 16,97x, dan untuk CD-RW
10x sebesar 9,03x. (cgs)

ARE/PCplus

Era wirelessmemang
membuat para produsen produk-
produk TI juga tak mau kalah
dalam mengeluarkan beraneka
ragam produk berbasis nirkabel.
Salah satu yang tengah gencar
mengeluarkan produk semacam
ini adalah Asus dengan sederetan
kartu wireless maupun access
point-nya. salah satu seri produk
jenis ini adalah WL-100g yang
merupakan wireless LAN card.

Datang dengan
menggunakan interface PCMCIA,
produk asal Taiwan ini memang
diperuntukkan untuk notebook
yang memiliki slot PCMCIA.

OCZ yang baru
meramaikan pasar
memori sejak Agustus 2000
sekarang ini merupakan salah satu
brand memori yang cukup
disegani. Beberapa laboratorium
uji perusahaan motherboard
memanfaatkan produk buatannya
sebagai test bed resmi untuk
memorinya. Salah satu tipe yang
dimilikinya adalah PC-4000 EL
Gold Dual channel.

PCplus sendiri menerima
produk ini sebanyak dua keping
dengan kapasitas 256MB. OCZ
memberikani heatspreader
kuning keemasan yang terbuat
dari tembaga pada kedua sisinya

Alhasil, produk ini dapat diinstal
pada notebook manapun yang
memiliki slot jenis ini. Dari sisi
spesifikasi teknisnya, produk yang
tergolong cardbus tipe II ini sudah
mendukung protocol 802.11g yang
menggunakan frequency band
sebesar 2,4GHz dengan
kemampuan untuk transfer data
hingga mencapai 54Mbps. Kartu ini
juga sudah mendukung
penggunaan sistem dual mode
sehingga kompatibel dengan access
point berprotokol 802.11b.

Untuk dapat menggunakan
kartu ini, Asus
mensyarat-
kan

notebook
dengan prosesor

300MHz atau lebih
dengan memori
minimal sebesar
32MB.

Agar
kemampuan
menangkap sinyal

cukup kuat, Asus menyertakan pula
sebuah antena eksternal yang dapat
dilipat bila tidak digunakan.
Sementara, sebagai indikator kartu
ketika sedang bekerja, disertakan
pula dua buah lampu indikator
sebagai penanda apakah sistem
sedang terhubung ke jaringan dan
adanya frekuensi  gelombang radio
yang diperlukan di sekeliling.

Keunikan dari kartu yang
dapat bekerja pada sistem jaringan
ad hoc maupun infrastructure ini ini
adalah proses instalasi yang sangat
cepat dan user friendly, baik saat
diinstal pertama kali maupun saat
digunakan. Ini dimungkinkan

berkat software bawaannya yang
cukup mudah dipahami. Pada
software yang disertakan, beragam
setting jaringan bisa diatur dengan
sangat mudah. Tak ketinggalan
disertakan pula fitur keamanan
data pada software-nya dengan
sistem keamanan yang dimiliki
karena sudah menggunakan
standar WEP 64/128 bit.

Ketika diuji coba pada di dalam
ruangan, kemampuan yang
diberikan produk yang
membutuhkan tegangan 3,3volt ini
sudah cukup baik. Jarak yang bisa
dijangkau bisa mencapai sekitar 40
meter lebih dengan halangan

agar panas yang ditimbulkan bisa
tersebar merata. Adanya
heatspreader ini menunjukkan
memori ini dirancang untuk bekerja
pada clock yang tinggi dan
dipersiapkan untuk overclock.

Dari sampel yang diterima,
terlihat produk yang merupakan
tipe single side ini dikemas dalam
satu paket yang memang ditujukan
untuk penggunaan pada sistem
dual channel agar kemampuannya
bisa maksimal. OCZ sendiri
merekomendasikan produk yang
menggunakan sistem Ultra Low
Noise Shielded PCB ini digunakan
pada sistem berbasis Intel i865 dan
i875.

Untuk masalah tegangan yang
memang sensitif jika frekuensi
memorinya dinaikkan, produsennya
berani memberikan garansi hingga
batas 3volt karena memori jenis ini
dilengkapi dengan fitur Extended
Voltage Protection, meski untuk
kestabilan direkomendasikan pada
tegangan hingga 2,8volt.

PCplus menguji produk yang
memiliki life time warranty ini
dengan menggunakan prosesor
Intel Pentium-4 3GHz FSB800MHz,
kartu gafis Albatron GeForce
FX5700 128MB, harddisk Seagate
Barracuda 7200.7 40GB, mother-
board Abit IS-7  dengan chipset i865,
power supply Enlight 420W.

Dari hasil uji
yang dilakukan,
produk yang
memiliki setting
SPD 3-8-4-4 untuk
CAS latency-Act
to Precharge
delay-DRAM RAS
to CAS delay-
DRAM RAS
Precharge ini,
selain mampu
mendukung sistem dual channel
secara penuh, juga cukup nyaman
buat di-overclock. Untuk setting
standarnya tersebut, frekuensi yang
bisa diakomodasi hingga mencapai
260MHz dengan tegangan 2,6V.
Sementara, untuk clock 2,5-6-3-3,
memori ini mampu bekerja hingga
clock 245MHz dengan tegangan
2,8V. Frekuensi secepat ini bisa jadi
terlampaui andai saja motherboard
yang digunakan mendukung
tegangan memori hingga 3,0volt.

Untuk Anda yang
menginginkan sistem yang cukup

progresif, mampu
di-overclock, dan mendukung
sistem dual channel secara
maksimal untuk pengguna chipset
i875 dan i865, produk ini boleh
dipertimbangkan. Namun untuk
itu, harga yang harus dibayar pun
cukup lumayan. (sil)
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dinding yang cukup banyak.
Pada kemasan jualnya, selain

menyertakan CD driver untuk ins-
talasi pada Windows 98/Me mau-
pun XP, Asus juga menyertakan
sebuah buku manual yang cukup
lengkap yang berisi panduan ins-
talasi maupun setting yang diper-
lukan. Buat pengguna notebook,
kartu ini bisa dipilih lantaran
kompatibilitas dan kemudahan
setting yang diberikan. (sil)
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Terhitung tanggal 17 Desember
sampai dengan 31 Desember
tahun lalu, jika Anda membeli motherboard
ASUS yang dilengkapi dengan WiFi dan Anda
termasuk 10 pembeli pertama, seharusnya Anda
berhak untuk mendapatkan jaket eksklusif ASUS.
Promo ini melengkapi open house PT Astrindo
Surya di outlet Astrindo THR Mall Lt. II Surabaya.

Dalam open house ini masyarakat bisa
mendapat penjelasan yang lengkap mengenai
produk-produk unggulan dan terbaru dari
Astrindo, seperti ASUS, Creative, memori
TwinMos, OCZ, dan berbagai produk lainnya.

Menurut Willy dari Astrindo, di penghujung
tahun ini ASUS merilis dua jenis produk baru
yang tampaknya akan menjadi tren di tahun-
tahun mendatang. “Produk tersebut adalah
motherboard yang dilengkapi dengan WiFi dan
Digimatrix,” ujar Willy.

Saat ini tidak kurang dari 13 jenis
motherboard ASUS yang sudah dilengkapi
dengan WiFi. Pada motherboard ini terdapat 1
buah slot yang kelihatan “aneh”. Slot ini adalah
slot WiFi-b (802.11b) dan juga kompatibel untuk
standar WiFi yang akan datang, yaitu WiFi-g
(802.11g). Setelah menginstalasi ASUS Wi-
Fi@HOME yang sudah dilengkapi dengan antena
dan software AP, kini Anda sudah mempunyai
Access Point untuk Wireless LAN.

“Kemampuan WiFi dari ASUS cukup bagus,
mampu menghubungkan sampai 31 unit

Bertempat di Tanjung Lesung, sebuah resor di ujung
barat Pulau Jawa, Intel menggelar acara khusus untuk para
wartawan, 16-17 Desember tahun lalu. Sebanyak 23 wartawan dari
berbagai media berpartisipasi dalam acara yang dikemas sangat fun
dan berkesan.

Budi Wahyu Jati, Country Manager Intel Indonesia, dalam
presentasinya menjelaskan berbagai teknologi yang akan dirilis Intel
pada tahun 2004, yang salah satunya adalah prosesor berkode
Prescott, sebuah prosesor yang memiliki teknologi proses pembuatan
dengan kerapatan antartransistor mencapai 90 nanometer. Tak lupa,
Budi juga me-review berbagai teknologi yang sudah diperkenalkan
oleh Intel dan menjadi salah satu milestone dalam perkembangan
teknologi informasi pada tahun 2003.

Selain itu, Budi juga memaparkan secara sekilas rencana Intel
sehubungan dengan gencarnya pemberitaan tentang prosesor
Extreme Edition. Dalam demo juga ditunjukkan kelebihan dari
prosesor tersebut dibandingkan prosesor Hyper Threading biasa yang
juga sudah dirilis oleh Intel tahun.

Tak lupa, dipaparkan pula gambaran sistem komputasi modern

Pada tanggal 6-7
Desember 2003 lalu,
Gigabyte mengadakan Gigabyte
Fun Weekend untuk para
distributor dan reseller-nya.
Acara tersebut dihadiri juga
oleh Usman Gani dari Nusantara
Eradata Jakarta, distributor
Gigabyte.

“Acara ini gratis untuk
distributor atau reseller yang

sampai kurang lebih lima tahun
ke depan, di mana nantinya era
komputasi dan komunikasi akan
disatukan dalam satu peranti
mini. Dengan penyatuan komputer dan komunikasi ini, setiap orang
bisa menggunakan komputer dan berkomunikasi di manapun, dalam
satu alat yang sama. Prototipe dari peranti ini sendiri sudah
diperkenalkan.

Yang juga tak kalah menarik adalah gagasan cemerlang tentang
konsep kaus kaki cerdas, di mana apabila Anda menggunakan kaus
kaki ini, berbagai jenis gangguan kesehatan yang Anda alami bisa
dideteksi secara dini. Konsep yang dikembangkan oleh Intel ini
tampaknya mengadopsi sistem akupunktur yang sudah berabad-abad
dikenal oleh masyarakat.

Selain Budi Wahyu Jati, Intel Media Day juga diisi dengan
presentasi dari Wijanto Kodrat, salah satu manajer di Acer Indonesia
yang menjelaskan tentang konsep Acer menyatukan berbagai peranti
elektronik dalam satu produk, yang dipopulerkan dengan nama
Aspire. (snu)

Intel Media Day:
Menengok Masa Lalu,
Mengintip Masa Depan

Para wartawan berpose
bersama sebelum meninggalkan
resor Tanjung Lesung,
meninggalkan penggalan
pengalaman tak terlupakan.

komputer sekaligus dengan jarak 30 m untuk di
dalam ruangan (beda lantai, beda ruangan) dan
300 m untuk luar ruangan. Software AP yang
kami sediakan khusus untuk Windows XP,
sementara komputer lain bisa mengakses AP
dengan Windows 98SE, ME, 2000, dan XP,” ujar
Willy.

“Karena ditujukan untuk penggunaan di
rumah maupun kantor kecil, maka pemasangan
WiFi ini tidaklah sulit. Cukup memasang
antenanya lalu instal software-nya dan
bereslah sudah. Software-nya secara otomatis
akan men-setting WiFi-nya secara otomatis,”
ujar Willy.

ASUS Wi-fi@HOME ini tampaknya cocok bagi
pengguna rumahan yang tidak ingin rumhanya
kelihatan kumuh karena kabel berseliweran.
Selain itu cocok untuk tempat-tempat umum
seperti café, restoran, atau hotel yang ingin
menyediakan layanan wireless LAN. ASUS Wi-
fi@HOME kompatibel bagi seluruh produk yang
mendukung WiFi 802.11b.

Sementara itu produk unggulan kedua, yaitu
Digimatrix, adalah salah satu solusi bagi
penggemar hiburan, khususnya home theater
(ulasan lengkap mengenai produk ini bisa Anda
baca di PCplus edisi 155). Bagusnya lagi
Digimatrix juga mendukung WiFi.

Untuk informasi lebih lanjut, Anda bisa
mengunjungi open house yang diadakan
Astrindo di THR Mall Lt. II Blok D No. 1-2. (din)

Jaket untuk
Sepuluh Pembeli Pertama
Mobo WiFi

mengambil paket yang
telah kami sediakan,” ujar Eka
dari Nusantara Elektronika
Surabaya. “Ternyata memang
paket kami diminati, terbukti
peserta fun weekend kali ini
lebih dari 150 orang,”
imbuhnya.

Pada kesempatan kali,
fun weekend tersebut digelar
di Klub Bunga, suatu resor

yang cukup mewah di
Kota Batu, Malang, Jawa
Timur. Sebelumnya peserta
berangkat bersama-sama
dari kantor PT NE Surabaya
dengan menggunakan 2 unit
bus dan beberapa mobil
pribadi. Pada malam harinya
digelar acara ramah-tamah
sekaligus pembagian
doorprize TV 21”, DVD ROM,

Fun Weekend di Klub Bunga
CD-RW, CD-ROM, dan
lain-lain.

Selain itu PT NE juga
memperkenalkan produk-produk
baru dari Gigabyte, terutama
VGA Card yang menggunakan
Nvidia GeForce. Hal ini cukup
menarik, karena sebelumnya
Gigabyte dikenal sebagai
pendukung ATI. “Hal ini
tampaknya dilakukan agar

masyarakat punya pilihan yang
lebih luas,” ujar Eka.

“Kami berharap dengan
acara ini para dealer dan
reseller kami lebih memahami
produk Gigabyte, sehingga
pada tahun-tahun mendatang
mereka mampu memberikan
informasi yang akurat tentang
Gigabyte,” kata Eka menutup
wawancara. (din)

Slot khusus pada motherboard generasi terbaru dari Asus yang
mengimplementasikan dukungan Wi-Fi.

Antena yang portabel dan bisa dipindah-pindahkan memudahkan tingkat
penerimaan frekuensi.

ARE/PCplus
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Arman Kania
aruman_8@yahoo.com

Championship Manager: Season 03/04
Update untuk Championship

Manager 4

C

Championship Man-
ager (CM) merupakan

game strategi bola
yang sangat terkenal.

Mereka yang sudah
pernah memainkan

game CM4, mungkin
merasa sedikit kecewa

dengan rilis tersebut,
karena terdapat
berbagai bug di

dalamnya. Jangan
mencoba dulu

sebelum menyimak
ulasan ini!!!

M bisa
disebut game
“wajib” bagi para
bola mania, gameplay-

nya hampir bisa dibilang
realistik, mulai dari segi
manajerial, taktik, sampai
karakter para tokohnya. Sayang,
versi CM terdahulu, CM4, belum
bisa memberikan keasyikan bagi
para pemainnya akibat bug-bug
yang ada di dalamnya.
Contohnya, bug pada nilai

moralitas pemain, nilai moral
pemain kita sepertinya tidak
naik-naik meskipun kita telah
memenangkan 8 pertandingan
berturut-turut. Masalah tersebut
masih tetap ada walaupun kita
telah mem-patch CM4, tak heran
jika banyak pemain
meninggalkan CM4.

Di Championship Manager:
Season 03/04, hampir semua bug
yang mengganggu hilang. Bug
pada moralitas pemain juga sudah
disempurnakan. Contohnya, jika
ada seorang pemain yang
bermoral very poor, kita pasang
pada sebuah pertandingan,
kemudian kita memenangkan

pertandingan tersebut, maka besar
kemungkinan moral pemain
tersebut langsung naik menjadi
good atau bahkan superb. Jadi,
tidak perlu menang di beberapa
pertandingan untuk menaikkan
moral seorang pemain. Sebaliknya,
jika di suatu pertandingan seorang
pemain bermain buruk, maka besar
pula kemungkinan moralnya akan
turun.

Sebenarnya, naik tidaknya
moral pemain bukan hanya
ditentukan oleh nilai pemain
tersebut, tetapi juga ditentukan
oleh kecocokannya bermain di
negara tempat ia tinggal, jenis
latihan yang dilakukannya,
performa klub yang dibelanya, dan
hubungannya dengan para pemain
lain. Kita juga bisa melihat pemain
kita menilai pemain lainnya.
Misalnya, Tacchinardi bisa menilai
bahwa dia merasa cocok bermain
bersama Edgar Davids, atau
Zalayeta menilai bahwa Buffon
pandai dalam menggalang
pertahanan. Hal ini bisa kita lihat
pada bagian good relationship pada
tab information.

Dalam game ini, ada
perubahan pada bagian training.
Kita bisa  menyeting bagian training

cukup pada satu layar saja, tidak
perlu klik sana-sini untuk pindah
layar. Grafik yang memperkirakan
besarnya latihan juga tersedia di
sini. Ada 5 hal yang perlu dilatih –
mentality, physical, goalkeeping,
defending dan attacking. Lima bar
yang mewakili lima hal tersebut
akan berubah-ubah, tergantung
latihan apa yang kita berikan.
Dalam layar latihan, kita juga bisa
melihat penilaian para pelatih
mengenai performa latihan para
pemain kita.

Dari segi taktik, juga terdapat
beberapa perubahan. Seperti biasa,
kita bisa mengeset taktik secara tim
atau individual. Tetapi berhati-

hatilah ketika mengesetnya, jangan
pernah menyuruh seorang pemain
melakukan “run with the ball” bila
dribbling dan pace-nya kecil. Untuk
mengeset taktik dan posisi pemain,
kita harus pintar dalam melihat
kemampuan pemain kita. Nilai-nilai
skill pemain memiliki keterkaitan,
misalnya, taktik off-side trap bisa
berjalan sukses bila para bek kita
memiliki nilai positioning, team-
work, dan anticipation yang tinggi.

Bug yang ada pada bagian
pertandingan di CM4 juga sudah

Situs-situs yang
wajib

dikunjungi
pemain CM:

1.  www.cmskins.com
Situs yang berisi

berbagai macam skin,
wallpaper dan lain-lain
yang berhubungan dengan
CM.

2.  www.cmgamer.com
Situs mengenai taktik,

latihan dan hal-hal
mengenai bagaimana
menjadi manajer tim CM
yang baik.

3.  www.loveofchampman.
co.uk

Situs yang mirip
dengan situs cmgamer.com.
Berisi cara bermain CM
yang baik.

4.  www.sigames.com
Berita seputar CM dan

patch-patch untuk CM.

Publisher:
Eidos Interactive

Spesifikasi
sistem

minimum:

• Microsoft Windows 98
Second Edition/Windows
2000/Windows XP

• Prosesor Pentium III
600MHz

• 96MB RAM (128MB RAM
untuk XP)

• Soundcard kompatibel
dengan DirectX 8.1

• 1024 x 768 VGA Card 32
bit

• Ruang harddisk 300MB

diperbaiki. Di CM4, saat bek kita
sedang menjaga striker lawan,
kemudian ada seorang gelandang
lawan yang menggiring bola ke
arah gawang kita, terkadang bek
kita akan langsung menghampiri
gelandang tersebut, dan tanpa rasa
bersalah meninggalkan striker
lawan. Akibatnya, gelandang
tersebut akan mengoper bola ke
striker lawan, yang mungkin akan
mencetak gol. Dan kita hanya bisa
terdiam kesal karena kebodohan
bek kita. Dalam game ini,

kekurangan tersebut sudah
diperbaiki, bek kita bisa menjaga
striker lawan dengan lebih baik,
dan menyerahkan urusan
gelandang lawan ke pemain yang
lain.

Kesimpulannya, CM 03/04
merupakan CM4 yang telah
mengalami perbaikan di sana-sini,
nama-nama yang digunakan
adalah nama-nama pemain sepak
bola musim 2003/2004. Bagi para
penggemar AC Milan, Kaka sudah
ada dalam game ini. Uniknya, kita
bisa memainkan Liga Indonesia di
sini. Sebagai saran, jangan terlalu
banyak memainkan sebuah liga
dalam satu waktu di CM, karena
kita mungkin harus menunggu
lama karena terlalu banyak hal
yang harus diproses. PC+
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga dalam Dolar AS
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MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE-X, i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 85
Asus P4SDX, SiS655, AGP8X, DDR,
6PCI, USB2.0, Hyper-threading 71
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 252
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800, 4DDR,
RAID, LAN, audio 137
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4P800 +WiFi, i865PE, FSB800,
ATA100_SATA, 4DDR, audio 179
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 70
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio, Serial ATA,
1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 80

Asus P4P800S, i848P, FSB800,
2DDR, audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 101
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP984 SATA, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 91
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 74
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 68
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 52
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 49
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 49
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100, AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 59
MSI 651M-L, SiS 651, m-ATX, FSB533,
2DIMM, ATA133, AGP4X 66
MSI 648 MAX-V, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 68

MSI 848P Neo-S, i848P, FSB800MHz,
AGP8X, 2GB DDR400, SATA, 5PCI 94
MSI 648F Neo, SiS648FX, FSB800MHz,
AGP8X, 3GB DDR ATA133, SATA,
AGP8X 78
MSI 645GVM, I845GV, Matx, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 72
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400, FSB533,
USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX,
FSB533, 2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A, FSB266,
2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 79
Gigabyte GA-7N400-EL,
nForce2 ultra, ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE, ATX,
FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133,
AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 190
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130

DFI LAN Party NF II Ultra,
nForce 2, ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 85
DFI 648FX-ALE, i648FX, ATX, FSB800,
AGP8X, DDR 400 67
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 52
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 88

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soltek SL-87CW-FL, i875P,
AGP8X, ATX, 4DDR 175
Soltek SL-86MPI-L, i865P, AGP8X,
ATX, 2DDR 98
Soltek SL-85MIR3-L, i845GE,
AGP4X, mATX, 2DDR 74
Soltek SL-85MIV4-L, VIA P4M266A,
2 PCI, mATX, 2DDR 60
Soltek SL-85MIV3-L, VIA P4M266A,
3 PCI, mATX, 3DDR 60
Soltek SL-KT600-RL, VIA KT600,
6PCI, ATX, 3DDR 73
Soltek SL-75MRN-L, nForce2,
5PCI, ATX, 3DDR 93
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KURSUS

KURSUS Video Editing (Adobe Premier) 350rb
Digital Imaging (Photoshop) 150rb Merakit PC
95rb LAN 95rb Praktis,Cepat,Certificate IZZAH
Com  J l .Rawamangun Timur No.78
Ph.47867273

LAIN-LAIN

DISTRO LINUX,Menjual CD Linux terbaru.
Mandrake/Redhat/Slackware/Openoffice dll
Murah dan Bergaransi (1 to 1 Replacement)
Kualitas CD dijamin bagus ( LG/BenQ/Sony)
Bisa kirim keseluruh Indonesia. Hubungi:
08121876981 Email: distro_linux@yahoo.com
http://www.geocities.com/distro_linux/

IKLAN BARIS

Soltek SL-KT400A-L, VIA KT400A,
6PCI, ATX, 3DDR 64
Soltek SL-75MIV2-L, VIA KM400,
3PCI, mATX, 2DDR 71

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit IC7 MAX III, i875P, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 233
Abit IC7, i875P, FSB 800MHz,
4DDR, AGP 8X, 5 PCI 143
Abit AI7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 144
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 190
Abit IS7E, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 109
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 133
Abit VI7, VIA PT800, FSB 800MHz,
2 DDR, AGP 8X,  5 PCI 94
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 93
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 116
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 84
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 93
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 30
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 60
Visipro 256MB (16 IC) PC-133 73
Visipro 512MB PC-133 110
Visipro 128MB (8 IC) PC-2100 26
Visipro 256MB (8 IC) PC2100 45
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 88
Visipro 128MB (4 IC) PC-2700 26
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 45
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 89
Visipro 256MB PC3200 (8IC) 50
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 17
V-Gen SDRAM PC-133 (4IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 128MB 34
V-Gen SDRAM PC-133 (8IC) 256MB 53
V-Gen SDRAM PC-133 (16IC) 256MB 67
V-Gen SDRAM PC-133 (16IC) 512MB 105
V-Gen DDR PC-2100  128MB 24
V-Gen DDR PC-2100  256MB 41
V-Gen DDR PC-2700  256MB 42
V-Gen DDR PC-2100  512MB 80
V-Gen DDR PC-2700  512MB 81
V-Gen DDR PC-3200  256MB 44
V-Gen DDR PC-3200  512MB 87
V-Gen RDRAM PC-800 128MB 50
V-Gen RDRAM PC-800 256MB 97

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

MCPRO 512MB DDR PC-3200 86,5
MCPRO 256MB DDR PC-3200 43.5
MCPRO 512MB DDR PC-2700 84,8
MCPRO 256MB DDR PC-2700 40.6
MCPRO 128MB DDR PC-2100 20.7

MULTIMEDIA CARD

MCPRO 64MB 22
MCPRO 128MB 35
MCPRO 256MB 69,5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

MCPRO Flash memory 32MB 17
MCPRO Flash memory 64MB 21.5
MCPRO Flash memory 128MB 37.5
MCPRO Flash memory 256MB 54

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 65
Visipro Flash Memory 512MB 125

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165
MCPRO pen drive 128MB USB 2.0 39,5
MCPRO pen drive 256MB USB 2.0 58,5
MCPRO pen drive 512MB USB 2.0 120.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115

DigiSound II, 128MB,
multi MP3, voice recording, display 130

MagicStar 128 Turbo, USB 2.0, 128MB 70

Umax Flash Drive FD-201
64MB, USB 2.0 43
Umax Flash Drive FD-201
128MB, USB 2.0 65
Umax Flash Drive CD-101,
64MB + SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB +
MP3 player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5
Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 59
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 72
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 75
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 105
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 165
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 225

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 52.3
Seagate Barracuda 7200.7 40GB
ATA100 56
Seagate Barracuda 7200.7 80GB
ATA100 71.9
Seagate Barracuda 7200.7 120GB
ATA V/100 100.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 134.6
Seagate Barracuda SATA 80GB,
ATA100 103,5
Seagate Barracuda SATA 120GB,
ATA100 126.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 50
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 53
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 103
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 170
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 235

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235
Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 360
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache, 7200rpm 405

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 145
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 425

IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB,
68/80pin, 7200rpm, SCSI160,
4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah  U320 36,6GB 163
Seagate Cheetah U320  73GB 398
Seagate Cheetah U320 73.4GB
Fibre channel 510
Seagate Cheetah U320 36,7GB 306

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 42.5
Athlon Xp 2000+ (Thoroughbred A) 50.5
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ ((Thoroughbred A) 64
AthlonXP 2400+ fan (Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 87
AthlonXP 2800+ (Barton FSB333) 140
AthlonXP 3000+ (Barton FSB333) 199

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) +
FAN TBRED B FSB 266MHz 76
AMD ATHLON XP 2400+ (BOX) +
FAN TBRED B FSB 266MHz 83
AMD ATHLON XP 2600+ (BOX) +
FAN BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 150
AMD ATHLON XP 3000+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 229
AMD ATHLON XP 3200+ (BOX) + FAN
BARTON FSB 400MHz CACHE 512 459

Intel Pentium-4 1,8AGHz-478 119
Intel Pentium-4 3,06GHz, box, 478 281
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 126
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 138
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,66GHz,
(512) FSB 533 179
Intel Pentium-4 2,8GHz
(512) FSB 533 210

Tray Pent-4 2,4CGHz, cache 512Kb,
FSB 800 w/o fan 165
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 174
Box Pent-4 2,6CGHz,
cache512Kb, FSB800 194
Box Pent-4 2,8CGHz,
cache512Kb, FSB800 210
Box Pent-4 3.0GHz,
cahce512Kb, FSB800 297
Box Pent-4 3,2GHz,
cache512Kb, FSB800 441

Intel Celeron 1,7GHz, c/128 62
Intel Celeron 2.0GHz, c/128 65
Intel Xeon Pentium-4 2,4GHz
512KB cache L2 239
Intel Xeon Pentium-4 2,BGHz,
512KB cache L2, 533 250
Intel Xeon Pentium-4 2,6GHz,
512KB cache L2 278
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 509

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

CASING

Procase ATX PS/2 tipe 477
power supply 350W 23
Procase ATX PS/2 tipe 0207
power supply 350W 24
Procase ATX PS/2 tipe 0208
power supply 350W 26

Enermax ATX CS-5190 AL,
power supply 365W 404
Enermax ATX CS-5190 AL,
power supply 450W 419
Elan Vital S15, big tower,
ATX, power supply 300w 472

VGA CARD

Asus A9600SE/TD/128MB 152
Asus A9200SE/T/ 64MB 64
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 128MB DDR 567
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 85
Asus V9520 Home Theater-128MB 189
Asus V9280 /TD, Ti4200-128MB 173
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 546
Asus V9180 SE/T 64MB,
MX-440-8X 53

Abit Siluro FX5200DT, FX5200,
AGP8X, 128MB DDR 82
Abit Siluro FX5600 Ultra OTES,
FX5600Ultra, AGP8X, 128MB DDRII 207

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 85
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 145
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KUIS Si Ciplus mendengar kabar dari Lala bahwa sekarang sudah ada
motherboard yang menggunakan chipset ATi terbaru sebagai
northbridge/southbridge-nya. "Ada onboard VGA-nya juga lho?",

komentar Lala yang terngiang-ngiang di telinga Si Ciplus. Tolong dong si Ciplus, sebutkan chip
grafis Radeon seri berapa yang digunakan sebagai VGA onboard pada motherboard itu?
Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan alamat yang jelas dan
sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan menunda-nunda, karena jawaban sudah
harus masuk ke meja Redaksi PCplus paling lambat tanggal 16 Januari 2004. PCplus akan
memberikan 5 buah kaos PCplus untuk 5 orang pemenang yang menjawab dengan benar dan
beruntung! Buruan!!! Hadiah akan dikirim langsung ke alamat pemenang.
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PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz,
DVI port 190
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 450
PixelView FX5700, AGP8X,
DDRII 256MB, VIVO, DVI 205
PixelView FX5700, AGP8X,
DDR 128MB, VIVO, DVI 180
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 85

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 46
MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 50
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 73
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 89
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR256, AGP8X,
256MB DDR, DVI, VIDEO IN, TV OUT 250
MSI FX-5600 VTDR128, FX5600,
AGP8X, DDR128 215
MSI FX-5600 VTDR256, FX5600,
AGP8X, DDR256 250
MSI FX-5600 VTD256 (N-box),
FX5600, AGP8X, DDR 256 255
MSI FX-5900 ultra VTD256 (N-box),
FX5900 ultra, DDR256 570

Gainward GF4MX440, 64MB,
5.0ns DDR, AGP8X, TV OUT 46
Gainward GeForce FX 5200,
128MB, 4.0ns DDR, AGP8X, TV OUT 72
Gainward GeForce FX 5600, 128MB,
ULTRA FAST DDR, AGP 8X, TV OUT 135
Gainward GeForce FX 5600, 256MB,
ULTRA FAST DDR, AGP 8X, TV OUT 165
Gainward GeForce FX5900, 128MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 385
Gainward GeForce FX5900, 256MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 450

Soltek  SL-5200-XD, GeForce FX5200
128MB DDR, DVI, TV out 72
Soltek  SL-X600-D6DT, Xabre600,
64MB DDR, DVI, TV out 61

Elsa Quadro FX2000, 128MB DDR II,
AGP 8X VIVO, DVI-I 1797
Elsa Quadro FX1000, 128MB DDR II,
AGP 8X, DVI-I 1073
Elsa Quadro FX500, 128MB DDR,
AGP8X, DVI-I 346
Elsa Gladiac FX930, GeForce FX5800,
128MB, AGP8X, VIVO, DVI-I 388
Elsa Gladiac FX732, GeForce FX5600,
128MB, AGP8X, VO, DVI-I 181
Elsa Gladiac FX534, GeForce FX5200,
64MB, AGP8X, VO, DVI-I 105
Elsa Gladiac 528 (VIVO), GF4 Ti4200,
AGP8X, 128MB DDR, VIVO 156
Elsa Gladiac 518, GF4 MX440,
AGP8X, 64MB DDR, TVO 60

Elsa Gladiac 517SEP, GF4 MX440,
64MB DDR, TVO 51
Elsa Falcox 980FX-256,
Radeon 9800, 256MB VO, DVI 456
Elsa Falcox 980FX-128,
Radeon 9800, 128MB VO, DVI 347

Elsa Falcox 960FXPRO-128MB,
Radeon 9600, 128MB, VO DVI 211
Elsa Falcox 960FX-128,
Radeon 9600, 128MB, VO DVI 153
Elsa Falcox 920FX-128,
Radeon 9200, 128MB, VO DVI 98
Elsa Falcox 920SE-64MB,
Radeon 9200, 64MB, VO DVI 63

Sapphire Radeon 9200SE-D64,
64MB DDR, TVI, AGP8X 58
Sapphire Radeon 9200 D64, 64MB
DDR,TVO, AGP8X 69
Sapphire Radeon 9200 D128,
128MB DDR, VIVO, AGP8X 106
Sapphire Radeon 9600 D-128,
128MB, DVI, VIVO, AGP8X 142
Sapphire Radeon 9800Pro D-128,
128MB DDR, DVI, AGP8X 455
Sapphire Radeon 9800Pro D256,
256MB DDRII, DVI, AGP8X 536

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT+TV out 47

DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               73
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 160
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     190

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9600 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I,
twin view 137
Gigabyte R9800 Pro , radeon 9500,
TV-out S/RCA, DVI port DVI-I,
twin view 407
Gigabyte R9000 Pro,
ATI Radeon 9000Pro, 64MB DDR,
TV-out, S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 67
Gigabyte R9600 Pro, ATI Radeon
9600 Pro, 128MB DDR 192
Gigabyte R-9800 Pro,
Radeon 9800Pro, 380MHz/ 680MHz,
256MB 522
Gigabyte R-9200 (VIVO), Radeon 9200,
250MHz/ 400MHz, 128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW 40x12x48 box 135

Gigabyte  CD ROM 52X 26

MSI CD-ROM C-52 20
MSI CR-52M, 52x32x52 48
MSI CRE-52M CD-RW external 120

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x52 100
Asus external slim combo SCB 2408-D 210
Asus CRW 5224A, 52x24x48 51

TDK CDRW 52x24x48 D
second edition black 50
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